
 

 

 

 

 

 
 

MVN User Manual 

Document MVNManual, Revision Z, 01 04 2021 
 



  

 

    MVN User Manual 

 

ii 

 
Revision Date By Changes 
Z 01 04 2021 PHA MVN 2020.2 release 

 

 
© 2005-2021, Xsens Technologies B.V. All rights reserved. Information in this document is subject to change 
without notice. Xsens, Xsens DOT, MVN, MotionGrid, MTi, MTi-G, MTx, MTw, Awinda and KiC are registered 
trademarks or trademarks of Xsens Technologies B.V. and/or its parent, subsidiaries and/or affiliates in The 
Netherlands, the USA and/or other countries. All other trademarks are the property of their respective owners. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

    MVN User Manual 

 

iii 

Table of Contents 

Table of Contents .......................................................................... iii 

Abbreviations and Terms ............................................................... x 

Default Folders ............................................................................. xi 

1 Introduction .............................................................................. 1 

2 Content overview ...................................................................... 2 

2.1 MVN Link suitcase with contents ................................................................... 2 

2.2 Motion Tracker (MTx) .................................................................................. 2 

2.3 Body Pack (BP), Battery Pack, and Access Point (AP) ...................................... 3 

2.4 Cabling ..................................................................................................... 3 

2.5 MVN Awinda (starter) backpack/suitcase with contents ................................... 3 

2.6 Motion Tracker (MTw) ................................................................................. 4 

2.7 Awinda Station ........................................................................................... 4 

2.8 MVN Awinda Charger .................................................................................. 4 

2.9 “The Suit” .................................................................................................. 5 

2.10 Motion Trackers on the extremities ............................................................... 5 

2.11 Software ................................................................................................... 6 

3 Getting started .......................................................................... 7 

3.1 Installation of software ............................................................................... 7 

3.2 Preferred language ..................................................................................... 7 

3.3 Setup hardware ......................................................................................... 7 

3.4 MVN Analyze/Animate workflow overview ...................................................... 8 

3.5 Tips for best practice .................................................................................. 9 
3.5.1 Operating conditions ............................................................................. 9 
3.5.2 Absolute maximum ratings ..................................................................... 9 
3.5.3 Suit, shirt, short maintenance ............................................................... 10 
3.5.4 FabriFoam Velcro Straps ....................................................................... 10 
3.5.5 Dynamic movements ............................................................................ 10 
3.5.6 Warming up the motion capture engine .................................................. 10 
3.5.7 CH5000 Charger Safety ........................................................................ 10 

4 Software ................................................................................. 12 

4.1 Software Installation .................................................................................. 12 

4.2 Software Activation ................................................................................... 12 
4.2.1 Software License Key ........................................................................... 12 



  

 

    MVN User Manual 

 

iv 

4.2.2 Dongle License Key .............................................................................. 12 
4.2.3 Network License Key ............................................................................ 13 

5 Hardware ................................................................................ 14 

5.1 MVN Link .................................................................................................. 14 
5.1.1 Motion Trackers (MTx) .......................................................................... 14 
5.1.2 Body Pack (BP) and Battery .................................................................. 14 
5.1.3 Battery Charger ................................................................................... 17 
5.1.4 Access Point (AP) ................................................................................. 19 
5.1.5 Awinda Station or Sync Station .............................................................. 20 

5.2 MVN Awinda ............................................................................................. 21 
5.2.1 Wireless Motion Trackers (MTw) ............................................................ 21 
5.2.2 MTw LED Indications ............................................................................ 21 
5.2.3 MTw Stand-by Mode ............................................................................. 22 
5.2.4 Exiting stand-by mode .......................................................................... 22 
5.2.5 Awinda Station .................................................................................... 22 
5.2.6 Awinda Station Synchronization Ports ..................................................... 22 
5.2.7 Awinda Station Status LED .................................................................... 23 
5.2.8 Awinda USB Dongle .............................................................................. 24 
5.2.9 Awinda USB Dongle LED ....................................................................... 24 
5.2.10 Powering off MVN Awinda ..................................................................... 24 

5.3 The suit .................................................................................................... 24 
5.3.1 Straps ................................................................................................ 24 
5.3.2 MVN Lycra suit .................................................................................... 25 
5.3.3 Putting on the remaining Motion Trackers ............................................... 26 
5.3.4 Foot pads............................................................................................ 26 
5.3.5 Putting on the Body Pack and Battery Pack ............................................. 26 
5.3.6 Tracker locations ................................................................................. 26 

5.4 Connecting the hardware and software ........................................................ 27 

6 MVN Analyze/Animate ............................................................ 28 

6.1 Status Bar ................................................................................................ 29 

6.2 Command line interface ............................................................................. 29 

7 Workflow and Functionalities in MVN Analyze/Animate .......... 30 

7.1 New session.............................................................................................. 30 
7.1.1 Create a New Recording Session ............................................................ 30 

7.2 Configure an MVN System .......................................................................... 31 
7.2.1 Enable/disable search for new system .................................................... 31 
7.2.2 System Status ..................................................................................... 31 
7.2.3 System Name ...................................................................................... 31 
7.2.4 View Hardware Status .......................................................................... 31 
7.2.5 Suit Configuration ................................................................................ 31 
7.2.6 Scenario ............................................................................................. 33 
7.2.7 Accept Systems ................................................................................... 33 
7.2.8 Max Update Rate ................................................................................. 33 
7.2.9 Body Dimensions ................................................................................. 33 
7.2.10 Props ................................................................................................. 35 



  

 

    MVN User Manual 

 

v 

7.2.11 Sync .................................................................................................. 37 

7.3 General Settings ....................................................................................... 37 

7.4 Configuring the Video Camera ..................................................................... 37 
7.4.1 Configuration ...................................................................................... 37 

7.5 Configuring the Awinda Station (or Sync Station) .......................................... 39 

7.6 Hardware Status ....................................................................................... 40 
7.6.1 Relocating motion trackers .................................................................... 41 
7.6.2 MVN Awinda: Changing Radio Channel ................................................... 42 
7.6.3 MVN Awinda: Changing Radio Channel ................................................... 42 
7.6.4 MVN Awinda: Reject Unused Trackers..................................................... 42 
7.6.5 MVN Awinda: Forget System ................................................................. 42 

7.7 Navigator ................................................................................................. 43 

8 Setup ...................................................................................... 44 

8.1 Calibration ................................................................................................ 44 
8.1.1 Record and process calibration .............................................................. 44 
8.1.2 Apply calibration and define x-axis ......................................................... 45 
8.1.3 Hands-off calibration ............................................................................ 46 
8.1.4 Calibration quality ................................................................................ 46 

9 Preview and Recording ........................................................... 48 

9.1 Preview .................................................................................................... 48 
9.1.1 Viewport Icons .................................................................................... 49 
9.1.2 Views ................................................................................................. 49 
9.1.3 Real-time graphs ................................................................................. 50 
9.1.4 Save and Restore Layout ...................................................................... 51 

9.2 Recording ................................................................................................. 51 
9.2.1 Note for recording for MVN Awinda Users ................................................ 51 

9.3 Add comments after recording .................................................................... 52 

9.4 Recovery of MVN file after system crash ....................................................... 53 

9.5 Markers .................................................................................................... 53 

9.6 Network Streamer ..................................................................................... 54 

9.7 Network Monitor ........................................................................................ 56 

10 Playback, reprocessing and editing ....................................... 57 

10.1 Reprocess HD ........................................................................................... 57 

10.2 Batch Reprocess HD .................................................................................. 57 

10.3 Playback .................................................................................................. 58 

10.4 Synchronization with video ......................................................................... 59 

10.5 Contact point editing .................................................................................. 59 
10.5.1 Selection of samples ............................................................................ 61 
10.5.2 Contact point editing options ................................................................. 62 

10.6 Multi-person editing ................................................................................... 64 



  

 

    MVN User Manual 

 

vi 

11 On-Body Recording ............................................................... 65 

11.1 Configuration ............................................................................................ 65 

11.2 Calibration and recording ........................................................................... 65 

11.3 Import Recordings ..................................................................................... 65 

11.4 Swap Trackers .......................................................................................... 66 

11.5 Remote On-Body Recording ........................................................................ 67 

12 3D Position Aiding ................................................................ 69 

12.1 GNSS ....................................................................................................... 69 
12.1.1 Introduction ........................................................................................ 69 
12.1.2 Set up with GNSS position aiding ........................................................... 69 

12.2 HTC Vive .................................................................................................. 71 
12.2.1 Background ......................................................................................... 71 
12.2.2 Vive Hardware placement ..................................................................... 71 
12.2.3 Setting up ........................................................................................... 73 
12.2.4 Object tracking .................................................................................... 76 

13 MVN Remote app for iOS and Android ................................... 77 

14 Data Analysis ........................................................................ 78 

14.1 Graphs ..................................................................................................... 78 
14.1.1 Parameter vs. Time .............................................................................. 78 
14.1.2 Overlay graphs .................................................................................... 78 
14.1.3 Coordination / Phase Plots (Parameter vs. Parameter) .............................. 78 
14.1.4 Graph handling .................................................................................... 79 
14.1.5 Graph toolbar ...................................................................................... 79 
14.1.6 Scaling Options ................................................................................... 79 
14.1.7 Zoom ................................................................................................. 80 
14.1.8 Pan .................................................................................................... 80 
14.1.9 Show/ Hide Legends ............................................................................. 80 
14.1.10 Show Numerical Values on Graphs ...................................................... 80 
14.1.11 Equal axes ....................................................................................... 80 
14.1.12 Amount and layout of graphs .............................................................. 81 

14.2 Cascade / Tile windows .............................................................................. 81 

14.3 Linked views ............................................................................................. 81 

14.4 Marker List ............................................................................................... 81 

15 Saving and Exporting ............................................................ 82 

15.1 BVH ......................................................................................................... 82 
15.1.1 Frame skip .......................................................................................... 84 
15.1.2 Overwrite first frame with T-pose ........................................................... 84 
15.1.3 Output Presets .................................................................................... 85 
15.1.4 Output Unit ......................................................................................... 85 

15.2 C3D ......................................................................................................... 85 
15.2.1 Points exported in C3D Exporter ............................................................ 86 



  

 

    MVN User Manual 

 

vii 

15.3 FBX ......................................................................................................... 86 

15.4 MVNX ...................................................................................................... 87 
15.4.1 MVNX backwards compatibility .............................................................. 94 

15.5 Export Movie ............................................................................................. 95 

15.6 Export Excel ............................................................................................. 96 

16 Features of MVN Analyze/Animate ....................................... 97 

16.1 Plug-ins ..........................................................Error! Bookmark not defined. 

16.2 MVN usage statistics .................................................................................. 97 

17 MVN Ethernet Camera ........................................................... 98 

18 Xsens Peripheral Software .................................................... 99 

18.1 Magnetic Field Mapper (MFM) ...................................................................... 99 

18.2 Firmware Updater ...................................................................................... 99 

18.3 Software Activation Tool: Offline License Activation or Updating a License ........ 99 
18.3.1 Step 1: Retrieve the license information from a Sentinel protection key ...... 99 
18.3.2 Step 2: Send the C2V file ...................................................................... 99 
18.3.3 Step 3: Apply the received v2c file using the Software Activation tool......... 99 

18.4 Software Activation Tool: Applying an Update ............................................. 100 

18.5 RUS Utility: Rehosting a Sentinel protection key .......................................... 100 
18.5.1 Step 1: Collect Information about the Recipient Computer ...................... 100 
18.5.2 Step 2: Generate the License Transfer File ............................................ 100 
18.5.3 Step 3: Apply the License Transfer File ................................................. 100 

18.6 Setup a network license ........................................................................... 100 

19 Troubleshoot ....................................................................... 102 

20 Warranty and liability ......................................................... 105 

20.1 Customer Support ................................................................................... 105 

21 Regulatory Notices MVN Link .............................................. 106 

21.1 Radio Frequency Exposure and Emission .................................................... 106 

21.2 CE Declaration of Conformity MVN Link ...................................................... 107 

21.3 Certificate of Conformity for Radio Equipment in EU ..................................... 108 

21.4 FCC Statement ........................................................................................ 109 

21.5 FCC Declaration of Conformity MVN Link .................................................... 110 

21.6 Certificate of Conformity for Radio Equipment in Japan ................................ 111 

22 Regulatory Notices MVN Awinda ......................................... 112 

22.1 Radio Frequency Exposure and Emission .................................................... 112 



  

 

    MVN User Manual 

 

viii 

22.2 CE Declaration of Conformity MTw2, Awinda Station, Awinda Dongle ............. 113 

22.3 FCC Statements ...................................................................................... 114 

22.4 FCC Declaration of Conformity MTw2 ......................................................... 115 

22.5 FCC Declaration of Conformity Awinda Station ............................................ 116 

22.6 FCC Declaration of Conformity Awinda Dongle ............................................. 117 

22.7 Certificate of Radio Equipment in Japan MTw2............................................. 118 

22.8 Certificate of Radio Equipment in Japan Awinda Station ................................ 119 

22.9 Certificate of Radio Equipment in Japan Awinda Dongle ................................ 120 

23 Appendices ......................................................................... 121 

23.1 Lycra suit sizes overview .......................................................................... 121 

23.2 MVN kinematics and output ...................................................................... 121 
23.2.1 Quaternion orientation representation .................................................. 121 
23.2.2 Conversions ...................................................................................... 122 

23.3 Body planes ............................................................................................ 122 

23.4 Coordinate systems ................................................................................. 124 

23.5 Anatomical model .................................................................................... 125 
23.5.1 Definition of segment axes .................................................................. 125 
23.5.2 Bony/anatomical landmarks ................................................................ 125 

23.6 Segment axes definitions and Origin Definitions .......................................... 128 
23.6.1 Spinal segments: L5, L3, T12, T8: Segments 2-5 ................................... 129 
23.6.2 Neck: Segment 6 ............................................................................... 130 
23.6.3 Head: Segment 7............................................................................... 130 
23.6.4 Shoulder: Segment 8 Right and Segment 12 Left ................................... 130 
23.6.5 Upper Arm (Humerus): Segment 9 Right and Segment 13 Left ................ 131 
23.6.6 Forearm (Radius/Ulna): Segment 10 Right and Segment 14 Left ............. 131 
23.6.7 Hand: Segment 11 Right and Segment 15 Left ...................................... 131 
23.6.8 Upper Leg (Femur): Segment 16 Right and Segment 20 Left ................... 132 
23.6.9 Lower Leg (Tibia/Fibula): Segment 17 Right and Segment 21 Left ........... 132 
23.6.10 Foot (Calcaneus): Segment 18 Right and Segment 22 Left ................... 133 
23.6.11 Toe: Segment 19 Right and Segment 23 Left ..................................... 133 

23.7 Joint angles ............................................................................................ 133 
23.7.1 Euler Extractions for the joint angles .................................................... 134 
23.7.2 Shoulder angle definitions ................................................................... 134 
23.7.3 Joint angle outputs ............................................................................ 134 

23.8 Xsens motion capture engine .................................................................... 134 
23.8.1 Height tracking .................................................................................. 135 
23.8.2 Engine settling time ........................................................................... 135 

23.9 Update Rate versus Sample Frequency ....................................................... 135 

23.10 Strap Down Integration ......................................................................... 136 

23.11 The Awinda Protocol.............................................................................. 136 
23.11.1 Choosing a Radio Channel for MVN Awinda ......................................... 136 

23.12 System Specifications ........................................................................... 138 



  

 

    MVN User Manual 

 

ix 

23.13 System block diagrams ......................................................................... 143 
23.13.1 MTw .............................................................................................. 143 
23.13.2 Awinda Dongle ................................................................................ 143 
23.13.3 Awinda Dongle ANT ......................................................................... 144 
23.13.4 Awinda Station ............................................................................... 144 

24 Contact point editing .......................................................... 145 

25 Synchronization with External Devices ............................... 146 

25.1 The Hardware ......................................................................................... 146 
25.1.1 Important note when receiving 5V synchronization pulses ....................... 146 

25.2 Sync In .................................................................................................. 147 

25.3 Sync Out ................................................................................................ 148 
25.3.1 Settings in MVN Analyze/Animate ........................................................ 149 

25.4 Important Notices for Sync In ................................................................... 149 
25.4.1 Sync In Recommended Settings .......................................................... 150 

25.5 Sync In with MVN Analyze/Animate ........................................................... 150 

25.6 Sync Out with MVN Analyze/Animate ......................................................... 150 

25.7 3rd party Synchronization Examples ........................................................... 150 

25.8 Network sync .......................................................................................... 150 

25.9 Gloves ................................................................................................... 151 

26 References .......................................................................... 152 

 



  

 

    MVN User Manual 

 

x 

Abbreviations and Terms 

Abbreviation / Term Description 

API Application Programming Interface 

AP Access Point: The method of transporting data from the body pack to the 
PC 

BP Body Pack, on-body controller unit for the motion trackers, connects to 
power and wireless transmission of data to host PC via the Access Point 
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.C3D Coordinate 3D export format 
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.FBX Filmbox animation file format 

IK Inverse kinematics 

MTx Xsens Inertial and Magnetic Measurement Unit with on-body cables 

MTx-STR String of Xsens Inertial and Magnetic Measurement Units 

MTw Xsens completely wireless Inertial and Magnetic Measurement Unit 

MT Xsens Inertial and Magnetic Measurement Unit (generic reference to MTw 
or MTx) 

MVN MVN native file format 

MVN camera (Ethernet 
camera) 

Physical camera packaged for video reference data 

MVN Straps Velcro straps for attaching MTw to the body 

MVN Suit Lycra suit 

MVN system Complete MVN product (hardware and software) 

.MVNA MVN subject dimensions file 

.MVNS MVN session file 

.MVNX MVN open XML file format 

SDK Software Development Kit 

Sensor Components of the MTx, e.g. gyroscope, accelerometer 

Subject Person in the suit 

The suit MVN Straps and Lycra suit - whichever applies 

Motion Tracker MTw, MTx or MTx-STR 

UDP User Datagram Protocol (for data streaming over Local Area Network 
(LAN)) 



  

 

    MVN User Manual 

 

xi 

Default Folders 

Description Files Location 

Main program mvn_studio64.exe C:\Program Files\Xsens\Xsens MVN 
<version>\MVN Studio 

Documentation MVN Quick Setup 
Sheet.pdf 

C:\Program Files\Xsens\Xsens MVN 
<version>\Documentation 

 

 



   

 

 

 

 

  

 

1 www.xsens.com 

1 Introduction 
The Xsens MVN inertial motion capture system is an easy to use, cost efficient system for 

full-body human motion capture. MVN is based on Xsens' state-of-the-art miniature 

inertial sensors and wireless communication solutions combined with advanced sensor 

fusion algorithms, using assumptions of biomechanical models. 

 

MVN is a completely portable system; it is not restricted to a studio or lab. It can be used 

anywhere: outside, in the office, and on the work floor. There are no limitations in 

measurement volume (except the wireless range). 

 

This MVN system is a full body inertial kinematic measurement system, incorporating 

synchronized video data. Instant graphical output is provided, including joint angles. An 

additional C3D exporter has been implemented, as well as improved MVNX (XML) output, 

containing all of the segment information included in the Xsens MVN system as well as 

joint angle data, center of mass and factory calibrated sensor data. 

 

Examples of fields of use: 

• Biomechanics, sport, rehabilitation, ergonomics and human-machine interaction.  

Benefit from the fully ambulant measurement system, advanced functional axes 

calibration, no need to palpate bony landmarks for marker placement, direct low-noise 

measurement of acceleration and angular velocity enabling easier internal 

forces/momentum calculations. 

• 3D Animation.  

Enjoy unprecedented ease-of-use, rich and smooth data, very short setup time, and 

the absence of cumbersome post-processing of markers or lost data. 

• Virtual reality, training & simulation.  

Benefit from the highly portable system and a price-point enabling full-body insertion 

of (multiple) subjects in VR for highest degree of immersion, low-latency smooth 

motion data. 
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2 Content overview 

2.1 MVN Link suitcase with contents 
Figure Description 

 

Figure 1: Suitcase containing the MVN 

Link System 

The MVN Link System arrives in a strong, durable 

and watertight case. The case has wheels and an 
extendable handle for easy transportation. The 
suitcase dimensions meet the requirements for most 
airline hand-luggage. The suitcase contains: 
• 4 MTx String with three trackers 
• 6 Motion Trackers (MTx) 
• 1 Body Pack 

• 1 Battery Pack 
• 1 Battery charger 

• 1 Access Point 
• 1 Upper Body Cable 
• 1 Lower Body Cable 
• 1 Battery Cable 

• 1 Y Cable 
• Lycra suit including headband, gloves, shorts, 

footpads 
• 1 Segmometer 
• Quick set-up sheet 

2.2 Motion Tracker (MTx) 
Figure Description 

 

Figure 2: Motion Tracker 
(left:MTx, right: MTx-STR) 

The MVN Link system contains two types of motion trackers; the 

single MTx used as end trackers and the string of three MTx-STR 
The motion trackers, MTx, and MTx-STR are the miniature inertial 
measurement units containing 3D linear accelerometers, 3D rate 
gyroscopes, 3D magnetometers, and a barometer, which 

measures atmospheric pressure. These trackers are placed at 
strategic locations on the body (fixed by the suit), to measure the 
motions of each body segment. 
The MTx trackers are positioned on the pelvis, sternum, hands, 
and head.  The MTx-STR’s are used to chain the legs (upper leg, 
lower leg, and feet), as well as for the upper body (shoulders, 
upper arms, and for-arms).  For more information about Motion 

Trackers, see Section 5.1.1. 
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2.3 Body Pack (BP), Battery Pack, and Access Point (AP) 
 
Figure Description 

 

Figure 3: Body Pack (BP) 

Figure 3 shows the Body Pack (BP). The strings of MTx’s are 
interconnected by the Body Pack. It delivers power from the 
battery pack to the connected MTx’s and retrieves their data 
ensuring exactly synchronized samples. 

For more information about the Body Pack, see Section 
5.1.2. 

 
Figure 4: Access Point (AP) 

Figure 4 shows the Access Point. The Access Point pairs with 
the Body Pack to handle the data traffic between the BP and 
the computer. This Access Point connects to the PC or laptop 
via Ethernet cable or wirelessly and is powered using a 

proprietary power adapter or laptop battery.  One Access 
Point can connect to multiple MVN systems. For more 
information about the Access Point, see Section 0. 

 

Figure 5: Battery Pack (Battery) 

Figure 5 shows the Battery Pack, which connects to the Body 
Pack via the Battery Cable. The Battery Pack is a single unit 

made up of 3 Lithium Ion rechargeable cells, and has a 
typical rating of 10.8V and 2.9Ah.  This Battery charges via a 
single bay standard smart charger and provides up to 9.5 
hours of continuous recording time to the system. 

2.4 Cabling 

While transmission from the subject to the PC is completely wireless, there are a number 

of cables running through the MVN Link suit, connecting the MTx and MTx-STR’s to the 

Body Pack. Additionally, if the user chooses, there is the option of transmitting motion 

data to the PC from the BP by directly using an Ethernet cable between the Body Pack 

and the Access Point. This is particularly useful for applications such as skiing or 

snowboarding, where the wearer of the suit can connect directly to a laptop carried in a 

backpack. 
 

2.5 MVN Awinda / MVN Awinda starter neoprene case with contents 
Figure Description 
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Figure 6: Suitcase containing 
the MVN Awinda System 

The MVN Awinda arrives in durable neoprene case with 
protective frame, which contains: 
• 17(+1) Wireless Motion Trackers (MTw) 
• 1 Awinda Station 
• 2 Awinda Chargers 
• MTw full body Velcro straps, including 3 shirts, headband, 

footpads, 2 pairs of gloves 
• 1 Segmometer 
• Quick Setup sheet 

 

Figure 7: Suitcase containing 
the MVN Awinda Starter 

System 

The MVN Awinda Starter arrives in durable neoprene shell 
case with protective frame, which contains: 
• 17 Wireless Motion Trackers (MTw) 
• 1 Awinda Dongle with Antenna 
• 6 3-way USB charging cables 
• 1 6port USB hub 

Quick Setup sheet 

2.6 Motion Tracker (MTw) 
Figure Description 

 

Figure 8: Motion Tracker (MTw) 

Like the MTx, the MTw is a miniature inertial measurement 

unit containing 3D linear accelerometers, 3D rate 
gyroscopes, 3D magnetometers, and a barometer.  
Additionally each MTw contains an internal battery. The 
trackers are placed at strategic locations on the body 

(secured by the straps), to measure motion of each body 
segment. For more details about the MTw, see Section 5.2.1. 

2.7 Awinda Station / Awinda dongle 
Figure Description 

 

Figure 9: Awinda Station 

The Awinda Station controls the reception of 

synchronized wireless data from all wirelessly 
connected MTw’s. See Section 5.2 for further 
details. 

 

 
Figure 10: Awinda dongle 

The Awinda dongle controls the reception of 
synchronized wireless data from all wirelessly 
connected MTw’s. See Section 5.2 for further 
details. 
 

2.8 MVN Awinda Charger 
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Figure Description 

 

Figure 11: MVN Awinda Charger 

The MVN Awinda Charger is capable of 
charging six motions trackers. Charging from 
empty to full takes about one hour. 

 

Figure 12: 6 3way usb charging cables plus 6 
port USB hub 

The 6 3way usb charging cables plus the 6 

port USB hub are capable of charging 18 
motions trackers. Charging from empty to full 
takes about one hour. 

2.9 “The Suit” 
Depending on the system, either a Lycra suit or a set of mounting straps are provided. 

The Lycra suit, has been designed for MVN Link and the straps for MVN Awinda and MVN 

Awinda Starter. The generic term for either mounting type is simply “The Suit”. Each 

mounting system is dedicated to ensuring a good fixation to the body, to minimize skin 

motion artefact. 

 

For more information about each Suit type see Section 5.3. 

 
MVN Link MVN Awinda MVN Awinda Starter 

 

Figure 13: MVN Link Lycra suit 

 

Figure 14: MVN Awinda Straps 

 
Figure 15: MVN Awinda 

Starter Straps 

2.10 Motion Trackers on the extremities 
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The motion trackers are secured to the extremities – the head, hands and feet, using a 

headband, gloves and a foot pads, as can be seen in the figures below. 
Accessories for placing motion trackers on the extremities 

 

Figure 16: Headband 

 

Figure 17: Gloves 

 

Figure 18: Foot Pads 

2.11 Software 

The MVN system is controlled by a software application called MVN Analyze/Animate. 

MVN Analyze/Animate is a 64-bit application for Windows 10. There are four versions of 

MVN Analyze/Animate: MVN Basic, MVN Animate, MVN Animate Pro, and MVN Analyze. 

 

Additional software packages are available for users with specific needs:  

 

For users wishing to use the facilities offered by MVN, such as the biomechanical model 

and various other dedicated functionalities, for visualizing and collecting data the MVN 

Software Development Kit (MVN SDK) is available, where users can create their own user 

interface. 

 

MVN Basic, is our license free version. This version enables the view of recorded files and 

ability to record files. No exporting or streaming is enabled. 

 

MVN Animate Pro comes enabled with the capabilities of a real-time streaming interface 

from MVN to Autodesk Motion Builder® and Maya®. Additionally, the MVN remote 

control and MVN time-code plug-in are enabled for users who wish to accurately measure 

the time over which recordings are made (for example to facilitate synchronization with 

other devices such as cameras and audio equipment that also accept time-code as a 

synchronization means). 

 

To stream to Siemens PLM software, the Siemens Tecnomatix streamer is available with 

MVN Analyze. 
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3 Getting started 

3.1 Installation of software 

Note: Do not connect your MVN System (either Access Point or Awinda Station) 

until software installation is complete (software installation includes 

installation of relevant drivers which can be finalized, when the hardware is 

connected). 

 

Run the downloaded MVN Installer (mvn_studio#_setup.exe). Install with “Administrator” 

rights. Follow the on-screen instructions. 

• See 4.1 for details. 

 

3.2 Preferred language 

The option to present the software in Mandarin, Korean or Japanese, as a replacement of 

English is available under the preferences tab. 

 

 
Figure 19: Preferences tab 

 

By clicking in the User Interface section, one can change the language under the 

preferred language tab. Please note, this will require a restart. 

3.3 Setup hardware 
If using the MVN Link system: 

• Connect the Access Point to the computer using the network cable optionally with the 

Ethernet-to-USB adapter. See Section 0 

• After the suit has been put on, connect the head, hands, and feet trackers to the MTx-

STR’s  

• Place the Body Pack on the right and the Battery Pack on the left of the back (for 

more information on putting on the suit, see section 5.4 

• Connect the Battery Pack and all strings of trackers to the Body Pack 
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• Press the button on the Body Pack once to power on the device, a pulsing fading LED, 

solid LED, beep and finally blinking LED indicate the startup process. See Section 

5.1.2. 

 

If using the MVN Awinda (starter) system: 

• Connect the Wireless Master (see chapter: 2.7) to the computer or laptop 

• Turn on the trackers by pressing the button until each LED is activated and begins to 

flash 

• Place the straps and trackers on the body (for more information on putting on the 

straps, see section 5.4). 

3.4 MVN Analyze/Animate workflow overview 
Icon Description 

 

Run MVN Analyze/Animate. See Section 7. 

Start a new session. See Section 7.1.1. 

For MVN Animate Pro or MVN Analyze Pro users requiring additional hardware 
(reference camera or sync), initialize this hardware at the new session stage. 

Check the hardware status to make sure that all trackers that are needed for the 
given configuration have been detected by MVN Analyze/Animate. See Section 7.6. 

 

Calibration. See Section 8. 

For this step users should be in an area where they can walk back and forth for 5-10 
meters. 

• Ensure that the ‘Hardware and Fusion setup’ icon is active in the workflow tool bar. 
• On the Body Dimensions tab enter the subject height and Foot or Shoe length. See 

section 7.2.9. 
• Click the Calibration tab. Select N-pose + Walk and follow the instructions to 

perform a sensor to segment calibration. Additional calibration poses are also 

possible if expert calibration routines are enabled. See Section 8.1. 
• Pay attention to the calibration quality displayed in the Messages for Calibration 

window before applying the calibration to the character. See Section 8.1.4. 

 

Preview and Record. See Section 9. 

• The live character can be seen in MVN Analyze/Animate viewport. See Section 9.1. 
• To record a trial, click the red “Record” button. See Section 9.2. 

 

Playback and editing. See Section 10. 

• The recorded trials can be played, using familiar playback buttons. See Section 
10.3. 

• Contact editing is used to manually determine when contact is made between the 
subject and the surroundings. See Section 10.5.2. 

 

Analysis. See Section 11. 

• Graphical representation of all data, real-time and offline. Section 14.1. 

 

Saving and Exporting. See Section 15.  

MVN trials are saved directly as files with the .mvn extension. Files with this 
extension can be opened in MVN Analyze/Animate. Data can also be exported to:  
• BVH (BioVision Hierarchical data) embeds captured motion data in ASCII format 

which can be imported in many animation applications. BVH requires a strict 
hierarchal structure, and only relative joint angles can be exported into this file 
format. This will cause differences between the BVH output and the originally 

captured motion. See Section 15.1. 
• C3D (Coordinate 3D) is a format used prolifically in optical systems. The format is 

coordinate 3D; therefore bony landmark points have been calculated and exported 
from MVN (virtual marker set). See Section 15.2. 

• FBX (Filmbox) is a platform-independent 3D file format enabling access to 
Autodesk software (MotionBuilder or Maya). For some software packages, an FBX 

plug-in should be installed. FBX files exported from MVN contain position and 
orientation information of all 23 segments. See Section 15.3. 
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• MVNX is a human readable, XML format which can be imported to many other 
software programs, including MATLAB and Excel. This format contains the most 
information, including the sensor data, segment kinematics and joint angles, as 
well as the subject information needed to recreate a 3D visualization of a character. 
See Section 15.4. 

• Movie Exporter is an mpeg-4 (.mp4 or .avi) video export tool which contains a 

capture of the character’s live motion as configured in the display window. 
• Excel exporter creates a file which can be opened in Microsoft Excel directly 

3.5 Tips for best practice 

3.5.1 Operating conditions 

The recommended operating temperature of the MVN System is between 0°C and +50°C 

ambient temperature. If operated outside this temperature range performance may 

decrease or the device might be damaged. Fast transient temperature fluctuations may 

cause significant temperature gradients across the device. Such gradients cannot be 

properly modelled by temperature compensation and may therefore decrease 

performance. For optimal performance the ambient temperature should remain constant 

as much as possible during the measurement. Please be aware, that for product safety 

regulations (IEC 62368-1) it is not advised to wear devices on the body at temperatures 

above 43°C. 

 

The Awinda Station, Awinda USB Dongle, Awinda Chargers, Access Point, Body Pack, 

Battery Pack, and MT’s must be kept dry at all times. Condensation and water may 

damage the internal electronics. 

 

The MT’s should be protected from electro static discharges or sources of radiation, as 

exposure to such sources will damage the internal electronics. 

 

The MT’s should be protected from violent handling such as drops on hard surfaces. 

Excessive shocks or violent handling may damage the MT’s. When handling an MT at a 

desk, it is advised to place cushioning material on the desk. 

 

 

With MVN Awinda, if it appears that data performance is less than expected, try 

changing the radio channel to ensure a channel is used with minimal radio 

interference. 

3.5.2 Absolute maximum ratings 

Stresses above Absolute Maximum Ratings may cause permanent damage to the device. 
Description Value (MVN Link) Value (MVN Awinda) 

Shock (any axis):  100000 m/s2 (10000 g) 
unpowered/powered 

100000 m/s2 (10000 g) 
unpowered/powered 

Operating/Storage Temperature: 0 C - +50 C  0 oC - +50 oC 

 

Stresses beyond those listed here may cause permanent damage to the device. These 

are stress ratings only and functional operation of the MT at these or any other 

conditions beyond those indicated in the specifications are not implied. Exposure to 

absolute maximum rating conditions for extended periods may affect device reliability. 

 

Note: Drops onto hard surfaces can cause shocks of greater than 100000 m/s2 

(10000 g) exceeding the absolute maximum rating of the device. Care should be 

taken when handling to avoid damage. Drops causing shock greater than 

absolute maximum ratings may not destroy the device but will permanently 
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alter the properties of the physical motion sensors, which may cause the device 

to become inaccurate. 

3.5.3 Suit, shirt, short maintenance 

To wash the suit, shirt, shorts remove all cables, BP and MT’s. Follow the instructions 

on the label inside the suit: 
Description Icon 

Machine wash at 30°C – 85 F 

 
 

Do not bleach 
 

 

Do not iron 

 
 

Do not dry clean 

 
 

Do not tumble dry 
 

For the headband and gloves, remove the MTx and use only cold hand wash. 

3.5.4 FabriFoam Velcro Straps 

Do not place in washing machine or dryer as this may damage the material. Hand wash 

in warm water. Use mild detergent if soiled. Rinse well. Gently squeeze out excess water. 

Air dry, foam side up, on rack or towel or hang to dry. It is best to wash regularly to 

keep the material clean and free of body salts, oils, etc. This will help to prolong material 

life. 

3.5.5 Dynamic movements 

The MVN Suit/Straps should provide enough fastening for most movements. However, 

depending on the individual anatomy and fit with the Suit/Straps it might be necessary to 

take additional steps to ensure that the motion tracker follow the movement of the 

underlying body segment as well as possible. In particular, for users who will carry out 

extreme movements, martial art, professional athletes or jumping from heights; it is 

worth considering applying the provided straps over the Lycra suit as reinforcements to 

make sure the motion trackers follow the movement of the underlying segment. These 

straps should be tightly bound tape (be careful to not block the blood circulation!) over 

the locations of the MT on the body. Additionally, in contact sports or other situations 

where there is a chance of physical impact it might be beneficial to apply some protective 

measures (e.g. padding) to protect the person wearing the MVN system as well as the 

MVN system itself. 

3.5.6 Warming up the motion capture engine 

MVN Analyze/Animate has an advanced motion capture engine that is initialized after the 

calibration procedure. For best performance, it is recommended to warm up the system, 

before making recordings. To do so, follow the calibration instructions to stand still when 

applying the calibration and move rather slowly (e.g. walk around) for approximately the 

first 30 seconds after applying the calibration. See Section 23.8 and in particular 23.8.2 

for more details. 

3.5.7 CH5000 Charger Safety 

▪ Do not expose the charger or power supply to water or liquids.  

▪ Do not open the charger or power supply case, no user serviceable parts are 

inside.  

▪ Do not cover the fan exhaust or obstruct the airflow, this will cause overheating.  
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▪ Use only the manufacturer’s power supply and observe terminal polarity.  

▪ Place the charger in a cool spot, away from external heat sources  

▪ Caution - during recalibration the charger may become warm. 
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4 Software 
As mentioned in Section 2.11, the MVN system is controlled by MVN Analyze/Animate. 

The installer of the software can be downloaded from https://www.xsens.com/software-

downloads. The instructions below detail the installation procedure. 

4.1 Software Installation 

Note: Do not connect your MVN System (either Access Point, Awinda dongle, or 

Awinda Station) until software installation is complete. 

 

Run the downloaded MVN Installer (setup.exe). Always run installation as a user with 

“Administrative” rights (by right clicking on icon and selecting “Run as Administrator”). 

 

The MVN Analyze/Animate installer will install: 

• MVN Analyze/Animate 

• Documentation 

• Example files 

• Drivers for:  

• Xsens Access Point  

• MTw trackers 

• MVN Awinda Station and Dongle 

• MVN ethernet camera (Allied/Prosilica) 

• Dlink drivers 

• Bonjour drivers 

• Software activation tool 

 

Note: When starting MVN Analyze/Animate for the first time, allow the 

Windows firewall to give permission to MVN Analyze/Animate to start and 

connect to the internet. 

 

Plug-ins, including: MotionBuilder plug-in, Time Code and Remote Control plug-in and 

MVN SDK are optional. Separate installers are available for the MVN MotionBuilder and 

Maya plug-ins, the Unity plug-in and the MVN SDK. The Time Code and Remote Control 

plug-in is part of the MVN Analyze/Animate installer and is activated through licensing. 

4.2 Software Activation 

MVN Analyze/Animate needs to be activated before use. Activation can be done by three 

types of license keys; Software; Dongle; Network. More information about the licensing 

can be found in section 18.3. MVN Basic can be used without a license, allowing you to 

record MVN files. 

4.2.1 Software License Key 

When using a software license key, license activation is necessary. The Software Activation 

tool can be started from Start Menu > Xsens MVN 2021.x > Xsens MVN 2021.x > Xsens 

MVN Software Activation. Follow the on-screen instructions to start the activation, use the 

product key sent to you by customer service in email and ‘MVN Letter’. 

4.2.2 Dongle License Key 

Once MVN Analyze/Animate has installed and your license dongle is connected, the 

software will immediately recognize the license and open MVN Analyze/Animate. 

https://www.xsens.com/software-downloads
https://www.xsens.com/software-downloads
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Extension licenses or upgrade licenses can be activated on the dongle using the Software 

Activation tool, which can be started from Start Menu > Xsens MVN 20xx.x> Xsens MVN 

20xx.x > Software Activation. 

4.2.3 Network License Key 

When using a network license key, the red dongle needs to be used on a pc (server) that 

is running a service called ‘Sentinel LDK License Manager’. This service needs to be 

started by running an installer, which can be downloaded from: 

Xsens website: https://www.xsens.com/software-downloads 

Look for the download ‘Sentinel HASP/LDK - Windows GUI Run-time Installer’. 

https://www.xsens.com/software-downloads
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5 Hardware 

5.1 MVN Link 

The standard MVN System consists of a combination of hardware and software. The 

previous section described how to install the software. The following will provide an 

overview of the hardware, which includes the MTx’s, Body Pack, Sync Station and Access 

Point; and how to assemble the devices into the mounting system (Lycra suit or MVN 

Mounting straps). 

5.1.1 Motion Trackers (MTx) 

The MTx is a complete miniature inertial measurement unit with integrated 3D rate 

gyroscopes measuring angular velocities  3D linear accelerometers measuring 

accelerations including gravitational acceleration, 3D magnetometers measuring the 

(earth) magnetic field, and a barometer to enable measurement of atmospheric pressure. 

 

Two types of motion trackers are integrated in the suit, the MTx, and MTx-STR. These 

are identical on the inside but have different connectors, as can be seen in Figure 2. 
Figure Description 

Figure 20: MTx2 sensor 

The back of the MTx displays various regulatory notices and 2D 
barcodes used by Xsens for quality control and tracking, as well 
as the MTx product code (MTx2-4A7G6) and serial number1 

(SN).  
 
A Velcro strip is attached to the back of the MTx tracker around 
the sticker in order to allow for easy mounting of trackers onto 
the suit. 

5.1.2 Body Pack (BP) and Battery 

Bodypack Battery 

 
Figure 21: Body pack 

 
Figure 22: Battery 

The Body Pack (BP) interconnects multiple strings of MTx’s and retrieves their data 

ensuring exactly synchronized samples. The collected data is transmitted by an optimized 

2.4 or 5.0 GHz spread spectrum wireless link to the Access Point connected to the PC or 

via Ethernet cable. 

 

On the top of the Body Pack there are 4 connectors. With Xsens facing upwards, from 

right to left: 

• The large connector is a 5 pin connector which connects to the Battery Pack cable 

• The two central connectors are 5 pin connectors to connect to the strings of trackers 

 

 
1 Also known as Device ID. 
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On the bottom of the Body Pack, there are 3 connectors: 

• One Ethernet connector which can be used for cabled recordings, when the system is 

directly connected to the recording PC rather than transferring data via wireless signal 

• A micro USB connector, supported for future use to configure the BP 

 

The BP is powered by a single Battery Pack (rechargeable smart Lithium Ion battery 

pack). The Battery Pack has a typical operating time of 9.5 hours (using the wireless 

connection) and can be charged using the provided charger. 

5.1.2.1 BP Power on/off and status LED 

Each BP has one push button with integrated LED, which controls its power state. 

State Description 

Power on: Press button once, a single beep will sound and the LED will begin to 

blink slowly: 1 second on, 1 second off 

Power off: Press button three times, three beeps will sound and the LED will stop 
blinking. 

5.1.2.2 BP Status LED 

The status LED changes color depending on the BP state. 

LED indication Active mode 

Off Power down 

Slow fading flash Body Pack turning on 

Solid Wireless mode – searching for host 

Flashing Wireless mode – connected to host 

Strobe flashing Wireless mode – sending data 

5.1.2.3 Setup for wired connection via Ethernet 

This section refers to the wired connection between Body Pack and PC, via Ethernet 

cable. 

MVN is configured to operate in wireless transmission mode by default. However, an 

Ethernet connection can be made between the BP and the AP in order to directly transfer 

data to the PC. 

 

Note: The Ethernet connection should be established prior to turning on the BP. 

5.1.2.4 Running a Wi-Fi Protected Setup (WPS) 

In order to establish a connection between a Body Pack and an Access point, users must 

conduct a Wi-Fi Protected Setup (WPS).   

 

• After the AP is turned on, press and hold the WPS button located on the side of the 

unit for 2 seconds, until the connection light begins to flash (3 rapid strobes followed 

by a pause).  From the time this flashing begins you have 2 minutes to create a 

connection with the body pack. 

 

• Next, initialize the Body Pack and wait for the unit to beep and begin searching for 

a wireless connection.  Once the BP is initialized, press and hold the power button 

for 2 seconds and wait for the LED to begin flashing like the AP LED. 
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• A successful WPS is indicated by a beep and the BP LED will return to intermittent 

flashing. 

 

Any Router that supports WPS can be connected to a Body Pack. See the Tutorial video 

“WPS connection”. Click the address for a direct link to the tutorial. 

https://tutorial.xsens.com/video/wps-connection 

5.1.2.5 Soft Access Point 

To make the MVN Link system really portable you can connect the Body Pack directly to a 

laptop or tablet. From within MVN Analyze/Animate you can turn your computer into a 

wireless access point, which is called ‘Soft Access Point’ it is often also referred to as 

‘Virtual Router’. To enable this feature go to Options > Soft Access Point and tick the 

box.  

 

Note: To make use of this feature, MVN Analyze/Animate needs to be ‘Run as 

administrator’. 

 

See the Tutorial video “Soft Access point connection”. Click the address for a direct link 

to the tutorial. https://tutorial.xsens.com/video/soft-accesspoint-connection 

5.1.2.6 Wi-Fi Configuration Body Pack 

The Body Pack Wi-Fi connection can also be configured manually from the web interface, 

which can be started from MVN Analyze/Animate. Options > Soft Access Point  click 

‘Show advanced options’ and then click the button ‘Link configurations’ this will open the 

web interface for the Body Pack. 

 

 
Screenshot Description 

 
Figure 23: Web interface 

The web interface consists of a system overview and 
Wireless LAN Settings.  
 
Under the Wireless LAN Settings you can scan and manually 

connect to a network or start WPS. Here you can also set the 
Frequency Band and Channel that the Body Pack will scan 
on. The router determines the Frequency Band and Channel 
of the connection, setting the Frequency Band and Channel 
on the Body Pack that matches the settings on the router a 
connection will be made faster. 
 

Static IP address can also be set up here. 

 

See the Tutorial video “Manual Wi-Fi connect through Web interface”. Click the address 

for a direct link to the tutorial. https://tutorial.xsens.com/video/connect-to-wifi 

https://tutorial.xsens.com/video/wps-connection
https://tutorial.xsens.com/video/soft-accesspoint-connection
https://tutorial.xsens.com/video/connect-to-wifi
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5.1.3 Battery Charger 

The CH5000 is a standalone desktop smart, standard battery charger with the added 

ability to recalibrate the fuel gauge on smart battery packs.  

5.1.3.1 Using your Charger  

Place the charger on a flat, level surface away from sources of heat and moisture. Plug 

the DC connector from the power supply into the back of the charger and connect the 

power supply to the mains AC supply using the cable supplied.  

 
Figure 24: Battery charger 

5.1.3.2 Charging 

Place the battery into the battery bay ensuring that the 5-way connector is fully seated. 

The LEDs in the status window will provide status information and the charger will 

automatically begin charging.  

 

LED Indication:  

The status of the battery is indicated by the LEDs visible in the status window: 

LED indication Active mode 

Green flashing Battery charging  

Green solid Battery fully charged  

Blue flashing Battery in calibration mode  

Blue solid Battery fuel gauge calibrated  

Red flashing Battery fuel gauge needs recalibration  

Red solid Error 

 

Recharge and recalibration Time:  

The recharge time for the battery (NC2040) is 3 hrs. The time given is for a full charge 

from 0% to 100% state of charge. Recalibration is 16-20 hrs. A calibration cycle will be 

faster if the battery is fully charged to begin with. 

5.1.3.3 Fuel Gauge Recalibration  

If fuel gauge recalibration is needed, the red LED on a calibrating charger will flash upon 

insertion of the battery. This provides feedback on the accuracy of the fuel gauge. 

  

At this point you can choose to either calibrate the fuel gauge or to charge the battery. 

Calibration takes longer than charging and it may not be convenient to go through the 

calibration cycle at that moment. 
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To recalibrate the fuel gauge, press the button on the front of the charger. The charger 

will automatically begin to charge the battery if the button is not pressed.  

  

The blue LED will flash to indicate that the battery is undergoing the recalibration cycle. 

During calibration the discharge resistors will be cooled by the fan. Removing the 

battery, or pressing the calibration button again will re-start the process from the 

beginning.  

  

At the end of this procedure the blue LED will stay constant, indicating a fully calibrated 

fuel gauge. Warm environments can cause calibration failure - keep the charger away 

from direct sunlight or heat sources. 

For more details on smart charging and recalibration go to www.inspiredenergy.com 

 

Impedance-Tracking fuel gauge recalibration is achieved by charging the battery, 

allowing it to rest, discharging it and allowing it to rest again as shown below:  

• Charge the battery to full charge and allow it to rest for at least 5¼ hrs.  

• Discharge the battery to empty and allow it to rest for 5¼ hrs 

• At this point the fuel gauge is calibrated, but the battery is partially discharged 

and will require a recharge 

 

The temperature during the process must remain between 10°C & 40°C.  

5.1.3.4 What is fuel gauge recalibration and why is it needed?  

As the battery ages and is used, its available capacity shrinks - so with each cycle, your 

device’s runtime gets a little bit less.  

 

A good rule of thumb is that Li-Ion batteries lose 5% capacity per 100 cycles & 5% per 

year.  

  

http://www.inspiredenergy.com/
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5.1.4 Access Point (AP) 

The MVN System comes with one Access Point (AP) which handles the data traffic 

between the BP and the computer. The Access Point should be connected to the PC via 

Ethernet cable through the Ethernet port or using the supplied Ethernet to USB adapter. 

 
Figure 25: Access point 

 

1. LAN 1~4 LED 

• Off: No power or no physical connection. 

• On: Has physical connection to a local area network (LAN). 

4. 2.4GHz LED / 5GHz LED 

a. Off: No 2.4GHz or 5GHz signal. 

b. On: Wireless system is ready. 

c. Flashing: Transmitting or receiving data via wireless connection. 

5. Power LED 

a. Off: No power. 

b. On: Device is ready. 

c. Flashing slow: Rescue mode 

d. Flashing quick: WPS is processing. 

6. WPS button 

a. This button launches the WPS Wizard. 

8. Power button 

a. Press this button to power on or off the system.  

9. Power (DC-IN) port 

a. Insert the bundled AC adapter into this port and connect your router to a 

power source.  

12. LED On/Off button 

a. Press this button to turn on/off the backlight LED on the panel. 

13. LAN 1 ~ 4 ports 

a. Connect network cables into these ports to establish LAN connection. 

14. Reset button 

a. This button resets or restores the system to its factory default settings 

5.1.4.1 Positioning the Access Point 

For the best wireless signal transmission between the wireless router and the network 

devices connected to it, ensure that you: 
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• Place the wireless router in a centralized area for a maximum wireless coverage 

for the network devices. 

• Keep the device away from metal obstructions and away from direct sunlight. 

• Keep the device away from 802.11g or 20MHz only Wi-Fi devices, 2.4GHz 

computer peripherals, Bluetooth devices, cordless phones, transformers, heavy-

duty motors, fluorescent lights, microwave ovens, refrigerators, and other 

industrial equipment to prevent signal interference or loss. 

• To ensure the best wireless signal, orient the three detachable antennas as shown 

in the drawing below. 

 
Figure 26: Antennas orientation for best wireless signal 

Note: If the AP is connected to the computer through the supplied Ethernet to 

USB adapter, it will not function when a “Selective Suspend” power 

management feature is enabled on the PC/Laptop being used for recording. 

When the AP is used with “Selective Suspend” turned ON, the computer may 

hang during shutdown or possibly not shutdown correctly. You must therefore 

disable power management for the USB hub to prevent this.  

 

To do this, follow these simple steps:  

From the Start Menu >Right click on Computer >Manage >Device Manager >Universal 

Serial Bus Converters >Right click on USB Root Hub >Properties >Power Management. 

 

Uncheck the box “Allow the computer to turn off this device to save power.” OK your way 

out. 

Note: Doing this may significantly reduce laptop battery life. 

5.1.5 Awinda Station or Sync Station 

Figure Description 

 

Figure 27: Awinda station 
(sync station) 

MVN Link (version 4.1 onwards) supports synchronization with third 
party devices using an MVN Awinda Station or a Sync Station. The 
figure to the left shows the BNC connectors of the Awinda Station. 
 
Section 7.5 explains how to set up synchronization of the Awinda 

Station or Sync Station and Section 25 provides more details and 

examples with third party systems. 
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Note that if synchronizing with a third party device sending 5V, it is advised to purchase 

(from e.g. Farnell) a 3.3 - 5V / 5V - 3.3V SMD level translator to prevent damage to the 

Sync In ports of the Sync Station. 

5.2 MVN Awinda / MVN Awinda Starter 

5.2.1 Wireless Motion Trackers (MTw) 

The MTw provides 3D angular velocity using rate gyroscopes, 3D acceleration using 

accelerometers, 3D earth magnetic field using magnetometers, as well as atmospheric 

pressure using the barometer. Combined with Xsens algorithms, 3D drift-free orientation 

is provided. The MTw is an excellent measurement unit for orientation measurement of 

human body segments, in particular because it is also designed to maintain very high 

accuracy time synchronization of the individual sensor readout across a wireless network 

of multiple units. This is essential when measuring joint angles accurately. 

 

The MTw is powered using a LiPo battery. The battery can be in operation for up to 6 

hours, and maintain a level of charge in stand-by for approximately 90 hours when in 

sleep mode. It will be fully recharged after one hour docked in a wall powered Awinda 

Station. For more technical details on the MTw, sensor component specifications and 

orientation performance, see Section 23.12. 
Figure Description 

 

On the top of the MTw is an LED which indicates of device status. 

The MTw charges via micro USB connection located on its base. Next 
to this is a power button used to power each MTw on and off. 
 
The back of the MTw displays 2D barcodes used by Xsens for quality 
control and tracking, as well as the MTw product code (MTw2-

3A7G6) and serial number2 (SN).  

 
On the side of each MTw is a label indicating the pre-defined on body 
position. 
 
Velcro attached to the back of the MTw tracker allows easy fixation 
to the straps. 
 

The operating frequency of the MTw is 2405 – 2475MHz with a rated 
conducted RF power of 2 dBm. 

5.2.2 MTw LED Indications 

The following lists the LED indications of the MTw, which are a combination of the device 

states and the Awinda protocol states of the MTw. 
State Description 

Power-up  Blinking.  

Docked and fully charged ON 

Charging Slow fade from ON to OFF as a percentage [%] of battery status. 
A slow cycle means an almost full battery. A quick cycle means an 
almost empty battery. 

Scanning Pulsating out of sync with Awinda Station (CONN LED) 

Connected Slow symmetric ON/OFF toggle in sync with Awinda Station (CONN 
LED). 

Measuring  Fast symmetric ON/OFF toggle in sync with Awinda Station (CONN 
LED). 

Battery Low Quick Triple Pulses, overrides other states until charging again. 

 
2 Also known as Device ID. 

Figure 28: MTw 
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Flushing  Double pulse in sync with Awinda Station (CONN LED). 

Stand-by OFF. Blinks for 3 s, if motion has been detected, while searching 
for a radio connection. 

5.2.3 MTw Stand-by Mode 

Following a wireless connection to the Awinda Station or Dongle, the MTw enters 

measurement mode. If the radio of the Awinda Station or Dongle has been switched off 

for longer than 30 seconds the MTw will enter stand-by mode. In this mode, the MTw will 

shut down its power and stop the LED blinking, but monitor change in magnetic field 

every second. See below for exiting standby mode. 

5.2.4 Exiting stand-by mode 

The MTw will monitor its movement, if there is considerable movement, and there is a 

signal from an Awinda Station or Dongle, the MTw will become active again. 

To manually bring the MTw out of stand-by mode, reactivate the radio of the Awinda 

Station, and move the MTw. A simple 90 degree turn or simply lifting it from the suit 

case to apply to the subject should be enough. 

5.2.5 Awinda Station 

 

 

5.2.6 Awinda Station Synchronization Ports 

On the back of the Awinda Station there are four BNC ports, two Sync In ports and two 

Sync Out. The ports have been configured to send (Sync Out) or receive (Sync In) TTL 

pulses 0-3.3V.  

 

Note that this 3.3V is s lower than some devices, which will be synchronized with the 

MVN System. These other devices use 5V. For this reason it is advised to separately 

purchase (from eg Farnell) a 3.3 - 5V / 5V - 3.3V SMD level translator. This will prevent 

damage to the SyncIn ports of the Awinda or Sync Station when receiving 5V pulses from 

third party systems. In general sending a 3.3V pulse from an Awinda or Sync Station 

Figure Description 

 
Figure 29: Front view of the 

Awinda station 

Front view of the Awinda Station, showing the LEDs. A 

description of the LEDs is provided in Section 5.2.7 below. 
On top are docking spaces for 6 MTw’s with recessed micro 
USB connectors. On the side is a foldable and rotatable 2.4 
GHz antenna for maximum range. 
 
The external antenna of the Awinda Station enables a 

wireless range indoor/outdoor: 20/50 m (60/150ft).  

 
The operating frequency of the Awinda Station is 2405 – 
2475MHz with a rated conducted RF power of 19 dBm. 

 
Figure 30: Back view of the 
Awinda station 

Back view of the Awinda Station, showing the DC power 
connector, the USB connector and 4 BNC sync I/O 

connectors for synchronization with external devices.  
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SyncOut port is fine. Therefore unless a threshold of 5V of the third party system is 

required, in which case the 3.3V-5V SMD level translator will be required. 

 

For software configuration of the synchronization channels, see Section 25. 

5.2.7 Awinda Station Status LED 

The Awinda Station has five LED indicators. From right to left, these indicators are: 
Label Led Description 

CHRG 
 
[CHaRGer 
functionality] 

OFF When no mains power supply is connected to the Awinda Station. 

 GREEN: When 12V power supply is connected (mains power supply). 

STAT 
 

[STATus of 
the Awinda 
Station] 

OFF OFF: When no power supply is present and when MVN Analyze/Animate is 
not started. 

Power is from mains power supply and / or USB. 

 GREEN: Both USB connection present and MVN Analyze/Animate running 
connected to driver. 

 ORANGE: USB connection to host PC is present. 

 RED: Only power supply connected or error has occurred, e.g., a short-
circuit of an MTw. 

EXT 

 
[EXTernal 
connection] 

OFF Remains off unless external connection made. 

 GREEN: External connection e.g. sync port. 

CONN OFF OFF: No wireless connection. 

 GREEN slow blinking: (1 blink per second), radio switched on. When MTw 

connects, MTw LED and CONN LED blink synchronously. 
Fast blink: Measurement Mode. 

DATA OFF OFF: No data received. 

 GREEN: Measurement mode. 

 ORANGE: Flushing. Flushing is the action of transferring data that has 
been stored on the MTw buffer, while the MTw was out of range and 
unable to transfer data in real-time to the Awinda Station. 

 RED: Recording mode is active. This allows the remote monitoring that 

the host PC has initiated a recording successfully. 

 

Note: The power supply is needed to charge docked MTw’s or to change 

between power off and power on, of docked MTw’s. Only the power supply is 

needed for charging purposes (USB is not needed in this case). Power supply 

and USB connection are required for firmware updates or location reassignment 

of MTw’s. 

 

Power supply is not needed for wireless communication (e.g. measurement/recording). 
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5.2.8 Awinda USB Dongle 

Figure Description 

 

Figure 31: Awinda USB dongle 

The Awinda USB dongle has the same wireless capabilities 

as the Awinda Station, in that it can accurately control the 
reception of data of up to 32 MTw’s. 
 
Given that the Dongle does not have an external antenna its 
range is shorter than the Awinda station; indoor/outdoor 
10/25m (30/75ft). 
 

The operating frequency of the Dongle is 2405 – 2475MHz 
with a rated conducted RF power of 2 dBm 

 

Figure 32: Awinda Dongle ANT 

The Awinda Dongle ANT with external antenna has the same 
radio design and wireless capabilities as the Awinda Station, 
in that it can accurately control the reception of data of up to 

32 MTw’s. 
 
The Awinda Dongle ANT has a range that is in line with the 
Awinda Station; indoor/outdoor 20/50m (60/150ft). 
 
The operating frequency of the Dongle is 2405 – 2475MHz 
with a rated conducted RF power of 19 dBm 

5.2.9 Awinda USB Dongle LED 

The Awinda USB dongle has one white LED. 
State Description 

Radio Off LED off. 

Scanning for MTw’s Pulsating LED. 

Connected Slow symmetric ON/OFF toggle (MTw blinks in sync with LED of dongle). 

Measuring  Fast symmetric ON/OFF toggle (MTw blinks in sync with LED of dongle). 

5.2.10 Powering off MVN Awinda 

Power off the MTw’s by clicking on each tracker’s power button. 

 

To power off wirelessly, the system should be wirelessly connected. To power off, go to 

menu >Tasks >Switch Off Hardware. All MTw’s will switch off. The MTw LEDs and the 

CONN LED of the Awinda Station will switch off. 

5.3 The suit 

The MVN system arrives with motion trackers either mounted into a Lycra suit or located 

in a tray with a set of accompanying MVN straps. The generic term for the straps or the 

Lycra suit is simply “The Suit”. Below a description of how to mount the straps or suit is 

explained, followed by the advice for the extremities (hands, feet and head), which are 

the same for both systems. 

5.3.1 Straps 

The MVN Strap set consists of a set of patented non-latex composite material; these are 

often used in the medical profession, and are safe and hygienic. Additionally zip-fastened 

T-shirts in three sizes are provided for securing the sternum and shoulders. 

 

Straps are provided as a standard mounting system with MVN Awinda and are useful for 

interchanging setups between (different sized) subjects. 
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Straps are suitable for a majority of the adult population and can be placed directly on 

the skin for the close contact, or on top of the clothing for comfort. If worn over clothing, 

it is advisable to wear relatively tight-fitting clothes. 
Figure Description 

 
Figure 33: MTw side view 

The motion trackers are provided with a code 
indicating segment position. 
‘L’ or ‘R’: left or right side of the body. 
Segment: An abbreviation of the segment name. 

 
Figure 34: Full body strap set 

While the straps are not labelled, the dimensions 

give an indication of their intended locations. 
 

 

Segment Width (cm) Length (cm) 

Pelvis 10 140 

Upper Leg 10 72 

Lower Leg 5 55 

Upper Arm 5 55 

Forearm 5 30 

5.3.1.1 Putting on the Straps 

Below are a few simple steps to help put on the straps. It is advised to watch the tutorial 

video for more detailed and visual information. https://tutorial.xsens.com/video/placing-

straps 

 

• It is recommended to begin by putting on the top. 

• Since the sternum and shoulder trackers are attached to Velcro patches on a zip-

fastening t-shirt, it is advised to secure this garment before attaching the upper arm 

straps. 

• For the arms, legs and pelvis: Straps should first be placed (tightly) onto the limb in 

question, fasten the tracker in place then wrap the remaining length of the strap tightly 

around the limb and fasten using the Velcro tab. 

• It is necessary to have assistance for positioning the motion trackers of the shoulder 

blades after the zip on the vest has been secured. It is also advisable to have assistance 

for accurate positioning of the tracker at the pelvis, while the wearer (or second 

assistant) wraps the remaining length of the strap around the waist. 

• Check that the Straps are fastened tightly enough to the body.  

To do this, the subject wearing the straps should walk, run or perform sample 

movements to be measured. If the straps become loose, re-tighten them and repeat 

the check.  

Note: When tightening the straps, pull the strap from the center of the length 

rather than at the end! 

5.3.2 MVN Lycra suit 

A Lycra suit is provided with the MVN Link system. The MVN Lycra Suit is available in 6 

different sizes (S, M, L, XL, XXL and 4XL). Before putting on a suit, ensure that the size is 

appropriate. The suit must be tight fitting, therefore choose the appropriate suit size. 

Note that the fabric is stretchable, a medium size suit can fit to both a short muscular 

athlete (e.g., 1.60 m, 70 kg) and a tall slim person (e.g., 1.75 m, 65 kg).  

 

Take care when putting on the suit; you are working with delicate materials. The subject 

is advised to wear closely fitting shorts and a tight shirt underneath the MVN Lycra Suit. 

https://tutorial.xsens.com/video/placing-straps
https://tutorial.xsens.com/video/placing-straps
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Other clothing can be worn on top, no connection or line-of-sight is needed to the 

external world other than the wireless data link. Follow these steps to put on the suit: 

 

Important: 

• The zip is at the front of the Lycra suit. 

• Do not pull aggressively on the material, work gradually from the feet to the neck. 

5.3.2.1 Putting on the Lycra suit 

Below are a few simple steps to help put on the Lycra suit. Again it is advised to watch 

the video on the tutorial portal for more detailed, visual information. 

https://tutorial.xsens.com/video/putting-on-lyrca-suit 

5.3.2.2 Placing the MT’s in the Lycra suit 

Upon delivery, the Lycra suit will come with MTx inside already. However, for changing 

suit sizes or after washing, you will need to put the motion trackers back in the suit. It is 

advised to do this when the “empty” suit is already on the subject. The video on the 

tutorial portal shows how to do this best. https://tutorial.xsens.com/video/preparing-

hardware-mvn-link 

5.3.3 Putting on the remaining Motion Trackers 

When the suit has been put on, motion trackers for the head, hands and feet will remain 

outside of the Lycra. The head band is fitted with a Velcro patch, and gloves are fitted 

with a pocket for motion tracker placement. The motion trackers for the feet are secured 

to the shoes using foot pads, as described in section 5.3.4. 

5.3.4 Foot pads 

Dedicated foot pads have been made to facilitate placement of the motion trackers on 

the feet, these pads can be used with many different types of shoes and remain fixed to 

the feet, minimizing motion of the tracker on the foot and ensuring reliable motion 

capture data and foot contact detection. 

 

 
Figure Description 

 

Figure 35: Foot pads 

To use, place the pads with the motion tracker 
attached onto the bridge of the foot, tongue of 
the shoe. It is best to push this a little further 
to the front of the foot, since when the shoes 

are fastened, it can slip upwards. Make sure 
the shoe fastening e.g. prevent the tracker 
from shifting within the shoe. 

5.3.5 Putting on the Body Pack and Battery Pack 

The Body and Battery Packs are placed into the pockets at the back of the Lycra suit. 

While it is not crucial, it is more comfortable if you the Body Pack is on the right and the 

battery on the left. 

5.3.6 Tracker locations 

The placement of the motion trackers onto the correct segment is very important, as 

each tracker has a given ID, which is used throughout the motion capturing procedure. 

Additionally, it is important that the motion trackers are positioned on the segment in a 

place where maximal range of motion and a minimal amount of skin motion artefact 

occurs. When wearing the Lycra suit, it is more likely that the MTx’s are positioned 

https://tutorial.xsens.com/video/putting-on-lyrca-suit
https://tutorial.xsens.com/video/preparing-hardware-mvn-link
https://tutorial.xsens.com/video/preparing-hardware-mvn-link
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correctly than with the Straps. Therefore please refer closely to the following information 

to ensure the best placement. The table below describes the positioning of the motion 

trackers. 
Location Abbreviation Optimal position 

Foot FOOT Middle of bridge of foot 

Lower leg LLEG Flat on the shin bone (medial surface of the tibia) 

Upper leg ULEG Lateral side above knee 

Pelvis PELV Flat on sacrum 

Sternum STERN Flat, in the middle of the chest 

Shoulder SHOU Scapula (shoulder blades) 

Upper arm UARM Lateral side above elbow 

Fore arm FARM Lateral and flat side of the wrist 

Hand HAND Backside of hand 

Head HEAD Any comfortable position 

 

Watch the video on the tutorial portal for instructions on how to put place the MTw’s on 

the straps. https://tutorial.xsens.com/video/preparing-hardware-mvn-awinda 

 

5.4 Connecting the hardware and software 

To connect the hardware and software, connect to the Access Point or plug the Awinda 

Station into the USB port of the pc. When using the MTx, make sure that the BP is 

switched on. Start MVN Analyze/Animate to begin working with the system. 

https://tutorial.xsens.com/video/preparing-hardware-mvn-awinda
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6 MVN Analyze/Animate 
MVN Analyze/Animate is easy-to-use software, which can be used for real-time viewing 

and recording. Off-line playback, analyzing and editing of previously recorded sessions 

are also possible with MVN Analyze/Animate. Figure 36 shows a typical view of MVN 

Analyze/Animate when a recording has been made. 

Figure 36: MVN Analyze/Animate interface 

The main tool bar at the top of the MVN Analyze/Animate interface is displayed in  

Figure 37 below. Using this toolbar, much of the functionality of MVN Analyze/Animate 

can be called. 

 

File Edit Network streamer, Record & Playback 
Workflow and 

views 

    
 

Figure 37: Main toolbar in MVN Analyze/Animate 
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6.1 Status Bar 
At the bottom of the MVN Analyze/Animate interface is the status bar. It is important to 

pay attention to the icons shown here, as they give important information about the 

status of the system. 

 

Figure 38: Example of Status Bar in MVN Analyze/Animate 

• Frame number - Time 

• Hardware status – status of wireless connection 
Disabled Searching Ready 

   
• Power – energy levels of batteries in for the Battery Pack or MTw’s3  

        
Empty       Full 

• Radio – quality of wireless connection for the BP or MTw’s4 
Unknown Bad Moderate Good 

    
• Update Rate: 60Hz, 100Hz, 120Hz, 240Hz 

• See Section 23.8 for more information about sample frequency versus update rates. 

• Position aiding Hardware status  
Good position 

quality 

Acceptable 

position quality 

Poor position 

quality 

Fair position 

quality 

No position 

data 

Duplicate 

position data 

      

6.2 Command line interface 

MVN Analyze/Animate also has a command line interface to allow users to automate 

some of the processes. 

• Command line options include Run, Reprocess, Export, Copy and Trim. For a full 

overview of the options: open a ‘Command Prompt’ in ‘C:\Program 

Files\Xsens\Xsens MVN 20xx.x\MVN Studio’ (Shift + RMB > ‘open command window 

here’). 

• Run ‘mvn_studio64.exe –h’ to get an overview of the available options 

 
Figure 39: Command line interface 

 
3 Note that the battery indicators are also available in ‘Hardware’ pane. The animated battery in the 
status bar indicates the battery life of the MTw with the least amount of power. 
4 Note that the signal strength indicates that of the weakest wireless link to the connected MTw 
network. 
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7 Workflow and Functionalities in MVN Analyze/Animate 
MVN Analyze/Animate is designed for optimal flow of the steps required for recording and 

analyzing motion. Different workflow items become active at various stages. 

 

       

Figure 40: The workflow toolbar gives the user an optimal interface setup per functionality: 
Hardware and Fusion Setup, preview and record, playback and editing and analysis 

7.1 New session 

A new session is created during the workflow stage “Hardware and Fusion Setup”. Before 

creating the new session, ensure that the hardware is connected and powered on. 

7.1.1 Create a New Recording Session 

To create a new session, click the icon or go to File >Create a new recording session. 

Figure 41 shows the first interface to appear. 

 

   

Figure 41: Configure a new session 

Note that all details are default and ready for first time use. For quick start, wait for the 

status indicators on the avatar to turn green, click ‘’Ok’. Now the live, uncalibrated 

character will appear on screen. Go to Section 8 for instructions to proceed. 

 

For a more informed, step-wise approach, it is useful to watch the tutorial or read the 

following steps for guidance below. 

 

The Configure Session window shows 4 possible MVN Systems that can be connected to, 

systems, see 7.2 for more detailed explanation. On top of that, the Stealth mode can be 

enabled or disabled in the General Settings tab, see 7.3. The two bottom tabs are to 

configure the Video Camera (see 7.4) and the Sync Station (see 7.5). The connected 
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hardware can be configured in the Hardware Status panel (see 7.6) and the Navigator 

panel is described in 7.7. Tutorial video about setting up a recording session: 

https://tutorial.xsens.com/video/set-up-a-recording-session 

7.2 Configure an MVN System 

For each of the four possible MVN Systems, the user can configure the individual 

settings. Note that the Sync Settings dialogue is available only with an MVN Analyze 

license. 

7.2.1 Enable/disable search for new system 

 As described above, click the button on the top left corner from OFF (red) to ON 

(green). While the default settings are enough to proceed with a single suit, additional 

changes can be made. 

7.2.2 System Status 

The system status can be monitored by checking the indicators on the avatar. 

Hardware status pane can be opened by clicking on the ‘tool’ icon. In accordance with 

traffic-light indicators, green indicates that everything is in order, while red indicates that 

there is a problem to be addressed. In the expanded view, the text accompanying the 

colored icon specifies the problem and clicking the spanner opens the hardware status 

window for detailed trouble shooting. 

7.2.3 System Name 

It is advised to change the name of the system from “MVN System 1/2/3/4” to a more 

personalized name, for example the name or ID of the person wearing the system. (It 

can also be deleted if not needed.) 

7.2.4 View Hardware Status 

 For MVN Link this view is only needed for troubleshooting or relocating trackers. For 

MVN Awinda, it may be necessary to change the radio channel, which is possible in the 

hardware status window. See Section 7.6 for detailed information. 

7.2.5 Suit Configuration 

When a connection between the PC and the live system is made, a detection phase takes 

place within MVN Analyze/Animate to detect all necessary hardware. To ensure that MVN 

Analyze/Animate searches for the correct hardware, ensure that the correct suit 

configuration is chosen. If for example full body is selected, when no hands are 

connected, this will result in an error when the suit is detected. There are multiple suit 

configurations possible in MVN. The suit configurations, sensors required for each for 

each are given in the table below:  

 

https://tutorial.xsens.com/video/set-up-a-recording-session
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Suit Configuration Picture (green = 
active sensors, blue 
= inactive sensors) 

Number 
of 
Sensors 

Max Update 
rate – MVN 
Awinda (Hz) 

Max Update 
rate – MVN 
Link (Hz) 

Full Body 

 

17 60 240 

Full Body no hands 

 

15 60 240 

Lower Body 

 

7 100 240 

Upper Body 

 

11 60 240 

Upper Body no 
Hands 

 

9 100 240 

Lower Body with 
Sternum  

 

8 100 240 
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7.2.6 Scenario 

Depending on the type of measurement you will carry out, select the type of scenario 

that will ensure the best results, and minimize post-processing. The scenarios available 

include: 
Scenario Description 

Single Level This scenario assumes that the subject will be walking on level terrain 

Multi Level This scenario assumes that the subject will be walking on terrain or varying 
height, e.g. climbing stairs. 

No Level This scenario assumes that the subject will remain in a seated position, e.g. 
in a car. This means that the pelvis will remain at a preset height. 

Soft Floor This scenario is used if it can be assumed that the feet will slightly decrease 

in height, during the time between the feet contacting the ground and 
leaving it, e.g. grass, or soft carpet. 

Vehicle  It is now possible to select a vehicle scenario for your data collection 

sessions. The vehicle scenario is very similar to the No Level scenario with 
an adjustment to the acceleration divergence monitoring. Meaning it can 

cope better with long and slow accelerations, such as when turning a 
gradual banking in a car. To select this scenario, when configuring your 
motion capture session, simply select vehicle in the Scenario tab. 

 

7.2.7 Accept Systems 

From this drop-down menu, select the type of hardware connected to MVN 

Analyze/Animate. This is set to “Any” as default, making it easy if only one system is 

connected. It is also possible to specify MVN Link or MVN Awinda. 

7.2.8 Max Update Rate 

From this drop-down menu, select the update rate for the systems.  

Note: MVN Awinda (starter) full body max update rate is 60Hz, MVN Awinda 

(starter) lower body max update rate is 100Hz and MVN Link full body max 

update rate is 240Hz 

7.2.9 Body Dimensions 

 

Figure 42: Input body Dimensions of test subject.  

Figure 42 shows the interface for inputting the subject dimensions prior to a sensor to 

segment calibration. It is necessary to input Body Height and Foot length (shoe length at 
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the time of the measurement) in order for MVN Analyze/Animate to calculate other 

segment lengths (based on an anthropometric model).  

Note: A recording cannot be performed if the user does not insert these values; 

then the following error will be shown5 (Figure 43). 

 

Figure 43: Error if recording attempted without subject height and foot length. 

In addition to these basic measurements, other body segment dimensions can be 

adjusted for subject-specific anthropometry. The model-based values are presented 

between brackets, e.g. Knee Height “(48.61cm)”. The scaling model is based on the 

height of the subject without shoes. The extra sole height can be added as an offset to 

the feet. The height of the ankle joint will be adjusted internally and other segment 

dimensions, such as the leg length, will not change. If the subject and ankle height are 

measured with shoes on, all segment lengths will be scaled based on this length and the 

shoe sole thickness should not be entered. 

 

It is possible to provide values in either metric or imperial units. Metric units are active 

by default. To switch to imperial units go to: Options >Preferences >Interface >User 

interface >‘Use imperial units (inches)’. 

 

The specific body segment dimensions are presented in Figure 42. They can be found by 

palpating the anatomical landmarks, presented in the figures on the next page and in the 

online video tutorials: https://tutorial.xsens.com/video/body-measurements 

 

Be careful! If you are not sure how to accurately measure the dimensions, do not change 

the default values; the calculated values are generally accurate enough. 

 

To scale the model with these dimensions, click ‘Apply’. The system will automatically 

update dimensions for which no user input is provided.  

 

The subject body dimensions can be saved to your computer as an MVN Actor (.MVNA) 

file which then can be loaded the next time the same subject is used. After loading a 

subject file, it is still necessary to perform a segment calibration. It is also possible to 

modify body dimensions and reprocess the file with the new settings. 

 

In order to facilitate data collections, body dimensions can be measured beforehand and 

input into MVN Analyze/Animate without connecting an MVN suit in the Session 

Configuration. This feature allows users to save body dimensions as an MVNA file prior to 

instrumenting a subject.  Later, when the system is connected, the file can be loaded 

again from the Body Dimensions panel. 

 

 
5 Note that a recording can be performed without prior insertion of body dimension and without a 
calibration, if the feature “Allow uncalibrated recording” is enabled in the preferences menu. 

https://tutorial.xsens.com/video/body-measurements
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Dimension Description 

Body Height Ground to top of head when standing upright 

Foot or Shoe length Length of feet or length of shoes if wearing shoes 

Shoulder Height Ground to C7 spinal process 

Shoulder Width Right to left distal tip of acromion (acromial angle)  

Elbow Span Right to left olecranon in T-pose 

Wrist Span Right to left ulnar styloid in T-pose 

Arm Span Tip of right fingers to tip of left fingers in T-pose 

Hip Height Ground to most lateral bony prominence of greater trochanter 

Hip Width Right to left anterior superior iliac spine 

Knee Height Ground to lateral epicondyle on the femoral bone 

Ankle Height Ground to distal tip of lateral malleolus 

Extra Shoe Sole 

Thickness 

Additional thickness of soles, different from normal shoe sole height.  

Use for stilts, platform soles, etc. When this value is set, all other 
dimensions measured from the ground should NOT include this value. 

 

 

 

 
Figure 44: Anatomical landmarks on leg (left) and arm (right) 

7.2.10Props 

In addition to the normal suit configuration, additional MT’s can be attached to items to 

be measured in a recording, for example a sword, or a walking stick. These items to be 

measured are called “Props” and the motion tracker (MTw or MTx) attached to them are 

“Prop Trackers”. A prop can be tracked by attaching a prop sensor to one of the free 

connectors on the hands. 

The prop tracker must be configured in the new session dialog under ‘prop’ tab. Here, the 

type of prop can be selected (crutch, sword, gun, golf club, generic [this is simply a 

right-handed axis]), which can be assigned to a given suit and a given motion tracker ID. 

 

 

Greater trochanter 

Lateral epicondyle 

Lateral malleolus  

Ant. sup. iliac spine 

 

Lateral epicondyle 

Radial styloid 

Acromion 
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Generally the motion tracker on the prop is detected automatically when clicking ‘Apply’ 

in the Prop Configuration window. If this does not occur, go to Tasks >Re-initialize 

suit(s). The prop mesh (the on-screen image of the prop sensor) can be connected to 

any defined point on a body segment. The prop can be rotated freely but will always 

follow the position of the selected point. By selecting the ‘or’ option, the prop tracker can 

be swapped between two segments, for example the right and left hand (see the 

example in Figure 45). MVN Analyze/Animate will automatically detect the side on which 

the motion tracker is connected. 

  

Figure 45: Prop configuration menu 

 

The prop tracker should be mounted onto the prop such that two sides of the casing are 

parallel with the prop. For example, mount the prop tracker on the flat side of a sword 

with one axis aligned with the blade of the sword. Then, the orientation of the motion 

tracker can be set according to the natural orientation of the physical prop when holding 

it while in an N-pose. For more information, watch the tutorial for the MVN Awinda or 

MVN Link below. 

 

Setting up props for MVN Link:https://tutorial.xsens.com/video/setting-up-props-for-

mvn-link    

Setting up props for MVN Awinda: https://tutorial.xsens.com/video/setting-up-props-for-

awinda 
 

https://tutorial.xsens.com/video/setting-up-props-for-mvn-link
https://tutorial.xsens.com/video/setting-up-props-for-mvn-link
https://tutorial.xsens.com/video/setting-up-props-for-awinda
https://tutorial.xsens.com/video/setting-up-props-for-awinda
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7.2.11 Sync 

 

With MVN Awinda, the dialogue to configure the sync settings is in the MVN 

System configuration. To configure the Sync Station which is the method for 

synchronizing MVN Link with third party devices, the sync settings are 

configured via the Sync Station tab, see 7.5 . 

 

It is worth noting that sync with MVN Awinda is tighter than with MVN Link due 

to the tight control of the Awinda Station over the MVN Awinda System. 

For detailed information regarding sync settings, refer to section 25. 

7.3 General Settings 

In the general settings tab, the user can enable the “Stealth Mode” option which disables 

all sounds and LED’s on the body pack.  

7.4 Configuring the Video Camera 
If a video camera is to be used, enable the “Video Camera” in the respective tab. Note 

that before this can be configured, The MVN reference camera, must be plugged into the 

mains power supply and to the network connector of the pc or laptop in use. MVN 

Analyze/Animate should automatically detect the camera (if not, use the command “Scan 

for cameras”). If using a MVN Link system, connect the camera Ethernet cable into the 

Access Point and connect the AP directly to the Computer via Ethernet. Or choose the 

MVN Remote camera under source. 

7.4.1 Configuration 

Changing the video configuration is effectively changing the frame rate. 

MVN Analyze/Animate supports VGA, video data will always be in color, with a resolution 

of 640 x 480. 

To avoid flickering due to artificial lighting related to the mains frequency (50 Hz in 

Europe, 60 Hz in USA), select the appropriate frame rate (25 or 50 fps for Europe or 30 

or 60 fps for USA). 

Note that unless using a high performance computer with a fast HDD, it is advised that a 

lower frame rate is chosen (25 or 30 fps). 
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Figure 46: Example of camera configuration window 

If no pictured is displayed, if the image is jagged, or no camera is found, install the 

dedicated driver, found in C:\Program Files\Allied Vision Technologies. You may have to 

restart MVN Analyze/Animate for the camera to be found after this is installed. If no 

video data is displayed, check or uncheck the Use jumbo packets option to resolve the 

issue. The camera needs be connected to the dedicated ethernet port on the pc, whereas 

the internet connection can use the USB to Ethernet adapter. 

 

You may select to check the Auto Gain box or manually adjust the gain of the video 

yourself in this window. 
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7.5 Configuring the Awinda Station (or Sync Station) 
The Awinda Station as part of the MVN Awinda setup can also be used for synchronizing 

between MVN Link and third party systems. The user will note that when MVN Link is 

selected, the text beside Sync Settings states “Not sync capable”. The Awinda Station (or 

Sync Station) must be inserted for synchronization with MVN Link (Figure 47). 

  

Figure 47: Sync settings 

Click  to configure the sync settings. For details about each setting, refer to Section 

25. 
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7.6 Hardware Status 

To view the Hardware Status, Select the  in the configuration window. 

 

Hardware status shows a list of all trackers and masters detected by MVN 

Analyze/Animate. The figures below show the hardware status interface and Table 1 

details the meaning of the colored markers. This menu can be edited while the Configure 

Session window is also open, instructions for editing can be found below. When the 

Configure Session is not open, this interface is read-only. 

  

Figure 48 Hardware Status before a wireless 
connection has been established 

  

Figure 49 Hardware Status network connection 
is established and ready to measure 

Table 1: Legend of colored markers in detected hardware screen 

Icon Legend message Description 

 Not detected Motion tracker of a given segment is not detected 

 Tracker Rejected When a tracker is double click, indicating it is not 
needed, it is known as “rejected”. Its icon becomes grey. 

 Tracker Connected (MTw) Motion tracker is connected to the master 

 Master detected 

Network not locked 

Wireless master is detected. Red icon has not been 

double clicked to secure the network.  

 Connected (Master) Green icon at the master indicates network is secured. 

 MT unused An extra motion tracker has been detected 

 Duplicate More than one motion tracker has been detected with the 

same location ID. 

When all trackers have been detected, it may take some time (up to 30 seconds) to 

secure the network and for the 3D character to appear. Additionally, it may take several 

seconds for the battery status to display, please be patient to allow the information from 

each tracker to be transmitted to MVN Analyze/Animate. 
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7.6.1 Relocating motion trackers 

Each Xsens motion tracker has a unique location ID which relates them to the limb 

segment they should be placed on. If for some reason, a tracker has the wrong ID 

assigned to it, e.g. if an additional motion tracker is detected or a broken MT needs to be 

replaced with a spare, this can be done easily by reassigning the MT’s ID to the desired 

position. 

 

To assign a tracker to a different segment, drag and drop the ID to the Location, or vice 

versa. Alternatively, right click in the correct row and select “Update location to”. To 

ensure that the changes are saved, go to >Tasks >Reinitialize suit(s). 

 

Note that if two motion trackers are accidentally exchanged, for example on the hands or 

feet, do not use this function but reconnect the MT’s to the appropriate side and wait for 

the hardware status to update. 

 

Figure 50 Relocating trackers 
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7.6.2 MVN Awinda: Changing Radio Channel 

 

For MVN Awinda users, the Hardware Status is necessary in order to configure 

the network detection status of the system. 

Figure 48 Shows a list of motion trackers expected to be found by the MVN 

Awinda system. The icons of these trackers are black indicating that they are 

expected but not yet detected. As the Awinda Station is searching for MTw’s, 

the CONN LED of the Awinda Station, or the white LED of the Awinda USB 

dongle blinks rapidly. As each MTw connects, its LED will blink synchronously 

with that of the Awinda Station and its indicator will turn green in the Hardware 

Status window, see Figure 49. 

When the trackers has been detected, the status of the remaining battery 

power ( ) and the wireless strength ( ) of each tracker is available, see 

Figure 49 for an example. 

7.6.3 MVN Awinda: Changing Radio Channel 

 

In the Hardware Status window, either right click or double click the number 

under the letters “Ch”. A small menu appears providing the option to change 

radio channel, reject unused trackers or “forget” system. 

In general, when working in an environment known to have a lot of WiFi traffic, 

it is best to select channel 11, 15, 20 or 25. See Section 23.11.1 for background 

information. 

7.6.4 MVN Awinda: Reject Unused Trackers 

 

Again, in the Hardware Status window, either right click or double click the 

number under the letters “Ch”. 

From the small menu it is possible to reject unused trackers. It is possible that 

the MTw is powered on, but not needed for a particular session. This is 

particularly useful for owners of multiple Awinda Systems where an MTw is 

detected by one Awinda Station but is needed at another. To remove detected 

trackers, either select the “reject unused trackers” or double click anywhere on 

the row the tracker appears in and select “Reject on Master ********”. If this 

was done accidentally of you want to accept a new tracker, simply double click 

again and select “Accept on Master ********”. 

7.6.5 MVN Awinda: Forget System 

To explain the use of the command forget system it is first useful to understand how 

MVN Analyze/Animate deals with connection. For single person capture, the information 

in the hardware status window tends to always be the same tracker/master information. 

However it may change depending on: different suit configurations and whether or not 

props are used. Additionally, some institutes may have multiple suits within radio contact 

of each other, each measuring one subject. For this latter usage and for the purpose of 

multi-person capture (multiple suits connecting to one MVN Analyze/Animate instance), 

MVN Analyze/Animate actively remembers which motion trackers have connected to 

which master (Awinda Station or Body Pack). The result is that when the user attempts 

to connect the trackers to the same master at a later time, MVN Analyze/Animate only 

allows the remembered trackers to connect. This ensures efficient connections for always 

using the same suit configuration and prevents unwanted connections between masters 

and trackers. 
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Again, in the Hardware Status window, either right click or double click the 

number under the letters “Ch”. 

If a user attempts to make a connection in an existing configuration between 

an Awinda Station and a tracker used for the first time the option “Forget 

System” should first be selected. After this command, all trackers (including 

previously rejected ones) can connect again. 

 

When all devices necessary for the suit configuration are detected, the 3D character will 

appear in the 3D viewport. 

 

Ensure that the filename and directory are correct; then click apply to proceed. See 

section 8. 

7.7 Navigator 

When a new session has been created, suit-specific variables can be viewed in the 

navigator. This generally appears automatically on the left side of the window. If not, it 

can be found using View >Navigator. In the navigator, parameters of the suit can be 

seen, including the Suit ID and the color of the indicator above the head of the 3D 

character. While this is possible with only one system, it becomes essential when multiple 

systems are being recorded at once. 

 

If recording of multiple suits has been chosen during the new recording session, MVN 

Analyze/Animate will search for the selected number of systems. If more than one 

system is connected, the hardware status will have additional tabs to reflect this. 
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8 Setup 
The setup workflow stage consists of three parts; it shows the subject’s body dimensions 

(see 7.2.9), data fusion and sensor to segment calibration. The calibration procedures 

are only available once the MVN system is connected and the 3D Character has appeared 

in the view port. 

 

When a file has been recorded this icon remains active to enable changes to body 

dimension inputs. 

 

Note: It is not possible to save a calibration file, when a recorded file is open. 

 

The following steps are described for single system calibration. If multi-person capture is 

enabled, each step should be repeated for each additional system.  

8.1 Calibration 
Segment calibration is the step required to align the motion trackers to the segments of 

the subject. Creating a good calibration is of utmost importance in order to ensure 

accurate results. For this reason, the calibration procedure should be carried out with 

care to get the best performance. 

 

Watch the video on the tutorial portal for instructions on how to perform the calibrations:  

Calibration for MVN Awinda: https://tutorial.xsens.com/video/calibrating-awinda    

Calibration for MVN Link: https://tutorial.xsens.com/video/calibrating-link   

8.1.1 Record and process calibration 

• Select a calibration (Npose + Walk or Tpose + Walk). 

• A new image will appear in the 3D viewport which should be replicated by the subject. 

• If the subject is alone, first select “Hands off calibration” and the amount of time needed 

to get into position. (See Section 8.1.3) 

• Click “Calibrate”. 

• Ensure that the subject is holding the initial pose. 

• Click start and follow the instruction to stand in the static pose, relax and walk back 

and forth. 

• Once the calibration recording is finished, the system will automatically start processing 

the recording to get the results and show the progress. 

https://tutorial.xsens.com/video/calibrating-awinda
https://tutorial.xsens.com/video/calibrating-link
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Figure 51: Segment calibration interface 

 

8.1.2 Apply calibration and define x-axis 

When the calibration data has been processed, the system will show the quality of 

estimated calibration parameters and show warnings in case problems were detected 

(see Section 8.1.4 for more information). 

 

Before applying the calibration results, the forward pointing X-axis can be defined. To do 

so, the user is asked to stand in N-pose facing the forward axis of the measurement 

environment. In a setup with multiple MVN systems, each actor needs to perform this 

alignment. In this case, it is recommended to mark a place on the floor indicating the 

origin of the session. Each person should stand on this spot with the right heel when 

applying the calibration.  

 

The MVN system does not have an absolute positioning system. Therefore, the characters 

will show some drift over time in terms of absolute position in space with respect to the 

origin (defined at calibration). For short recordings, the drift of the character is typically 

limited to a few cm. With multi-person capture, the characters can drift apart after a 

while. Usually this can be fixed in the animation package used for retargeting the motion 

data to a virtual character. 

 

To reset the position and/or orientation of the characters in between recordings, select 

the character in the navigator and perform the required reset: 

• Reset position (menu > Tasks > ‘Move Character to Origin’ , or press ‘Ctrl-0’ 

(Ctrl+[Zero Key]). 

• Reset heading (menu > Tasks > ‘Axis Reset’ , or press ‘Ctrl+Alt+A’). 

• Reset position + heading (menu > Tasks > ‘Grid Reset’ , or press ‘Ctrl+Alt+G’). 

• Reset mocap engine (menu > Tasks > ‘Reinitialize Mocap Engine’ , or press 

‘Ctrl+Alt+F’).  

Please note that this step means all history in the engine is thrown away and the 

engine will start from scratch. 
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Please note that it is always recommended that a calibration is performed before 

beginning to record data using MVN Analyze/Animate. However, it is possible to enable a 

measurement without calibration in the preferences menu (Options >Preferences 

>General >Recordings). 

 

Another option in the preferences menu is “Enable simple calibration routines” in this 

menu to enable the not recommended N and T-pose. Please note that these calibrations 

are susceptible to magnetic distortions and can have a degrading effect on the preserved 

performance. 

8.1.3 Hands-off calibration 

It is possible to perform a calibration without assistance. Click the ‘Hands-off calibration’ 

check box and select the delay time. This is the time needed between clicking ‘Start’ and 

getting into position. Continue the calibration by clicking the ‘Calibrate’ button. Following 

the preset time delay, the calibration recording will automatically begin. 

8.1.4 Calibration quality 

MVN Analyze/Animate will perform several checks to determine the quality of the 

calibration routine. These checks include: a measure for standing still, the expected 

alignments of the MT’s on specific segments, and the detection of the walking part.  

 

Figure 52: Example of result of calibration quality 

 

There are four levels of calibration quality: 

 good 

 acceptable 

 poor 

 fail 

 

Generally, a ‘good’ or ‘acceptable’ quality indication is sufficient. If the calibration result 

is not ‘good’, the reason is indicated in the text below. Read the advice provided to 

improve the result. If the result is “acceptable”, consider repeating. 

 

A ‘poor’ quality indicates the engine was not able to properly extract the calibration 

parameters and will give feedback what went wrong. It is still possible to continue with 

recording, but it is better to repeat – taking into account the advice provided. 
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Note that a ‘good’ or ‘acceptable’ quality indication does not necessarily mean that the 

actual calibration is accurate. MVN Analyze/Animate can perform limited checks of the 

actual pose of the subject during the calibration due to a natural variation in body 

physique and locations of the motion trackers on the body. Therefore, always pay 

attention to the pose of the subject since it will influence the quality of the recording. 

 

Calibration data can be saved. This is useful if MVN Analyze/Animate closes/must be 

closed suddenly. When rebooting, data can be reloaded, without having to re-calibrate. 

To reload a calibration (including body dimensions), click ‘Load’. 
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9 Preview and Recording 

9.1 Preview 

During the Preview and Recording stage of the workflow, the viewport is active. 

 

There are a number of viewing possibilities, the 3D character in the 3D viewport and 

orthogonal views. Select the number of windows to view at one time. Figure 53 is an 

example of a four window view showing the 3D view and three different orthogonal 

views. To select which type to view, Right Click and select from the drop down menu, as 

indicated in the figure (or use the shortcut keys). The view changes only in the window 

where the cursor is pointing. In the 3D viewport, use the mouse to zoom (using scroll 

wheel) and pan (using middle mouse button) around the character. It can be viewed 

from any angle (change view using left mouse button) and distance. 

 

With MVN Analyze it is also possible to have the synchronized (live) video data. If video 

is enabled it automatically uses a window. Note: there is a difference between the virtual 

camera and the physical MVN Ethernet Camera. The camera views describe the possible 

viewing angles of the 3D character. The only preferences for the MVN Ethernet camera 

are in Options >Video Camera Settings. 

 

  

Figure 53: Example of 4 window view on the 3D view port. Top left is the 3D view. Bottom left is 
sagittal right. Bottom right is transversal cranial. Top right is coronal posterior. 
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9.1.1 Viewport Icons 

The icons above the viewport can be selected to show and hide various parameters, as 

detailed below. 
Icon Task 

 

Focus on Selected Segments (short-key ‘F’) 
Note: short-key ‘C’ always centers on the pelvis 

 

Show/hide floor 

 

Show/hide origin 

 

Show/hide shadows 

 

Show/hide center of mass 

 

Show/hide biomechanical model 

check 

Show/hide motion path (available during 
playback) 

 

Show/hide character label 

 

Amount and layout of viewports 

 

Show/hide graphs 

 

Enable/disable contact editing in current view 

 

Save Layout 

 

Restore Layout 

 

Select between a vertical or horizontal layout 
 

 

9.1.2 Views 

Right click on the screen (or use the shortcut key) to choose one of the following camera 

viewpoints: 
Menu command (+shortcut) Action 

Free move (V) The camera is still.  
The character may go out of view of the screen. 

Trailing (T) The character is always in view. 
The pitch of the camera is fixed. 
The distance of the camera to the character is fixed. 
The height of the camera follows the height of the pelvis. 
The camera heading is determined from the previous and new 
character position. 

Static (T) The position of the camera is fixed. 
The camera always looks at the character. 

Static with Auto Zoom (T) Similar principle to “Static” with the addition that the zoom is 
automatically adjusted to ensure that the character remains the 
same size 
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Fixed angle and distance (T) The global heading and pitch of the camera are fixed. 
The height of the camera follows the height of the pelvis. 

Horizontal Follow (T) Similar to “Trailing”, but the height and angle of the camera is 
now adjusted to prevent the image from varying with change in 
pelvis height 

Circle Around Character (T) Virtual camera will slowly circle around the centered character  

Coronal posterior (X) Show the back of the character. 

Coronal anterior (X) Show the front of the character 

Sagittal right (Y) Show the right side of the MVN character in the sagittal plane 

Sagittal left (Y) Show the left side of the MVN character in the sagittal plane 

Transversal cranial (Z) Show the top of the MVN character 

Transversal caudal (Z) Show the bottom of the MVN character 

 

The camera angle of the orthogonal views is by default defined by the movement of the 

pelvis. The height of the camera is also based on the pelvis; when the character is 

jumping the character stays within the view while the floor appears to move. This also 

has implications in the sagittal view; the subject may bend, while this appears as though 

the feet slide forward. The data is still correct (as seen in the 3D view). 

9.1.3 Real-time graphs 

With an MVN Analyze license it is possible to view graphical representation of data even 

in real-time and during recording. 

 

To do this, click the graph icon, and as with offline graphs, click and drag items from the 

Navigator. 

   

Figure 54: Real-time graphs 

Figure 54 is a screenshot of MVN Analyze/Animate with real-time graphs present. The 

key difference with this and the offline graphs is the lack of time bar. 

 

The real-time graphs have the same functionality as offline, for more information on 

graphs, see Section 14.1. 

 

Note that it is possible to zoom on the vertical axis. First ensure that “no auto-scaling is 

selected from the drop down menu, and then select the magnifying glass icon to zoom. 

However given that it is not possible to select a time window over which to observe the 
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real-time graphical data, the recommended setting during real-time preview is “Expand 

to fit”, or “Full Fit”. 

9.1.4 Save and Restore Layout 

To the right of the graph icon are two icons indicating the possibility to save and restore 

layouts of the interface. 

 

To save a layout, use the icon directly to the right of the graph icon, the layout currently 

in view will be saved. Give the layout a name, in the drop down menu that appears. 

 

To use a saved layout, click the rightmost icon “Restore Layout” and select the name 

from the drop down menu that appears. 

 

It is possible to delete a given layout by selecting it and clicking the delete button on the 

keyboard. 

9.2 Recording 
To record, save and export data, first make a new session (as described above) and 

perform a calibration. 

 

Record button prior to clicking 

 

Record button during recording6 

Press the red record button to start a trial recording. Press the same button to stop 

recording. The short key for starting and stopping recording is ‘Ctrl+R’. All recorded and 

saved files will have the name of the session, appended with a trial number (e.g. 

session = ’running_take’ will result in trial recordings ‘running_take-001.mvn’, 

‘running_take-002.mvn’ etc.). When a recording has been made, the recorded file 

automatically opens. This can be disabled in Options >Preferences >General >Recordings 

>Automatically open MVN file after record ends. 

9.2.1 Note for recording for MVN Awinda Users 

 When a recording is initialized in MVN Analyze/Animate for MVN Awinda, the “Data” 

LED of the Awinda Station becomes red, to indicate recording is in progress. Note that if 

data packets have been missed, retransmission slots ensure that the Awinda Station can 

recall these and they can be retransmitted during recording (retransmissions are activated 

only during recording). 

 

When recording is stopped, the “Data” LED may become temporarily orange, and the 

record button in MVN Analyze/Animate will temporarily appear as if the recording is paused, 

the missed data packs are being flushed. 

 

When opening a recorded file with flushed data it will automatically start reprocessing. This 

will ensure that the file contains all data, including retransmitted data from during the 

recording and data that was flushed from the buffer of the MTw2 at the end of the 

 
6 With MVN Awinda this button will continue even for a few seconds after recording is stopped, at 
this time, any samples missed during real-time recording are being flushed to the PC. 
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recording. For this reason, the recorded data is often of better quality than the real-time 

preview. 

9.3 Add comments after recording 

Adding comments after a recording has finished can be very useful in a later stage when 

you are opening the recordings. The popup dialog to add comments after a recording can 

be enabled or disabled (menu > Preferences > Interface > User Interface Show popup 

dialog for file comments after recording). 

 

To view the comments from the open file dialog in MVN Analyze/Animate or Windows 

Explorer, you will have to add the ‘comments’ column. Right click on the column header 

and click on ‘more’, now you can check the ‘comments’ column. 

  
Now when you are looking for that recording that was ‘perfect’ you will be able to easily 

find it from either the open file dialog in MVN Analyze/Animate or Window Explorer. 

When the comment contains a lot of text and is not fully visible you can hoover over the 

text and a tooltip will display the complete text. 

 
Figure 55: Open files 

The comments in recordings can be edited in MVN Analyze/Animate from the Comments 

pane (menu > View > Comments). 
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9.4 Recovery of MVN file after system crash 
If MVN Analyze/Animate was shut-down as a result of a system crash, the MVN file will 

not be properly closed and not useable. To correct this, when you try to load the 

corrupted MVN file in MVN Analyze/Animate it will look for a recovery file (MVR) that can 

be used to recover the data captured. A message will ask if you want to use a recovery 

file. This file has the same name and location as the corresponding MVN file but with a 

“MVR” extension. The file is used by MVN Analyze/Animate to recover the corrupted MVN 

file. 

9.5 Markers 

During or after recording, markers can be added to the timeline to indicate events. 

During recording, add a marker by clicking the Add Marker icon or by using the ‘+’ key or 

‘space bar’. 

 

In the playback window, a marker can be added and/or edited by double-clicking the 

timeline at a specific frame or by using the ‘+’ key. To add a marker directly, in the 

playback mode, double click on a time frame, to obtain the “Set Marker” menu shown in 

Figure 56. Alternatively, right click above the time frame, select “Add marker” and the 

same “Set Marker” menu will appear. Change the name of the marker in this menu to 

identify the marked event. 

 
When the marker is set, it will become yellow. Markers can be deleted by pressing the delete 
button after selecting the marker, or selecting delete marker when right-clicking above the time 
line. 

 

Figure 56: Set Marker Menu 

Markers are saved as default to MVNX file. See Section 15.4. 

 

To jump between markers, either go to Playback >Jump to next/ previous marker, or 

user the quick keys ‘PgUp’ for previous and ‘PgDown’ for next. 

 

Note that when multi-person capture is used, the markers are saved in each MVN file. 

When the MVNS file is opened, it includes these MVN files. This means that there can be 

a discrepancy when two different sample rates are used eg if MVN Link and MVN Awinda 

are used. For this reason MVNS file may appear to contain multiple markers, since they 

have been allocated slightly different times. Each MVN file itself will still only contain one 

marker. 
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9.6 Network Streamer 
The network streamer sends the poses of the active window (playback or real-time), both 

UDP and TCP are supported by the network streamer. The UDP Protocol is unidirectional, 

and contrary to TCP (Transmission Control Protocol, RFC 793) it is stateless and does not 

require the receiver to answer incoming packets. This allows greater speed. 

 

How to set up the network streamer is explained in this tutorial video. 
https://tutorial.xsens.com/video/setting-up-multiple-streams 
 

You can use a network monitor on another or same PC to receive this stream, or write 

your own receiver in another application.  

Change network streaming settings in Options > Network Streamer. 

 

To enable streaming, activate the ‘Enable network streaming’ checkbox. The receiving 

network address can be entered in ‘Destination addresses’. Use ‘localhost’ to 

send/receive on the same computer. UDP is the default protocol.  

 

It is possible to stream to multiple destination addresses. 

  

Figure 57: Network Streamer Options 

https://tutorial.xsens.com/video/setting-up-multiple-streams
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Figure 57 above shows the Network Streamer Options. The table below summarizes the 

functionality of each selection. Please refer to the Real-Time Network Streaming Protocol 

Specification for further details. 
Datagram Description 

Position + Orientation 
(Quaternion) 

Positions and orientation of each body segment, orientations in 
quaternion format, position units are in meters. This is the most 
accurate and preferred format for new application development. Use 
this to stream from one MVN Analyze/Animate to another. Select the 
‘Scaling Data’ for proper visualization of the character mesh. 

Position + Orientation 
(Euler) 

Position and orientation of each body segment. Orientations are Euler 
and position data is in meters. This is the format needed to send data 
to the MVN MotionBuilder (2018 and older) Live plug-in. See the MVN 
MotionBuilder plug-in user manual for further details. 

Character Meta Data Particularly useful when streaming data during multi-person capture, 

when selected, this protocol streams information inserted about the 

character including the character as inserted in the Navigator as well 
as the ID of the Body Pack or Awinda Station. 
This feature is supported by MVN Analyze/Animate as a network 
monitor. 

Scaling data This packet contains scaling information about the character, including 
the null pose definition and point definitions to scale a mesh. 

Unity 3D This setting should be selected in the network streamer for users of 
the Unity plugin. See the Unity plugin user manual for more details. 

Siemens Tecnomatix For MVN Analyze customers, it is possible to stream data in real-time 

to Siemens PLM software using this selection. See separate user 
manual for set up. 

Linear Segment 
Kinematics 

Absolute segment position, linear velocity and linear acceleration. 

Angular Segment 
Kinematics 

Absolute segment orientation, angular velocity and angular 
acceleration. 

Virtual Optical Marker Set This protocol streams a set of virtual optical markers. This is the 
virtual marker set for the 1.0 Motion Builder plug-in. This data is not 
supported for playback in MVN Analyze/Animate. 

Center of Mass Absolute 3D position of the center of mass. 

Tracker Kinematics Absolute 3D tracker orientation (quaternions) and free acceleration. 
Local acceleration, angular velocity and magnetic field of the sensor 
components. 
This feature is not supported by MVN Analyze/Animate as a network 

monitor. 

Joint Angles Data is contains point ID of the parent and child segment orientation 
and the joint angle in X,Y,Z. 

Time Code MVN Analyze/Animate contains a clock which starts running at the 

start of a recording. The clock measures the elapsed time in 
milliseconds. When data is sampled, the current value of the clock is 

also sampled and stored in the datagram(s) as a 32-bit unsigned 
integer value representing a time code. When this option is selected a 
string of this Time Code is streamed (HH:MM:SS.mmm). 

Send Finger Tracking Data This setting should be selected in the network streamer for users who 

want to include Finger tracking data. 

Send Object Tracking Data This setting should be selected in the network streamer for users who 
want to include Object tracking data. 

Network Sync JSON/XML For triggering other (3rd party) software, in different formats. 

Messages: 
• session name + take number 
• file path where the recorded files are (to be) saved 
• start/stop recording 



   

 

 

 

 

  

 

56 www.xsens.com 

9.7 Network Monitor 
MVN Analyze/Animate also implements a Network Monitor that can receive the MVN 

network stream of motion data. Note that this is mean only to monitor a network stream 

and no further functionality is provided than viewing (i.e. no saving, recording, editing 

etc). 

 

To open a network monitor in MVN Analyze/Animate, go to File >Open Network Monitor 

or press “Ctrl+M”, to obtain the menu shown in Figure 58. 

 

  

Figure 58: Select streaming host 

Here, enter the IP address of the sending computer or use ‘localhost’ if sending and 

receiving on the same PC. 
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10 Playback, reprocessing and editing 
When the data has been recorded, MVN Analyze/Animate offers several options for 

playback, reprocessing, video synchronization, and editing which will be discussed in this 

section. 

10.1 Reprocess HD 

With MVN Analyze/Animate, a new sophisticated processing option is available called 

“Reprocess HD”, which includes all data in the file to get the best performance for the 

recorded motion. The reprocessing can be enabled by pressing ‘Ctrl+Shift+P’ or click the 

icon below.  

 
When a MVN files is changed (e.g. changing scenario), it must be reprocessed to ensure 

that the changes are implemented. If the file is opened for the first time and contains 

retransmitted data, the file is automatically reprocessed to be sure all data is included in 

the engine (‘Auto-reprocess’). In order to use the HD reprocessing, manual trigger of the 

reprocess HD is needed. Note that the default behavior of the icon can be changed from 

‘Auto-reprocess’ to ‘Reprocess HD’ by clicking on the dropdown arrow to the right of the 

icon. 

 

The progress of reprocessing can be monitored in the frames bar at the bottom of the 

viewport. Data will first be read into the engine (indicated by the blue color), and then be 

processed by the engine (light green). Once the file or part of file has been finished, it is 

shown in green as shown in Figure 59.  

  

Figure 59: Contact editing reprocess bar 

10.2 Batch Reprocess HD 

The option to do batch processing is also possible in both normal and HD quality. This 

can be done from the tasks tab, using the batch reprocess option (Figure 60). Once this 
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window has opened, the input and output paths can be chosen with the level of 

reprocessing quality you desire. You can also change the number of parallel processes 

that are used during processing. This determines the amount of files that are reprocessed 

at the same time. Be advised that increasing this number will significantly increase the 

memory usage of MVN during reprocessing. The default setting should provide a sensible 

balance between CPU and memory usage.  

 

Force reprocessing can be used to force reprocessing, even if files have been processed 

with the same reprocessing quality earlier (not recommended). Use GNSS data uses 

available position aiding data to improve reprocessing. GNSS data can only be used in 

combination with HD Quality reprocessing. It is recommended to leave both settings at 

their default values. 

 

Clicking Reprocess starts the reprocessing and shows the progress per file in a separate 

window. The processing can be canceled at any time. 

 

 

 
Figure 60: Batch Reprocess window 

10.3 Playback 
Playback becomes possible with a recorded trial. To play and edit recorded files, open an 

MVN, MVNS or MVNX file. The Playback Toolbar contains familiar playback options.  

 

If multiple MVN, MVNS, or MVNX files are open, all files can be controlled at the same 

time using Global Playback options.  When analyzing similar recordings, to make all files 

jump to the same frame, simply use the quick key ‘Shift + Down’. 

 
Icon Task Short Key Global Playback Short Key 

 

Playback speed   

 

Loop recorded data R (toggle) Shift + R 

 

Go to start Home Shift + Home 

 

Previous frame Cursor left Shift + Cursor left 

 

Play / Pause Space bar Shift + Space bar 

 

Play selection Ctrl + Space bar  

 

Next frame Cursor right Shift + Cursor right 
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Go to end End Shift + End 

 

10.4 Synchronization with video 

In MVN Animate Pro, MVN data with synchronized video is available. The accuracy of the 

software synchronization depends heavily on the LAN connection to the camera and the 

wireless link quality to the MVN system. In general, the time offset between the MVN 

frame and the video frame is negligible, or less than 1-2 video frames. 

 

However, if there is a larger offset between the MVN and video data, time-

synchronization can be manually corrected using the sliding bar under the video. Drag 

the bar or use the numbers or the arrows to change the offset [ms]. The offset is applied 

to the whole file. Any clock skew between the camera and the MVN system is 

automatically estimated and corrected. 

 

 
 

Figure 61: Video synchronization sliding bar 

10.5 Contact point editing 

The MVN Fusion Engine uses external contacts of the body with its surroundings to 

minimize position drift of the computed body model with respect to the Origin (defined by 

starting point). A number of points on the anatomical model have been defined that are 

likely to make contact with the external world. An overview of these potential contact 

points is given in the table below. The detection of external contacts is based on 

measured kinematics of relevant body parts. In some cases, e.g., when a recording is 

made on different floor levels (e.g. stepping on stage), it can be desirable to overrule the 

automatically detected contact points or manually set height levels.  

Note: that after processing the file with the Reprocess HD engine, contact 

editing should not be necessary.  
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During Playback and Editing, four default bars appear above the timeline, indicating 

presence of contact points, advanced (floor level), position, and clipping edits (Figure 

62). If there is a contact, the contact will be shown in the viewport with a large blue 

sphere. When hovering above the ‘other contacts’ bar a tool tip pops up indicating which 

contact point is active. 

  

Figure 62: Contact point 

When clicking on a body segment with the left mouse button, the selected mesh will light 

up in red. The selected body segment shows spheres with external points of that 

segment. The time bar will zoom in and expand to show the detected contact points of 

the selected segment per frame. The colours of the spheres correspond with the coloring 

and labeling in the contact bar. For example, on the foot, there are four possible contact 

points: the heel (blue), first metatarsal (green), fifth metatarsal (red) and the pivot point 

on the ball of the foot (pink). 

 

When an external point is defined as a contact, the related sphere will enlarge for the 

currently displayed frame. Clicking on a second segment will show the contacts of both 

selected segments. 

 

Contact point Description  

HeelFoot Heel of the foot 

FirstMetatarsal Inside ball of foot 

FifthMetatarsal Outside ball of foot 

PivotFoot Center ball of foot 

TibialTub Bony elevation on upper part of the shinbone (tibia) 

GreaterTrochanter Eminence on the upper part of the femur 

IschialTub Buttock (left and right) 

Sacrum Base of the Spinal Column 

Central Buttock Buttock  

Anterior Superior Iliac Bony projection of the iliac bone  

PX Bottom of sternum 

T4SpinalProcess Vertebra between shoulders 

Acromion Shoulder 

Olecranon Elbow 

BallOfHand Ball of hand 

TopOfHead Top of head 
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To scrub, drag the time line scroll bar ( ) to the left or right. Step through the time 

frames using the left and right cursor or keep it pressed to move very slowly though the 

file, frame by frame. 

  

Figure 63: Contact points on the 3D viewport and the contact editing menu 

10.5.1 Selection of samples 

The left mouse button (and drag) will set a contact for the selected contact point. The 

color of the user-defined contact point will be slightly darker than the color of the original 

detected contact point. Only one contact point can be selected per segment. To select 

contact points for multiple segments, hold the shift key during selection with the left 

mouse button. 

Note: The first contact editing action will take more time than the succeeding 

actions due to the caching mechanism. 

 

The right mouse button (and drag) will show the contact point editing options for the 

selected frames. In the next section, these options will be explained. 

To ensure that the changes are applied, click reprocess – see Section 10.5.2.6. 

Undo (‘Ctrl + Z’) and redo (‘Ctrl + Y’) the performed contact point editing actions. Saving 

the file commits the changes and they can no longer be undone. 

 

Figure 64: Right click menu in contact editing 
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10.5.2 Contact point editing options 

10.5.2.1  Remove user-defined 

Revert to the original recording for the selected samples. Remove user-defined aiding 

refers to the positions and floor levels set, as remove user-defined contacts refers to the 

contact points of the segments. Reprocess to apply changes (see Section 10.5.2.6). 

10.5.2.2  Ignore contacts globally 

Removes all detected contacts for all segments. 

  

Figure 65: Example of ignore contact globally 

10.5.2.3  Ignore contacts for this segment 

The selected segment will not make contact for the selected samples. The MVN Fusion 

Engine will mark the most likely point of another segment as a contact. 

10.5.2.4  Set position 

Sets the position and its uncertainty for the selected contact point. Optionally, only the 

height of a point can be set. Set positions can be found in the set position bar. 

With the position aiding interface, it is possible to set a contact point at a desired 

coordinate (X, Y and Z). This can be useful in situations which are not supported by one 

of the user scenarios (e.g. walking stairs). Examples: (1) the starting position of a 

recording can be set to zero, (2) when the subject is hanging on a bar, the position of the 

hands can be fixed at a given height, (3) when a subject steps onto an object, the height 

of the contact can be ‘frozen’ to the height of the object, (4) when a subject jumps down 

from an object, the position of the foot can be set to the height of the object before 

jumping. Note that some situations, such as walking on an elevated surface can also be 

accomplished by setting the floor height. 

 

In the contact bar, right-click the desired time frame(s) and select the option ‘set 

position’. In the dialog, the X, Y and Z positions of the selected segment point of the 

current time frame are given. 

Note: in MVN Analyze/Animate, height is indicated by ‘Z’. 
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Figure 66: Set position menu during contact point editing 

The SD slider sets the standard deviation, which is an indication of how much the aiding 

point can be trusted in combination with the computed position of the MVN Fusion 

Engine. This option can also be used creatively for example to create a “soft” landing on 

a mattress. With the ‘Force no contacts’ options, no other contacts will be detected 

during the selected frames. The contact bar will show a dot in the center of the edited 

frame and mark all other contact points dark. The ‘Absolute’ option completely overrules 

the computed position of the MVN Fusion Engine. The contact bar will show a ‘P’ at the 

selected frame. After editing the co-ordinates, click the reprocess button. 

 

Always work chronologically when setting positions of contact points, since an edited 

position at frame k will influence the position at frame k+1 and further. 

 

 

Figure 67: Example of using contact point aiding for seated position 

10.5.2.5  Floor level 

Sets the height of the floor. Multiple floor levels can be set in one file. The current floor 

level is presented in the dialog; see  
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Figure 68 for an example. 

  

Figure 68: Set floor level menu 

Right mouse click on a contact bar to set the floor height to the height of that contact. 

The contact detection will now be applied on the new floor height for all following 

samples. 

Left mouse click and drag on the advanced bar allows you to set a floor height for a 

range of frames 

10.5.2.6  Clipping 

The clipping bar indicates when clipping has occurred in the data. This gives users an 

indication of when movement has caused sensor data to be exceeded. Data should not be 

trusted at these times. 

10.6 Multi-person editing 

In the MVNS file, the contact and aiding points for each character can be edited 

separately. Click on one of the segments of the character you want to edit and follow the 

workflow as described in Section 10.5. 

 

The body dimensions and scenario can also be changed in the calibration for the selected 

character. 

 

For each suit, a separate export file will be generated when exporting to MVNX, BVH or 

FBX, C3D see Section 15. 
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11 On-Body Recording 
On-body Recording’ allows you to record motions everywhere without the need for a 

laptop or PC by storing motions on the Body Pack (only for MVN Link). The Body Pack has 

internal memory that has the capacity to record up to 15 hours of data. This functionality 

is enabled by a firmware update (Body Pack firmware 1.1.4). 

11.1 Configuration 

To configure the Body Pack for On-Body Recording go to: Options > On-Body Recording 

  
Figure 69: On-Body Recording configuration window 

The top part of this dialog is intended for Device Configuration. Here you can enable or 

disable On-Body Recording and set the details of your recording, like Name, Update Rate, 

Suit Configuration, Scenario. 

 

See also the tutorial on how to configure the Body Pack: 

https://tutorial.xsens.com/video/enable-disable-on-body-recording/ 

11.2 Calibration and recording 

When using On-Body Recording you will not be guided by MVN Analyze/Animate which 

requires you to perform a calibration before you can actually start recording. You will 

need to start your recording session with a separate calibration recording (Npose + Walk 

or Tpose + walk as explained in tutorial video ‘Setup and calibration MVN Link’ or as 

described in 8.1 Calibration). It is essential to do this calibration recording with care and 

take time to stand in a proper Npose or Tpose for 5-10 seconds, following by walking 

back and forth for 5-10 meters. Further instructions on Calibration and Recording can be 

seen in the tutorial video: https://tutorial.xsens.com/video/perform-an-on-body-

recording-calibration 

  

 

11.3 Import Recordings 
Once you are finished with recording you can connect the Body Pack to the PC to import 

the recordings. Go to: Options > On-Body Recording 

 

https://tutorial.xsens.com/video/enable-disable-on-body-recording/
https://tutorial.xsens.com/video/calibrating-link
https://tutorial.xsens.com/video/perform-an-on-body-recording-calibration
https://tutorial.xsens.com/video/perform-an-on-body-recording-calibration
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Figure 70: import MTB files menu 

The bottom part of this dialog allows you to manage the recordings on your Body Pack. 

You can select the recording that contains the Npose + Walk or Tpose + Walk, which can 

then be applied to the other recordings. Body Dimensions and Scenario can be set here 

before you import it to a specific path on you pc. 

See also the tutorial on ‘Importing On-Body Recording files’: 

https://tutorial.xsens.com/video/importing-on-body-recording-files/ 

11.4 Swap Trackers 

 

The ability to swap tracker strings is now available within MVN Analyze. The option to do 

this is found in the OBR tab. Click on the OBR tab, followed by the swap trackers tab. 

 
Figure 71: OBR, swap trackers 

Following this, you will be directed to the swap tracker window. Place the location of the 

folder containing the files you wish to swap tracker strings under Input Path, once this is 

selected a list of the files will appear in the file column.  

 

 

https://tutorial.xsens.com/video/importing-on-body-recording-files/
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Figure 72: Swap trackers configuration 

Select the strings you desire to swap and click on the green and blue circular arrows, 

these will appear in the swapped trackers list. Select which processing mode you desire 

and finally click Swap. 

 

11.5 Remote On-Body Recording 

The Remote On Body Recording (Remote OBR) feature allows you to synchronously trigger 

multiple body packs to initialize and stop the On Body Recording (OBR) functionality. To 

set this feature up, first ensure each Body Pack is configured to OBR in the “Configure On-

Body Recording” tab. Once each Body Pack is configured, ensure your Access Point is 

switched on and open up the “Remote OBR” tab (Figure 73).  

 
Figure 73: Select Remote OBR 

After pressing this tab, the following interface will appear (Figure 74). 
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Figure 74: Bodypack Configuration interface 

The Access point will begin scanning for the Body Packs, once discovered, each Body Pack 

will appear with the Device ID and Name with the ability to select/deselect which Body 

Pack you want to record with. For each Body Pack the Recording status, battery status, 

Wi-Fi strength and Sync is also listed on the right side of the interface. The sync refers to 

the measured system clock deviation at the time of synchronization in milliseconds. 

 

At the bottom of the interface you can select/deselect scanning for Body Packs as well as 

deselect all. To name the take, type in the name in the TakeID section. To start and stop 

recording, push each respective button on the bottom right corner. You also have the ability 

to set a recording delay in seconds following the press of the start button. 
https://tutorial.xsens.com/video/remote-on-body-recording-robr 
 

From MVN 2020.2 onwards, you can transfer OBR file (.mtb) from Bodypacks to your 

computer wirelessly. Make sure to update the hardware with the latest firmware. In the 

bottom of panel of Figure 74, you can find two checkboxes and one user input.   

Automatic Download: If this box is checked and Bodypacks are successfully 

connected via WIFI, OBR file (.mtb file) will be automatically copied from all connected 

Bodypacks to your host computer. When the file is being recorded, it will not be 

transferred. Once a recording is finished, it will be automatically transferred for that file. 

Unchecking this checkbox will stop any active file transfers. 

Remove After Download: If this box is checked, OBR files in Bodypacks will be 

deleted after successful transfer. 

Download Path: This path is the destination path for saving .mtb file. You cannot 

change the path during file transfer.  

https://tutorial.xsens.com/video/remote-on-body-recording-robr
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12 3D Position Aiding 

12.1 GNSS 

12.1.1 Introduction 

The recent addition of GNSS (Global Navigation Satellite System) to Xsens MVN allows 

position aiding to your inertial motion capture. The GNSS refers collectively to GPS (USA 

including QZSS (Japan) and GLONASS (Russia) for this 1st release. These global 

positioning systems work all over the world including China and Japan, however the 1st 

release does not support BeiDou, which is optimal for China. GNSS has several benefits 

for your motion capture applications. 

i) One of the first major benefits allows position to be measured for applications 

that do not contain clear defined foot-strikes. Typically inertial motion capture 

calculates 3D position, by using the orientations of all of the segments in the 

linked segment model and in turn, calculating the postures in between foot 

contacts with respect to a global origin. However, for applications that do not 

contain foot strikes, such as cycling, skating, skiing, kayaking, horse-riding 

and several other vehicle based scenarios. 

ii) Second, it may reduce the effects of positional drift over time with respect to a 

global origin. 

However, it should be noted that the position is reliant on the accuracy of the GNSS 

signal itself, as this is what informs position and heading of the underlying biomechanical 

model. GNSS typically has an accuracy of up to 1 meter with respect to latitude and 

longitude, however there are several factors that can influence this accuracy. Some of 

these factors include: 

- The position of the antenna, we recommend placing the antenna on the shoulder, 

such that it points up at the sky. 

- Being in areas with a high density of buildings, this can influence the triangulation 

of the antenna with the satellites. 

- Moving into areas in which the antenna is blocked off completely, such as entering 

a tunnel. 

- The movement of the participant being measured, typically if the participant is 

stationary, the satellites take a bit longer to get a fix on the position. 

It is important to note, that the 1st phase of the integration of GNSS to inform position, 

does not use elevation, but only latitude and longitude. This is due to the fact that errors 

are much greater with elevation measurements, and in some cases can be up to 5 m. 

Thus, only latitude and longitude are used to measure the position along the XY plane 

with the pelvis locked in the Z direction. This must be taken into account for applications 

that have significant hills or mountainous regions.    

 

12.1.2 Set up with GNSS position aiding 

The GNSS antenna plugs into the Body Pack on the very right, by screwing in place. The 

antenna can then be placed on the top of the shoulder, we recommend placing it on the 

right shoulder with the antenna pointing towards the sky. Velcro patch can be placed on 

the antenna and suit, but it can also be placed above the shoulder sensor in the 

compartment of the lycra suit. Ideally, it should be pointed up at the sky as much as 

possible to improve the strength of signal. 
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When configuring a new session, open up the Position tab (Figure 75) and select the 

GNSS option. When this is enabled, the system will record and use the data collected 

from the GNSS antenna. The scenario can be set to 3 scenario’s: Single level, Multi level 

and No level. 

 
Figure 75: Position tab in the Motion Capture configuration 

When recording during a live session, the GNSS will show latitude and longitude in the 

bottom graph titled “Global Position Data (deg)” (see figure below), as well as the GNSS 

Accuracy in meters in the top graph titled “GNSS Accuracy data (m)”. Following HD 

reprocessing offline, the Avatar will move on the grid with respect to the global origin 

that was set (Figure 76). 
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Figure 76: GNSS set-up in MVN 

It is also possible to set-up the GNSS in On-Body Recording (OBR), by opening up the 

Configure On-Body Recording tab, selecting Data and checking the GNSS checkbox. 

 

12.2 HTC Vive 

12.2.1 Background 

MVN allows for position aiding with HTC Vive. With the feature, the MVN fusion engine 

combines the Motion Tracker data from the Motion Capture System (Link or Awinda) and 

the HTC Vive position tracking to improve the global position. This can be extended to 

multiple systems, improving the multi-actor alignment and optimizing the workflow. The 

Position Aiding can be viewed live as well as HD processed after recording. It can be used 

in the following Scenarios: 
Scenario Explanation 

Single Level Actor is moving on a single plane 

Multi Level Actor is moving on more than one plane (e.g. 
jumping on a table, walking stairs 

No Level Actor has no contacts with the environment 
(e.g. skating, cycling). No contacts are used in 
this Scenario, which might result in foot slide. 
For no foot slide, use the Single or Multi Level 

Scenario) 

 

This chapter helps you to set up a recording with HTC Vive Position Aiding. 

https://base.xsens.com/hc/en-us/articles/360012351440-Position-Aiding-HTC-Vive 

12.2.2 Vive Hardware placement 

The Vive Hardware can be used in multiple locations on the body for position aiding. The 

Segment closest to the location of the Hardware will be most accurate. So, if you are 

most interested in Hand location, for example, if you are recording a high five between 

actors, it is advised to place the Vive Trackers on the forearms of the actors.  

 

Below you can find an overview of the locations you can mount the Vive Hardware on. 

 

https://base.xsens.com/hc/en-us/articles/360012351440-Position-Aiding-HTC-Vive
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Vive Hardware Location visuals 

 

Pelvis 

 
Place the Vive Tracker just above Pelvis Motion Tracker 

Fore Arm (R/L) 

 
Place the Vive Tracker at 1/2 of the forearm (halfway 
from wrist to elbow) on the outer side of the arm in n-

pose. 

Lower Leg (R/L) 

 
Place the Vive Tracker at 1/3 of the lower leg (one-third 
from the ankle to the knee) on the outer side of the arm 
in n-pose. 

 

Head 

 
Place the headset on the head, as if you are playing a 
virtual reality game 
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Hand (R/L) 

 
Hold the controller in your hand as if you are holding it, 
playing a game 

   

   

 

 

12.2.3 Setting up 

To work with HTC Vive as positional aiding, make sure you set up Steam, Steam VR and 

HTC Vive. Please follow the steps in the BASE article below. 
https://base.xsens.com/hc/en-us/articles/360012457659-HTC-Vive-Setup-Guide 

Placement of the Vive trackers on the body is explained in this tutorial: 

https://base.xsens.com/hc/en-us/articles/360012351440-Position-Aiding-HTC-Vive 

 

After you have set up HTC Vive, you need to start an MVN live session: 

1. Open MVN 

2. Start a new live session (by clicking the Blank page icon) 

3. Follow the normal procedure in setting up a system. To enable positional aiding go 

to the Position tab (Figure 75) 

4. Select HTC Vive (Figure 77) 

https://base.xsens.com/hc/en-us/articles/360012457659-HTC-Vive-Setup-Guide
https://base.xsens.com/hc/en-us/articles/360012351440-Position-Aiding-HTC-Vive
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Figure 77: Motion capture configuration - Position - HTC vive 

Note: An octagon will appear on the avatar to indicate the status and location of 

the Vive trackers: 
Icon Color meaning 

 

green Vive Ready and receiving position data 

 
yellow Vive Tracker ready but not receiving position 

data.  

 
black No Vive Tracker detected  

5. In the TrackerID drop-down menu (Figure 78), select the Vive Tracker ID to 

attach to this actor. You can use multiple Vive Trackers / Controllers / Headset per 

actor, which all contribute to determining the position of the actor. For all 

hardware you want to use for Position Aiding, select a Location.  
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Figure 78: Select the Vive Tracker ID to attach to this actor 

6. Select the location on the body where the tracker is placed at the Location drop 

down menu. (Figure 78) 

 

7. Click Ok to start the live session 

8. Perform a regular calibration 

- Link (https://tutorial.xsens.com/video/calibrating-link/) 

- Awinda (https://tutorial.xsens.com/video/calibrating-awinda/) 

Typically, MVN will reset the Axis and Position based on the Vive data. In some 

cases, if there is not enough data collected, MVN indicates "System is not yet 

configured correctly for Vive data, please perform an Axis Reset.  

 
Walk around inside the bounds of the Vive Play Area. 

  
MVN will automatically detect the movement. Keep on walking around until the 

process bar is completed.  

 
 

 

 

Recording 

Figure 79: Preview of the tracker location on the body, from left 
to right:  

pelvis, left lower leg, right lower leg, left lower arm, right lower 
arm 

https://tutorial.xsens.com/video/calibrating-link/
https://tutorial.xsens.com/video/calibrating-awinda
https://tutorial.xsens.com/video/calibrating-awinda/


   

 

 

 

 

  

 

76 www.xsens.com 

After calibration, you are ready to record.  

1. Make sure you are in the bounds of the Play Area.  

2. Press the Record button (or Ctrl + R) to start the recording. 

3. Press the Record button (or Ctrl + R) again to stop the recording.  

4. MVN will create the following file type(s).  

 - .mvn file: contains the Position Aided Motion Capture Data 

 
- .mvno file: contains the positional and rotational data from the Objects (only 

created if Object Tracking was enabled during the session, see chapter 12.2.4) 

 
- .mvns file: contains the Mocap Data and Objects Data combined in a session 

(only created if Object Tracking was enabled during the session or multi person). 

 
 More info can be found here:  

https://base.xsens.com/hc/en-us/articles/360012446260-MVN-File-Types 

  

After processing, the Xsens Fusion engine has combined the MVN Motion Capture 

data with the Vive position data, resulting in Position Aided Motion Capture data 

(.mvn file). This data can be exported like any other .mvn file. 

 

Note: with multi-actor sessions, it is still important to perform an Axis Reset 

(in MVN > Tasks > Axis Reset, or Ctrl + Alt + A) to align the heading of the 

actors. 

 

12.2.4 Object tracking 

MVN Analyze/Animate Pro can also track, record, stream and export free-floating Objects 

(like cameras, tables, chairs, etc.) that have their own HTC Vive tracker connected. 

 

Note: not to be confused with ‘Props’ in MVN, which are always connected to a specific 

actor. 

 

See the following BASE article for more information about Object tracking: 
https://base.xsens.com/hc/en-us/articles/360012457639-Object-Tracking-HTC-Vive 
 

 

 

 

https://base.xsens.com/hc/en-us/articles/360012446260-MVN-File-Types
https://base.xsens.com/hc/en-us/articles/360012457639-Object-Tracking-HTC-Vive
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13 MVN Remote app for iOS and Android 
MVN Remote is an app that allows you to control MVN Analyze/Animate from your phone 

or tablet. The app can also record a reference video using the camera on the device. This 

video will be streamed to MVN Analyze/Animate and can be played back next to the 

motion that was recorded (Figure 80). 
https://base.xsens.com/hc/en-us/articles/360010738879-MVN-Remote-App-for-iOS-and-Android 

 

 
Figure 80: Remote app interface 

The app is available for both Android and IOS. 

 

 

 

 

 

https://base.xsens.com/hc/en-us/articles/360010738879-MVN-Remote-App-for-iOS-and-Android
https://play.google.com/store/apps/details?id=com.xsens.mvnremote
https://apps.apple.com/us/app/mvn-remote/id1073868646
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14 Data Analysis 
The final stage of the work flow is ‘Data Analysis’. The major feature of the analysis stage 

is kinematic graphs. 

 

14.1 Graphs 

In the analysis workflow stage, a graph appears in the interface. To view a graph of a 

given parameter, click and drag the parameter from tree view to the graph. Two types of 

graphs are possible: time vs. parameter and parameter vs. parameter (Coordination [or 

phase] Plots). 

14.1.1 Parameter vs. Time 

Drag and drop a parameter with the left mouse button to create a parameter vs. time 

graph. Click on the colored boxes in the legend to disable/enable data in a given plane. 

 

14.1.2 Overlay graphs 

Drag and drop the desired parameter with the right mouse (or left mouse + Alt) button 

into the data analysis window that contains the initial parameter/s. From here, select the 

option “Add to graph” from the drop down menu to display the parameters together 

(Figure 81). You can click on the coloured boxes in the graph legend to disable/enable 

data from the desired plane. 

 

 
Figure 81: Overlaying Graphs of multiple parameters 

14.1.3 Coordination / Phase Plots (Parameter vs. Parameter) 

Drag and drop a parameter with the right mouse button to the horizontal or vertical of 

the graph to create a parameter vs. parameter graph. Select the variable to plot from the 

menu. On the remaining axis, another axis of the parameter will be displayed as default. 

Repeat the process to plot the desired parameter on the remaining axis.  

  

Note: The graphs show the angular velocity in degrees per second. In MVNX 

files, the angular velocity is exported in radians per second. 
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Figure 82: Time vs. Parameter on the left hand side and parameter vs. parameter on the 

right hand side 

14.1.4 Graph handling 

Zoom and pan in the graph using the icons in the toolbar. The time on the time vs. 

parameter graphs conforms to that shown in the time bar. 

14.1.5 Graph toolbar 

Icon Task 

 

Zoom 

 

Pan 

 

Show/hide legend 

 
Show numerical value on graph 

 

Freeze graph (not yet available) 

 

Scaling options: Full fit, Expand to fit, No auto 

scaling 

 

Equal axes 

 

Show all samples (always on) 

 

Clear graphs (not yet available) 

 

Amount and layout of graphs 

  

Horizontal / Vertical graph view (on main tool 
bar but used only in combination with graphs) 

14.1.6 Scaling Options 

Scaling option Functionality 

No auto scaling Y-scale will no longer be scaled 

Expand to fit Y-scale will be stretched to show all data in plot 

Full fit Y-scale will be stretched to show all data in plot 
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14.1.7 Zoom 

To zoom, select the “No auto scaling” option. Zoom only takes place on the vertical axis. 

To zoom in time use the mouse wheel in the time line to zoom horizontally to a point in 

time. 

14.1.8 Pan 

To use the pan function, enable “no auto scaling”, click in the graph area with the left 

mouse button and drag up or down, to pan. Note that it is not possible to pan to an area 

with no data. When data is available beyond the limits of the vertical axis it is possible, 

using the cross bar to pan, and also using a purple scroll bar, which appears on the side 

of the graph when there is a large difference between vertical values, as Figure 83 

shows. 

  

Figure 83: Pan and Numerical Values on Graphs 

14.1.9 Show/ Hide Legends 

Often it is already understood what the colors of the graphs represent. To save room, the 

legends can be hidden by toggling the Show / hide legend icon. 

14.1.10 Show Numerical Values on Graphs 

Using this icon, the numerical value on the graph is visible. It is possible that at times the 

lines intersect and the values are not clearly visible, when this happens; remove one line 

from view by disabling this in the tick box in the legend. In this way the value of one line 

at a time is made visible. See Figure 83 for an impression of how the numerical values 

appear in the graph. 

14.1.11 Equal axes 

This tool is used with the phase / coordination plots. Toggle between Equal Axes and “Full 

Fit” depending on the detail required. 
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14.1.12 Amount and layout of graphs 

There are a number of pre-defined layouts available, which can be selected from the drop 

down menu. Additionally, there is a possibility for the user to define a custom amount 

and layout of the graphical representation. When “Custom” is selected, a new area 

appears where the user can insert the number of rows by columns to view. 

14.2 Cascade / Tile windows 

Multiple trials can be opened simultaneously and played and edited. Viewing a live 

performance is also possible in playback. Use the ‘Window >Cascade / Tile’ menu to 

select the window layout. 

14.3 Linked views 

When multiple windows are active, their views can be linked. Upon enabling Linked 

Views, the scene of all windows will be reset such that the origin faces the same 

direction. When the view in one window is changed, the view in the other window will 

change accordingly. Use ‘Options >Linked Views’ to toggle the linked views option. 

14.4 Marker List 

The marker list enables you to observe where you have placed your markers throughout 

your trials, simply click the view tab and select “Markers”. The marker list will appear in 

an interface that you can move anywhere depending on your preference. To set a 

marker, right click on the timeline where you would like to place it, input a name for the 

marker and the frame, and it will appear in the marker list (Figure 84). 

 
Figure 84: Marker list 
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15 Saving and Exporting 
When a recording has been made that contains more than just the motion data of a 

single actor (e.g. multi-actor or video), two files are created and saved automatically, 

one with the file extension “.mvn” and the other with the file extension “.mvns”. If 

synchronized video data is recorded, a movie file “.mpg” is also saved automatically. 

 

MVN (MVN native file) is the most comprehensive format and contains all measured 

inertial sensor data, and all kinematic data of each segment. It is a binary proprietary 

format and can only be used by MVN Analyze/Animate or by using the SDK. The MVN 

files contain all original data and can be used to re-process a recording using other 

settings. To copy a part of an MVN file to a new MVN file, select the frames and go to 

>Edit >Copy selection to new MVN file, press ‘Ctrl+B’ or right click the Timeline. 

 

MVNS is the MVN session file. It contains information about the recorded trials, it is 

necessary to open an MVNS file if video data was recorded, or to playback and edit time-

synchronized multi-person recordings. 

 

If video data was recorded, opening the file with extension mvn will open only the MVN 

data – the 3D character in the viewports. Therefore to watch synchronized video data 

with the MVN data, open the file with the “.mvns” extension, which will call both the 

.mpg and the related .mvn files. 

 

If MVN Analyze/Animate was used for multi-person capture, data of each character is 

saved in a separate MVN file, which is synchronized based on the internal clock of the 

XMs for each suit. This means that for long files, the number of frames between 

simultaneously recorded MVN files can differ. However, these MVN files are grouped in 

the MVNS file. All recordings in an MVNS file are opened in the same 3D viewport and will 

be played back simultaneously. In the MVNS file, all tracks have the same number of 

frames. The MVN files will all have the same session name with the suit number as a 

suffix. For example, the MVNS file ‘Skating-002.mvns’ consists of two MVN files: 

‘Skating-002-suit00.mvn’ and ‘Skating-002-suit01.mvn’. 

 

MVN (MVN and MVNX) files can be exported to C3D, FBX, BVH or MVNX format. Before 

exporting a file to a given format, ensure that the settings are correct. To do this, go to 

>Options >Preferences >Exporters. Then go to >File >Export >Export File and select the 

desired export format. For batch processing of all active captures, go to >File >Export 

>Export All Open Files. For batch processing of a complete folder, go to >File >Export 

>Batch export. To export only a selected portion of an MVN or MVNX file go to >File 

>Export >Export Selection. 

There are five main exporters, BVH, C3D, FBX, MVNX, and a Movie Exporter. Each 

exporter has its own menu in the preferences section. 

 

If working with an MVN Basic or MVN Animate/Analyze plus there exporting 

functionalities can be accessed through a MotionCloud subscription. MotionCloud can be 

accessed directly through MVN or via a separate web-browser. 

15.1 BVH 
The name BVH stands for BioVision Hierarchical data, and embeds captured motion data 

in ASCII format which can be imported in many animation applications. 

 

A BVH file consists of two parts, a header section which describes the hierarchy and 

initial pose of the skeleton; and a data section which contains the motion data. The start 
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of the header section begins with the keyword ‘HIERARCHY’. The following line starts with 

the keyword ‘ROOT’ followed by the name of the root segment of the hierarchy to be 

defined, usually the hips. Each segment contains a vector indicating the length and 

direction from the parent segment. The vector is specified by the keyword ‘OFFSET’ 

followed by the X, Y and Z values. The ‘CHANNELS’ keyword indicates the number of 

channels for this segment (usually 3 Euler angles) together with the order of rotation. On 

the next line, either you will find the ‘JOINT’ keyword or the ‘End Site’ keyword. The end 

site information ends the recursion and indicates that the current segment is an end 

effector (has no children). The end site definition gives the length of the preceding 

segment just like the offset of a child defines the length and direction of its parents 

segment. The world space is defined as a right handed coordinate system with the Y axis 

as the world up vector. 

 

In the default BVH hierarchy, the character is in a T-pose. Use the 3ds Max exporter to 

write a neutral pose (arms parallel to body). Use the Poser exporter to reduce the 

number of chest segments from 4 to 2. 

 

The motion section begins with the keyword ‘MOTION’. This line is followed by the 

number of motion frames by the keyword ‘Frames’ and ‘Frame Time’, indicating the 

sampling rate of the data. The rest of the file contains the actual motion data; the X, Y 

and Z position of the root segment and Euler angles of each segment with respect to its 

parent segment. Each line is one sample of motion data. The numbers appear in the 

order of the channel specifications as the skeleton hierarchy was parsed. 

 

 

 

 

It should be noted that the BVH format is restrictive and it does not reflect the full 

information as captured with MVN. The numerical resolution of BVH files is limited 

compared to the MVN and MVNX files. The Euler angle conversion may cause round-off 

issues in certain poses (singularities). Since all segments are rigidly connected (which is 
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not the case in the MVN Fusion Engine) some foot slide may occur since all errors such as 

mainly soft tissue artefacts are ‘projected’ on the feet. Further optimization can be done 

by using inversed kinematics (IK) solvers which are usually available in animation 

applications and which are also necessary for retargeting the motion data to different 

characters. 

 

The BVH format does not support multi-person recordings. For each person a separate 

BVH file will be made. 

 

Set the BVH preferences. An explanation of each option is provided below. 

  

Figure 85: BVH Preferences Menu 

15.1.1 Frame skip 

The frame skip number (n) is used to reduce the frame rate of the output. The exporter 

will perform down sampling by skipping every n frames (n = 0 to 10) of the original file 

(after smoothing) in the output. Note that if no smoothing is specified, no smoothing will 

be applied when using frame skip.  

 

The output rate is given by: original sample rate / (1 + skip factor). 

 

For example, an MVN file recorded at 100 Hz: 

frame skip = 1, output frame rate = 50 Hz 

frame skip = 2, output frame rate = 33 Hz 

frame skip = 3, output frame rate = 25 Hz 

 

Or for example, an MVN file recorded at 240 Hz: 

frame skip = 1, output frame rate = 120 Hz 

frame skip = 2, output frame rate = 80 Hz 

frame skip = 3, output frame rate = 60 Hz 

 

So, take care when selecting your preferred motion capture update rate if you need a 

specific output frame rate, it can make your life easier. 

15.1.2 Overwrite first frame with T-pose 

To align the captured motion data with an animation model, the T-pose will actually be 

inserted before the first frame of the data. The position and orientation of all segments 

can be found in the MVNX file in the <tpose>section. 
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15.1.3 Output Presets 

Several Output Presets are available that fit specific applications: 

• Motion Builder 

• 3D Studio Max 

• Poser 6 

15.1.4 Output Unit 

Select the desired output unit that is used in the animation program. 

15.2 C3D 
C3D means “Coordinate 3D”; as the name suggests it is a file format designed to contain 

3D coordinate data, usually in the form of bony landmarks. It has also been designed to 

contain analog data. The 3D and analog samples are interleaved, frame-by-frame, 

throughout the data in a straightforward manner. 

 

C3D data can contain 3D, 2D, analog data or a combination. The menu in Figure 86 

shows the possibilities allowed for C3D export. 

  

Figure 86: C3D Exporter interface in Preferences menu 

There are two lists of points that can be exported, “All available points” and “External 

Points”. External Points are included in the “All available” selection. Section 15.2.1 is a 

list of the anatomical landmarks exported by C3D. Just like BVH, C3D data can be 

downsampled prior to exporting. 

 

Most systems accept the 16 bit integer output format. However, when this is not the 

case, the single precision floating point (IEEE 754) can be chosen, which will enhance 

resolution (less output quantization). 

 

In the past C3D was designed to accept no more than 65535 frames. Tick the box to 

allow trials longer than 65535. 

 

A prop will be exported in C3D with tags: ‘origin’, ‘tip’ and ‘extra’. 
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15.2.1Points exported in C3D Exporter 

For an illustration of the location of the points, see Figure 93. 
# points # points 

1 pHipOrigin 33 pRightTopOfHand 

2 pRightASI 34 pRightPinky 

3 pLeftASI 35 pRightBallHand 

4 pRightCSI 36 pLeftTopOfHand 

5 pLeftCSI 37 pLeftPinky 

6 pRightIschialTub 38 pLeftBallHand 

7 pLeftIschialTub 39 pRightGreaterTrochanter 

8 pSacrum 40 pRightKneeLatEpicondyle 

9 pL5SpinalProcess 41 pRightKneeMedEpicondyle 

10 pL3SpinalProcess 42 pRightMiddleKneeCap (or pRightPatella) 

11 pT12SpinalProcess 43 pLeftGreaterTrochanter 

12 pPX 44 pLeftKneeLatEpicondyle 

13 pIJ 45 pLeftKneeMedEpicondyle 

14 pT4SpinalProcess 46 pLeftMiddleKneeCap (or pLeftPatella) 

15 pT8SpinalProcess 47 pRightLatMalleolus 

16 pC7SpinalProcess 48 pRightMedMalleolus 

17 pTopOfHead 49 pRightTibialTub 

18 pRightAuricularis 50 pLeftLatMalleolus 

19 pLeftAuricularis 51 pLeftMedMalleolus 

20 pBackOfHead 52 pLeftTibialTub 

21 pRightAcromion 53 pRightHeelFoot 

22 pLeftAcromion 54 pRightFirstMetatarsal 

23 pRightArmLatEpicondyle 55 pRightFifthMetatarsal 

24 pRightArmMedEpicondyle 56 pRightPivotFoot 

25 pLeftArmLatEpicondyle 57 pRightHeelCenter 

26 pLeftArmMedEpicondyle 58 pRightToe 

27 pRightUlnarStyloid 59 pLeftHeelFoot 

28 pRightRadialStyloid 60 pLeftFirstMetatarsal 

29 pRightOlecranon 61 pLeftFifthMetatarsal 

30 pLeftUlnarStyloid 62 pLeftPivotFoot 

31 pLeftRadialStyloid 63 pLeftHeelCenter 

32 pLeftOlecranon 64 pLeftToe 

 

If props have been used in the measurement, these will also be exported in the C3D file. 

The parameters of the props are Extra, Origin and Tip. If more than one prop has been 

used, the label will be appended with “_” and the number of the prop (2 onwards). To 

use the point, as with the output points of the biomechanical model, use the label 

“Origin”. Tip and Extra are needed to calculate the orientation of the prop. 

15.3 FBX 

FBX (Filmbox) is a platform-independent 3D file format which gives you access to content 

authored in software packages such as MotionBuilder, Maya, Unity or Softimage. For 

some software packages, an FBX plug-in should be installed. 
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Figure 87: FBX Preferences Menu 

FBX files contain both position and orientation information of all 23 segments. The FBX 

file will also contain the frame time format. Go to >Options >Preferences >Exporters 

>FBX … and select the timestamp output mode. To store the appropriate time code in an 

FBX file, the FBX exporter plug-in must be set to “Dynamic time increments" and "Start 

at real start time” as seen in   

Figure 87. This figure also shows that many of the options for FBX are also applicable to 

BVH. For details, see the above descriptions for the items on the BVH menu. 

 

Under Output preset you have the option to choose “Default” and “Skeleton”. “Default” 

export contains position and orientation information of all 23 segments in global 

coordinates. “Skeleton” export contains skeleton hierarchy information in a way that is 

used by many common 3D software packages like MotionBuilder, Maya, Unity and 

Houdini. 

 

15.4 MVNX 

MVNX (MVN Open XML format) files are provided. These are XML files that can be opened 

in programs such as Microsoft Excel, Access, MATLAB and C-Motion Visual 3D. 

 

C-Motion Visual 3D fully supports MVNX data, an example video of the integration can be 

found here: https://www.youtube.com/watch?v=btGLIStuqd4 

 

Tutorial videos are available on how to import MVNX data into, respectively, Microsoft 

Excel and MATLAB: 
https://tutorial.xsens.com/video/importing-mvnx-into-excel 
https://tutorial.xsens.com/video/importing-mvnx-into-matlab 

https://www.youtube.com/watch?v=btGLIStuqd4
https://tutorial.xsens.com/video/importing-mvnx-into-excel
https://tutorial.xsens.com/video/importing-mvnx-into-matlab
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MVNX contains as default, 3D segment and position data.  

 

Additional values can be exported as Figure 88 shows, including: 

• 3D Position, linear and angular acceleration and velocity of all 23 segments. 

• 3D Joint angles of 22 joints. 

• Center of Mass position of the body 

• Contact data indicating which contact point was detected as ground contact 

• 3D Orientation, free acceleration and magnetic field data of all 17 MT’s. 

 

Since MVN 4.0, a time code field is also available. 

  

Figure 88: MVNX Preferences Menu 

 

The MVN Fusion Engine calculates the position and orientation, and other kinematic data 

of each body segment, B, with respect to an earth-fixed reference co-ordinate system, G. 

By default, the earth-fixed reference co-ordinate system used is defined as a right 

handed Cartesian co-ordinate system. 

The axes of the Global reference system are defined as: 

• X (red) pointing to the local magnetic North. 

• Y (green) according to right-handed coordinate system (West) 

• Z (blue) pointing up 

 

The axes of each body frame (B) are aligned with this Global reference frame (G) when 

the subject is standing in the T-pose as shown in Figure 89. 
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Figure 89: Segment coordinate system at each segment origin, as is used in MVN. Legend: x: red, 

y: green, z: blue 

 

This section describes the MVNX definition based on version 4 (available since MVN 

4.3.7). This version contains some important fixes with respect to the previous version 

and it is recommended to use this version. Still, version 3 is available and can be chosen 

in the MVNX exporter preferences. Section 15.4.1 contains more details on the 

differences between MVNX version 3 and version 4.   
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The entire MVNX structure is as follows: 
<?xml version="1.0" encoding=" UTF-8"?> 
<mvnx version=“4”> 
     <mvn version=“…” build=“…”/> 
     <comment></comment> 
     <subject label=“Suit…” frameRate=“…”segmentCount=“…”recDate=“…”originalFilename=“…”> 
            <comment></comment> 
     <segments> 
        <segment label=“…” id=“…”> 
          <points> 
             <point label=“…”> 
                    <pos_b>X Y Z</pos_b/> 

             </point> 
etc. 
          </points> 
        </segment> 
etc. 
     </segments> 
     <sensors> 
        <sensor label =“…”/> 
etc. 
     </sensors> 
     <joints> 
        <joint label=“…”> 
             <connector1>…</connector1> 
             <connector2>…</connector2> 
        </joint> 
etc. 
     </joints> 
     <frames segmentCount= “…” sensorCount= “…” jointCount= “…”> 
          <frame time= “…” index= “…” type =“normal”> 
          <orientation>GBqseg1 

GBqseg2  …etc…   GBqseg23</orientation> 
          <position>Gposseg1 

Gposseg1 …etc…  Gposseg23</position> 
          <velocity>Gvseg1 Gvseg2 …etc…  Gvseg23 </velocity> 
          <acceleration>Gaseg1 Gaseg2  …etc…  Gaseg23 </acceleration> 
          <angularVelocity>Gwseg1 Gwseg2  …etc… Gwseg23</ angularVelocity > 
          <angularAcceleration>Gawseg1 Gawseg2 …etc…  Gawseg23</angularAcceleration> 
          <footContacts> LeftFoot_Heel … LeftFoot_Toe … RightFoot_Heel … RightFoot_Toe </footContacts> 
          <sensorMagneticField>Smsen1 Smsen2  …etc… Smsen17</sensorMagneticField> 
          <sensorOrientation>GSqsen1 GSqsen2  …etc… GSqsen17</sensorOrientation> 
          <jointAngle>jjnt1 jjnt2  …etc… jjnt22</jointAngle> 
           <jointAngleXZY>Jjnt1 Jjnt2  …etc… Jjnt22</jointAngleXZY> 
           <jointAngleErgo> JEjnt1 JEjnt2  …etc… JEjnt4 <jointAngleErgo> 
          <centerOfMass>GCseg1 GCseg2 …etc… GCseg23 </centerOfMass> 
          <marker>“name” </ marker > 
          </frame> 
etc. 
     </frames> 
     </subject> 
     <securityCode code= “…” /> 
</mvnx> 

The MVNX file starts with the XML version. Then the root element “mvnx” with a 

reference to the XSD (XML Schema Definition) and the MVNX version This is followed by 

a field “mvn”, containing the MVN Analyze/Animate version and build details with which 

this MVNX file was produced, followed by the comments that were added to the original 

recording: 
<?xml version="1.0" encoding=" UTF-8"?> 
<mvnx xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="http://www.xsens.com/mvn/mvnx" xsi:schemaLocation=http://www.xsens.com/mvn/mvnx 
http://www.xsens.com/mvn/mvnx/schema.xsd version=“4”> 
     <mvn version=“…” build=“…”/> 
     <comment></comment> 

The file continues with session information, including the suit label (= name of the MVN 

System), sample frequency used, number of segments calculated (indicating full or half 

http://www.xsens.com/mvn/mvnx%20http:/www.xsens.com/mvn/mvnx/schema.xsd
http://www.xsens.com/mvn/mvnx%20http:/www.xsens.com/mvn/mvnx/schema.xsd
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body); the date that the recording took place, and the filename of the original recording 

on which the MVNX file is based. When creating a recorded file, a user can insert a 

comment. This is available in the exported MVNX: (this field usually has the same 

contents as the comment field after the <mvn> tag, see above) 

<subject label=“ Suit 00130268” frameRate=“100 segmentCount=“23”recDate=“day month 
year”originalFilename=“DIRECTORY\FILENAME.mvn”> 
 <comment></comment> 

The next section contains mesh scale and labeling information for the segments. The 

mesh scale data is used for scaling of the visualization of the character in MVN 

Analyze/Animate. 

 

The section <segments> defines all positions (pos_b) of connecting joints (prefixed with 

a “j”) and anatomical landmarks (prefixed with a “p”) with respect to origin of that 

segment (in body fame B). The body frame (B) of this list of points is defined by Figure 

89. 

Within each segment is: 
<segments> 
<segment label=“RightUpperLeg” id=“16”> 
  <points> 
  <point label=“…”> 
   <pos_b>X Y Z</pos_b/> 
   </point> 
etc. 
  </points> 
</segment> 

The sensor data is simply a list of the names of segments measured with the MT’s: 
<sensors> 
 < sensor label ="Pelvis"/> 
 < sensor label ="Head"/> 
 < sensor label ="RightShoulder"/> 
etc. 
</sensors> 

The “joints” section is a list of the names of joints contained and the segments and 

connections a given joint: 
<joints> 
  <joint label=“ jLeftHip”> 
  <connector1>Pelvis/jLeftHip </connector1> 
  <connector2>LeftUpperLeg/jLeftHip </connector2> 
  </joint> 
  etc. 
</joints> 
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The “ergonomic joint angles” section is a list of specific joint angles used in ergonomic 

analysis contained, and the segments and connections for each given joint: 
<ergonomicJointAngles> 
  <ergonomicJointAngle label=“ T8_Head” index="0" parentSegment="T8" childSegment="Head"/> 
  etc. 
  </ergonomicJointAngles> 

The “foot contact definition” section is a list of the given foot contact points, and their 

index in the foot contact definition array for every given time frame, if the point is in 

contact with the ground, it is given the value 1, whilst if it is not in contact, given the 

value 0: 
<footContactDefinition> 
  <contactDefinition label=“LeftFoot_Heel” index="0"/> 
  etc. 
  </footContactDefinition> 

The frames section is opened with the segment, sensor and joint count. The data of all 

parameters are contained within this section, including the calibration pose data. 
<frames segmentCount= “…” sensorCount= “…” jointCount= “…”> 
  <frame … > 
  </frame> 
  Etc. 
</frames> 

The frame type “identity” denotes the nullpose or identity pose. All segment orientations 

in this pose are aligned with the global coordinates and have unit quaternion.  
<frame time="0" type="identity"> 

<orientation>…<orientation/> 
<position>…<position/> 

</frame> 

The frame type “tpose” describes the positions and orientations of all segments in the T-

pose. The positions and orientations of certain segments deviates slightly from the 

identity pose.  
<frame time="0" type="tpose"> 

<orientation>…<orientation/> 
<position>…<position/> 

</frame> 

The frame type “tpose-isb” describes the positions and orientations of all segments in the 

T-pose, but using the MVN anatomical frame for the body segments (Figure 92). The 

MVN anatomical frame is used to calculate the joint angles.  
<frame time="0" type="tpose-isb"> 

<orientation>…<orientation/> 
<position>…<position/> 

</frame> 

Following this, the frames are split into time; each frame increment is equivalent to 

([frame no. /update rate]*1000 [ms]). So at 120Hz, frame 1 is denoted by 

([1/120]*1000) = 8.3[ms]. Frames measured during a normal session are denoted with 

type = “normal”. 

The index attribute still contains the original frame number. 

The optional “tc” and “ms” attributes contain the TimeCode values, i.e. the absolute real 

time at which that specific frame was recorded (often used to synchronize and combine 

this recording with other data that was gathered at the same time). 
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The selection in the preferences menu determines the MVNX contents. Orientation and 

Position are mandatory, all others are optional and may depend on the license. 
<frame time= “…” index="frame number" tc="15:57:47:02" ms="1418227067039" type =“normal”> 
  <orientation>GBqseg1 

GBqseg2  …etc…   GBqseg23</orientation> 
  <position>Gposseg1 

Gposseg2 …etc…  Gposseg23</position> 
  <velocity>Gvseg1 Gvseg2 …etc…  Gvseg23 </velocity> 
  <acceleration>Gaseg1 Gaseg2  …etc…  Gaseg23 </acceleration> 
  <angularVelocity>Gwseg1 Gwseg2  …etc… Gwseg23</ angularVelocity > 
  <angularAcceleration>Gawseg1 Gawseg2 …etc…  Gawseg23</angularAcceleration> 
   <footContacts> LeftFoot_Heel … LeftFoot_Toe … RightFoot_Heel … RightFoot_Toe </footContacts> 
  <sensorMagneticField>Smsen1 Smsen2  …etc… Smsen17</sensorMagneticField> 
  <sensorOrientation>GSqsen1 GSqsen2  …etc… GSqsen17</sensorOrientation> 
  <jointAngle>jjnt1 jjnt2  …etc… jjnt22</jointAngle> 
   <jointAngleXZY>Jjntx1 Jjntx2  …etc… Jjntx22</jointAngleXZY> 
   <jointAngleErgo> JEjnt1 JEjnt2  …etc… JEjnt4 <jointAngleErgo> 
  <centerOfMass>GCseg1 GCseg2 …etc… GCseg23 </centerOfMass> 
  <marker>“name” </ marker name> 
</frame> 

 

For the elements represented below with a subscript “seg”, the set will contain the 

number of segments (segmentCount) times the number of columns of data. For a full 

body, this is 23 segments. 

 

Subscript “sen” contains the number of MT’s (sensorCount) times the number of columns 

of data. For a full body, this is 17. 

 

Subscript “jnt” contains the number of joints (jointCount) times the number of columns 

of data. For a full body, this is 22 joints. 
Function Describtion 
GBqseg  1x4 quaternion vector (q0, q1, q2, q3) describing the orientation of the segment 

with respect to the global frame.  

Gposseg  1x3 position vector (x, y, z) of the origin of the segment in the global frame in 
[m]. 

Gvseg  1x3 velocity vector (x, y, z) of the origin of the segment in the global frame in 
[m/s]. 

Gaseg  1x3 acceleration vector (x, y, z) of the origin of the segment in the global 
frame in [m/s2]. 

Gwseg  1x3 angular velocity vector (x, y, z) of the segment in the global frame in 
[rad/s]. 

Gawseg  1x3 angular acceleration vector (x, y, z) of the origin of the segment in the 
global frame in [rad/s2]. 

Gasen  1x3 sensor free acceleration vector (x, y, z) of the sensor in [m/s2]. 

Smsen  1x3 sensor magnetic field vector (x, y, z) of the sensor in [a.u.]. 

GSqsen  1x4 sensor orientation quaternion (q0, q1, q2, q3) of the sensor in the global 
frame in. 

jjnt  1x3 Euler representation of the joint angle vector (x, y, z) in [deg], calculated 
using the Euler sequence ZXY using the ISB based coordinate system. 

Jjntx  1x3 Euler representation of the joint angle vector (x, y, z) in [deg], calculated 
using the Euler sequence XZY using the ISB based coordinate system. 
Note: The joint angle using Euler sequence XZY is calculated and 
exported for all joints, but commonly only used for the shoulder joints, 

and it may depend on the movement of the shoulder if it is appropriate 
to use. 

GCseg  1x3 position of the body Center of Mass (x,y,z) in the global frame in [m]. 
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The numbering is presented in the table below. 
Number Segment Label Tracker Joint 

1 Pelvis Pelvis jL5S1 

2 L5 T8 jL4L3 

3 L3 Head jL1T12 

4 T12 RightShoulder jT9T8 

5 T8 RightUpperArm jT1C7 

6 Neck RightForeArm jC1Head 

7 Head RightHand jRightC7Shoulder 

8 Right Shoulder LeftShoulder jRightShoulder 

9 Right Upper Arm LeftUpperArm jRightElbow 

10 Right Forearm LeftForeArm jRightWrist 

11 Right Hand LeftHand jLeftC7Shoulder 

12 Left Shoulder RightUpperLeg jLeftShoulder 

13 Left Upper Arm RightLowerLeg jLeftElbow 

14 Left Forearm RightFoot jLeftWrist 

15 Left Hand LeftUpperLeg jRightHip 

16 Right Upper Leg LeftLowerLeg jRightKnee 

17 Right Lower Leg LeftFoot jRightAnkle 

18 Right Foot  jRightBallFoot 

19 Right Toe  jLeftHip 

20 Left Upper Leg  jLeftKnee 

21 Left Lower Leg  jLeftAnkle 

22 Left Foot  jLeftBallFoot 

23 Left Toe   

 

15.4.1 MVNX backwards compatibility 

Until MVN 4.3.7, MVNX (version 3) contained some inconsistencies related to the 

coordinate frames, which have been resolved (version 4). For backwards compatibility, it 

is still possible to import and export version 3 of MVNX. 

 

The changes of version 4 with respect to version 3 are: 

• The list of points at the beginning of the MVNX files is now correctly denoted as 

pos_b instead of pos_s. 

• The segment orientations GBq give the relation between global frame (G) and body 

frame (B). In version 3, this body frame is defined in Figure 89 and consistently 

used in the MVNX. In version 3, the body frames are defined by the MVN anatomical 

pose (Figure 92).  

• The initial poses used by the MVNX are now written as “identity” denoting the null-

pose, “tpose” denoting the T-pose, and “tpose-isb” denoting the T-pose using the 

MVN anatomical coordinate frame. In version 3, the initial poses were “tpose” 
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denoting the T-pose using MVN anatomical coordinate frame, and “npose” denoting 

the relation between the body frames of the T-pose and MVN anatomical pose. 

 

15.5 Export Movie 

Exporting movie data enables the user to export the 3D viewport of MVN 

Analyze/Animate to either .m4v or .avi. this facilitates presenting MVN information to 

audiences without the need for installation of MVN Analyze/Animate, Select the export 

format, resolution and export frame in >Options >Preferences >Exporters >Movie 

Exporter. 
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15.6 Export Excel 
 

It is now possible to export your data into an excel spreadsheet, simply put the output 

path, and file name in. Under Exporter select “Excel Exporter (*.xlsx)”. And click Export. 

 

 
 
Each corresponding section of the navigator (ie. Segments, joints etc.) will have its own 

tab in the xlsx file, each joint/segment will have its own column, with the frames listed in 

the rows. 
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16 Features of MVN SW licenses 
A range of additional features become available when using another license for MVN 

system. Additionally, the MVN Animate and MVN Analyze software has been restructured 

into:  

- Basic: free to download software, to create MVN files 

- Plus: stream to your third party software 

- Pro: all features included 

 

See the full comparison of the different Basic, Plus and Pro licenses below.  

Features for Animate:  https://www.xsens.com/compare/mvn-animate 

Features for Analyze: https://www.xsens.com/compare/analyze-basic 

16.1 MVN usage statistics 

An additional feature of MVN Analyze/Animate is the ability to gather and send 

anonymous usage statistics. The purpose of this is to help inform Xsens which 

components and features are most frequently used. Moreover, it can guide product 

management in making decisions to improve the product, inform quality assurance on 

which features to test, as well as the development team to ensure changes/fixes have 

had the desired effect. The data is anonymous via random identification and sent to 

Xsens once per day, with no personal data being stored. The user has the option to opt 

out of these statistics within the splash screen when MVN is first opened, as well as in the 

preferences section of the option tab.    

 

https://www.xsens.com/compare/mvn-animate-basic?_ga=2.180479918.826698929.1619172905-1005152132.1563269719
https://www.xsens.com/compare/analyze-basic?_ga=2.181004462.826698929.1619172905-1005152132.1563269719
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17 MVN Ethernet Camera 
MVN Analyze/Animate has the ability to record synchronized MVN and video data. This is 

possible using the Ethernet camera (Prosilica GS650) provided with the PRO system. The 

camera is a high quality professional GigE camera with a C mount. The GigE interface 

enables the use of long cables (max 100m) and standard 1 Gigabit Ethernet cards for 

interfacing. The currently supported frame rate in MVN Analyze/Animate is limited, but 

the camera itself is capable of 120 frames per second (fps), depending on lighting 

conditions. The camera has a global shutter and is capable of advanced triggering and 

synchronization features. 
https://base.xsens.com/hc/en-us/articles/360012884940-MVN-Ethernet-Camera-Legacy- 
 

Note: The MVN Ethernet Camera is a legacy product. If you are looking for 

similar functionality, the Remote App for iOS and Android might be suited (13. 

MVN Remote app for iOS and Android) 

 

https://base.xsens.com/hc/en-us/articles/360012884940-MVN-Ethernet-Camera-Legacy-
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18  Xsens Peripheral Software 

18.1 Magnetic Field Mapper (MFM) 

When a motion tracker is mounted to an object that contains ferromagnetic materials, 

the measured (Earth) magnetic field can become distorted, causing errors in measured 

orientation. To correct for known magnetic disturbances, for example, an MT attached to 

a steel prosthesis or prop, or simply that the magnetic field has become distorted due to 

an event or over time, a separate software product has been developed to allow users to 

remap the magnetic field. This software is called Magnetic Field Mapper (MFM). 

If MFM is needed, users should contact support@xsens.com for further support. 

18.2 Firmware Updater 

With new software releases, it can be expected that new firmware is required. For this 

purpose, Xsens supplies a firmware updater which can be downloaded separately from 

MVN Analyze/Animate at https://www.xsens.com/software-downloads under ‘Tools and 

Firmware’. 

18.3 Software Activation Tool: Offline License Activation or Updating 

a License 

An offline activation can be performed with the Software Activation Tool. In the offline 

activation process a Customer-to-Vendor (c2v) file is generated containing information 

on the current status of the licenses in your Sentinel protection keys. You can then send 

this file in order to activate license or receive a license update. 

 

Note: If you are using a dongle you must connect the dongle, before performing 

either of the following procedures. 

18.3.1 Step 1: Retrieve the license information from a Sentinel protection key 

1. Launch the Software Activation tool from the start menu or help menu in MVN 2018.x 

2. Click “Show advanced options”. 

3. Activating a Software License key for the first time: ensure that “Installation of a New 

Protection Key” is selected at the bottom of the screen. Updating an existing key or 

activate a dongle: ensure that “Update of existing protection key” is selected at the 

bottom of the screen. 

4. Click “Create security key information file (C2V)” 

5. Click “Next”, the file is generated 

6. Specify the directory where you want to store the C2V file. Enter a file name and click 

“Save”. 

7. The C2V file for the Sentinel protection key is generated and saved in the required 

location. The file can now be sent. 

18.3.2 Step 2: Send the C2V file 

1. Send the C2V file to Xsens support (support@xsens.com) requesting an offline license 

file. 

2. You will receive a Vendor-to-Customer file (v2c) from Xsens support. 

18.3.3 Step 3: Apply the received v2c file using the Software Activation tool. 

1. Launch the Software Activation tool. 

2. Click “Show advanced options”. 

3. Click “Apply license file (V2C)”. 

mailto:support@xsens.com
https://www.xsens.com/software-downloads
mailto:support@xsens.com
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4. Click “Next” and browse to the V2C files you have received to open it 

The license is activated/updated. 

18.4 Software Activation Tool: Applying an Update 

You can use the Software Activation tool to apply an update to the licenses stored in your 

Sentinel protection keys. 

To update the licenses in the Sentinel protection keys: 

1. Launch the Software Activation tool from the start menu or help menu in MVN 

Analyze/Animate 

2. Click “Show advanced options”. 

3. Click “Apply license file (V2C)”. 

4. Click “Next” and browse to the V2C files you have received to open it 

The license is activated/updated. 

18.5 RUS Utility: Rehosting a Sentinel protection key 

The RUS utility can be downloaded from: https://www.xsens.com/software/  

You can use the RUS utility to transfer a Sentinel protection key from one computer (the 

source computer) to another (the recipient computer). This is a three-step procedure 

that uses the RUS utility on both computers. 

18.5.1 Step 1: Collect Information about the Recipient Computer 

1. On the recipient computer, launch the RUS utility 

2. Click the Transfer License tab. 

3. Follow the instructions labelled “Step 1” to collect information about the computer 

and save it to a file. Make sure that the file (or a copy of the file) is accessible on the 

source computer. 

18.5.2 Step 2: Generate the License Transfer File 

1. On the source computer, launch the RUS utility 

2. Click the Transfer License tab. 

3. Follow the instructions labelled “Step 2” to select the SL key to transfer, read the 

recipient information file, and generate a license transfer (h2h) file. Make sure that 

the license transfer file (or a copy of the file) is accessible on the recipient computer. 

Note: After you perform this step, the SL key is no longer available on the 

source computer. Be sure to keep a copy of the transfer file until you have 

completed the transfer procedure. 

18.5.3 Step 3: Apply the License Transfer File 

1. On the recipient computer, in the RUS utility, click the Apply License File tab. 

2. In the Update File field, click the browse button and locate the license transfer (h2h) 

file. 

3. Click Apply Update. The SL key is installed on the recipient computer. 

Note: To ensure the success of the transfer procedure, all the steps in the 

procedure should be completed within no more than a two days of the time you 

first start the process. 

18.6 Setup a network license 
The server that will carry the licenses needs to be setup.  

https://base.xsens.com/hc/en-us/articles/360012575799-How-to-set-up-a-Server-and-

Client-for-Network-License 

 

https://www.xsens.com/software/
https://base.xsens.com/hc/en-us/articles/360012575799-How-to-set-up-a-Server-and-Client-for-Network-License
https://base.xsens.com/hc/en-us/articles/360012575799-How-to-set-up-a-Server-and-Client-for-Network-License
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How to active a network license: 

https://base.xsens.com/hc/en-us/articles/360012632119-How-to-activate-a-Network-

License 

https://base.xsens.com/hc/en-us/articles/360012632119-How-to-activate-a-Network-License
https://base.xsens.com/hc/en-us/articles/360012632119-How-to-activate-a-Network-License
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19 Troubleshoot 
Problem Solution 

Device driver error 
Awinda Station with 
docked MTw’s results in 
"Driver Software 
Installation" error. See 

figure to the right 
displaying the pop-up 
warning: 

 

This is a timing issue because Xsens motion trackers send data to 
the PC continuously to guarantee a fast set up time. To solve, 

remove the tracker from the station then redock. 

The suit does not connect. Check battery levels. 
 
Check ‘Hardware status’ menu (Section 7.6). 
 
Check Suit configuration (Section 7.2.5) 

 
Ensure that only one MVN Analyze/Animate is running on a given 
computer. 
 
MVN LINK: 

Turn on the BP off and on again (Section 5.1.2.1). 

 
Run a WPS between BP and AP 
 
MVN Awinda: 
Unplug Awinda Station from power supply and PC then reconnect 
re-plug. 
 

Power off MTws press power button for 6s. Press for 1s to turn 
back on. 

MTx status remains 
missing (‘red’) in 
‘Hardware status’ menu 

Check if MTx is connected. Sometimes a connector can become 
loose after putting on the suit. 
 

Replace MTx and relocate sensor ID (Section 7.6.1). 

MVN Analyze/Animate 

does not start (Shader 
compilation / validation 
errors). 

Use a computer with at least a DirectX 9 hardware card. 

Limited range wireless 
connection 

Turn off all other wireless equipment (Bluetooth, WiFi, etc) and 
scan for a WiFi channel free of other wireless signals. 

Live preview is active but 
recording is not possible 

Enter the subject dimensions: body height and Foot or Shoe length 
(Section 7.2.9). 
 

Perform an N-pose + Walk calibration (Section 8.1). Make sure to 
apply. 
 
MVN Awinda: 
Make sure that no Synchronization settings have been saved to the 
Awinda station 
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Character sticks to the 
ground or segments are 
pulled apart (wrongly 
detected contacts). 

Enter correct body dimensions of subject (Section 7.2.9). 
 
Perform new calibration pose. 
 
Choose suitable user scenario (default is flat ground assumption) 
(Section 7.2.6). 

 
Make sure the feet trackers are mounted rigidly.  

Character appears to 
bounce slightly when no 
movement is taking place. 

This is likely to be caused by visualization rather than data 
issues.Can result when tile size on the floor in MVN 
Analyze/Animate is large.  
 

Verify that the character is not moving using position data (eg 
graphical representation) to ensure that no movement is being 
detected. The position data should remain unchanged.  

 
When this is the case, make the tile size smaller, usually 50cm is a 
good tile size for visualization. To do this, go to >Options 

>Preferences >Interface > 3D View 

Shadows have jerky 
movements, even when 
character remains 
unmoving. 

Visualization issue, probably caused by floor tile size being too 
large, meaning that the shadow is redrawn too frequently. 
Decrease the size of the tiles to reduce this visualization effect. 

Pelvis is displayed too 
high.  

MVN file is recorded with old version of MVN Analyze/Animate. 
Make a copy of the original file and reprocess (Section 10.5.2.6). 

The system does not run 
in real-time. 

Close all other running application. 
 
Check wireless connection (maximum range and disable other 

wireless equipment). 
 

Reduce the display frame rate and/or update rate. 
 
See Section 23.12 for the specification of the recommended 
computer system. 

During recording, the 
rotations of some 
segments do not 
correspond with the 3D 
character. 

Check if MT’s have not moved in the suit. Perform a new 
calibration. 
 
Move calmly for 10-20 seconds directly after calibration. 
 
Stand still and perform a Character Reset (Ctrl+Alt+F). 

During recording, the 
rotations of some 
segments are not smooth. 

Check wireless connection. 
 
Sensors clipped. Use ‘Correct sensor clipping data on reprocess’ 
option in >Options >Preferences >General >Recordings. Reprocess 
file. 

 

Stand still and perform a Character Reset (Ctrl+Alt+F). 
 
With MVN Awinda: 
Change the radio channel (See 23.11.1) 
Verify that this is also the case with a saved and reprocessed file 
(which will also contain retransmitted data) 

Graphical performance of 
MVN Analyze/Animate is 
poor; update of image is 
slow 

Set display frame rate to the same rate as the update rate in the 
preferences menu. 
 

Avatar/ system drops from 

MVN Analyze/Animate  

This may be due to network configurations. Uninstall the network 

driver for the active Ethernet connection (through your device 
manager) then reinstall. 
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 With MVN Awinda 
there appears to be a large 
latency  

Change the radio channel. (See 23.11.1) 

 MTw LED shows 

dual blink pattern  

This does not happen often, if it does it means that the MTw has 

crashed. To restore to normal, switch it off, by pressing the button 
for 6s. Press it for 1s to turn it back on. 

 When connecting 2 
or more MVN Awinda 
systems, MTw’s assign to 
the wrong awinda station 

Begin by connecting one Awinda station and turn on the MTw’s for 
the system associated with this receiver. Select the system under 
Accepted Systems and change the Wifi Radio channel in the 
Hardware Status window to allow all of the MTw’s to connect.   

 
Once the system is detected, repeat this process with the second 
and additional systems. 

Character walks in 
place or is seen flying 

across the screen 

Check to make sure that all trackers are in the correct locations 

The battery from one 
MTw tracker drains much 
faster than the other 
trackers 

Contact support base.xsens.com for assistance. 

https://base.xsens.com/
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20 Warranty and liability 
Xsens Technologies B.V. warrants the products manufactured by it to be free from 

defects in material and workmanship for a period of 2 years from the date of delivery. 

Products not subjected to misuse will be repaired, replaced or credit issued at the sole 

option of Xsens Technologies B.V. Contact support: base.xsens.com for return material 

authorization (RMA) prior to returning any items for calibration, repair or exchange. The 

product must be returned in its original packaging to prevent damage during 

shipping. 

 

The warranty shall not apply to products repaired or altered or removed from the original 

casing by others than Xsens Technologies B.V. so as, in Xsens Technologies B.V. opinion, 

to have adversely affected the product, products subjected to negligence, accidents or 

damaged by circumstances beyond Xsens Technologies B.V.’s control. 

 

Note: Xsens reserves the right to make changes in its products in order to 

improve design, performance, or reliability. 

 

Subject to the conditions and limitations on liability stated herein, Xsens warrants that 

the Product as so delivered shall materially conform to Xsens’ then current specifications 

for the Product, for a period of one year from the date of delivery. ANY LIABILITY OF 

XSENS WITH RESPECT TO THE SYSTEM OR THE PERFORMANCE THEREOF UNDER ANY 

WARRANTY, NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY WILL BE LIMITED 

EXCLUSIVELY TO PRODUCT REPAIR, REPLACEMENT OR, IF REPLACEMENT IS 

INADEQUATE AS A REMEDY OR, IN XSENS' OPINION IMPRACTICAL, TO REFUND THE 

PRICE PAID FOR THE PRODUCT. XSENS DOES NOT WARRANT, GUARANTEE, OR MAKE 

ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE 

PRODUCT OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 

RELIABILITY, OR OTHERWISE. Xsens shall have no liability for delays or failures beyond 

its reasonable control. 

20.1 Customer Support 

Xsens Technologies B.V. is glad to help you with any questions you may have about MVN 

or about the use of the technology for your application. Please contact Xsens Customer 

Support: 

 ➔ by our forum: base.xsens.com/  

 ➔ telephone: Xsens HQ +31 88 97367 00 / Xsens US office 310-481-1800 

 

To be able to help you, please mention the 8-digit number on the Xsens Sticker, you can 

find this at the handle of the Suitcase or backpack. 

https://base.xsens.com/
https://base.xsens.com/
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21 Regulatory Notices MVN Link 

21.1 Radio Frequency Exposure and Emission  

The MVN Link system contains a small radio transmitter and receiver. During 

communication with other Wi-Fi products system receives and transmits radio frequency 

(RF) electromagnetic fields (microwaves) in the frequency range 2400 to 2500 MHz or 

5200 to 5700MHz. The output power of the radio transmitter is very low. When using the 

system, you will be exposed to some of the transmitted RF energy. This exposure is well 

below the prescribed limits in all national and international RF safety standards and 

regulations.  

 

Most modern electronic equipment, for example, in hospitals and cars, is shielded from 

RF energy. However, certain electronic equipment is not.  

 

Therefore:  

Note: This equipment emits RF energy in the ISM (Industrial, Scientific, 

Medical) band. Please insure that all medical devices used in proximity to this 

device meet appropriate susceptibility specifications for this type of RF energy.  

 

Turn off this electronic device before entering an area with potentially explosive 

atmosphere. It is very rare, but any electronic device could generate sparks. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Areas 

with a potentially explosive atmosphere are often, but not always, clearly marked. They 

include fuelling areas, such as petrol station, below deck on boats, fuel or chemical 

transfer or storage facilities, and areas where the air contains chemicals or particles, 

such as grain, dust, or metal powders. 
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21.2  CE Declaration of Conformity MVN Link 
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21.3  Certificate of Conformity for Radio Equipment in EU 
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21.4  FCC Statement  
Note: This equipment has been tested and found to comply with the limits for a 

Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference in a 

residential installation. This equipment generates, uses and can radiate radio 

frequency energy and, if not installed and used in accordance with the 

instructions, may cause harmful interference to radio communications. 

However, there is no guarantee that interference will not occur in a particular 

installation. If this equipment does cause harmful interference to radio or 

television reception, which can be determined by turning the equipment off and 

on, the user is encouraged to try to correct the interference by one or more of 

the following measures:  

 

1. Reorient or relocate the receiving antenna  

2. Increase the separation between the equipment and receiver  

3. Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected  

 

Consult the dealer or an experienced radio/TV technician for help 

 

 

 

  

This device contains  
FCC ID: XPYJODYW164 
IC: 8595A-JODYW164 
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21.5 FCC Declaration of Conformity MVN Link 
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21.6 Certificate of Conformity for Radio Equipment in Japan  

 

 

5GHz product for indoor use only using frequencies within 5.15-5.35GHz. 
The product may be used indoor and/or outdoor using frequencies within 5.47-5.72 GHz. 
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22 Regulatory Notices MVN Awinda 

22.1 Radio Frequency Exposure and Emission 

The MTw2, Awinda dongle and station contains a small radio transmitter and receiver. 

During communication with the Awinda Master it receives and transmits radio frequency 

(RF) electromagnetic fields (microwaves) in the frequency range 2400 of 2500 MHz. The 

output power of the radio transmitter is very low. When using the system, you will be 

exposed to some of the transmitted RF energy. This exposure is well below the 

prescribed limits in all national and international RF safety standards and regulations. 

Most modern electronic equipment, for example, in hospitals and cars, is shielded from 

RF energy. However, certain electronic equipment is not. Therefore: 

 

Note: This equipment emits RF energy in the ISM (Industrial, Scientific and 

Medical) band. Please insure that all medical devices used in proximity to this 

device meet appropriate susceptibility specifications for this type of RF energy 

(CE or FCC marked). 

 

Turn off this electronic device before entering an area with potentially explosive 

atmosphere. It is very rare, but any electronic device could generate sparks. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Areas 

with a potentially explosive atmosphere are often, but not always, clearly marked. They 

include fuelling areas, such as petrol station, below deck on boats, fuel or chemical 

transfer or storage facilities, and areas where the air contains chemicals or particles, 

such as grain, dust, or metal powders. 
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22.2 CE Declaration of Conformity MTw2, Awinda Station, Awinda 

Dongle 
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22.3 FCC Statements 
This equipment has been tested and found to comply with the limits for a Class B digital 

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference in a residential installation. This 

equipment generates, uses and can radiate radio frequency energy and, if not installed 

and used in accordance with the instructions, may cause harmful interference to radio 

communications. However, there is no guarantee that interference will not occur in a 

particular installation. If this equipment does cause harmful interference to radio or 

television reception, which can be determined by turning the equipment off and on, the 

user is encouraged to try to correct the interference by one of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

 

FCC Caution: Any changes or modifications not expressly approved by the party 

responsible for compliance could void the user's authority to operate this equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 

two conditions: (1) This device may not cause harmful interference, and (2) this device 

must accept any interference received, including interference that may cause undesired 

operation. 

 

Radiation Exposure Statement for Awinda Station: 

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled 

environment. This equipment should be installed and operated with minimum distance 

20cm between the radiator & your body. This transmitter must not be co-located or 

operating in conjunction with any other antenna or transmitter. 

 

 

 

 

 

 

 

 

 

  

This MVN Awinda product contains 

 

FCC ID:  MTw2: QILMTW2-3A7G6 

Awinda Station: QILAW-A2 

Awinda Dongle: QILAW-DNG2 

Awinda Dongle ANT: QILAW-DNG2-ANT 
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22.4 FCC Declaration of Conformity MTw2 
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22.5  FCC Declaration of Conformity Awinda Station 
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22.6  FCC Declaration of Conformity Awinda Dongle 
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22.7  Certificate of Radio Equipment in Japan MTw2 
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22.8  Certificate of Radio Equipment in Japan Awinda Station 
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22.9  Certificate of Radio Equipment in Japan Awinda Dongle 
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23 Appendices 

23.1 Lycra suit sizes overview 

The typical height and weight of a subject that will fit into a given suit size is related. 

While this is generally accurate, it is an indication, therefore test the suit size, to ensure 

that it is tight enough to keep MTx’s in place during measurement while remaining 

relatively comfortable. 
Size Body height  Weight  

S 155 - 165 cm 5'1'' - 5'4'' ft. 50 – 65 kg 110 – 143 lbs. 

M 165 - 170 cm 5'4'' - 5'6'' ft. 65 – 75 kg 143 – 165 lbs. 

L 170 - 180 cm 5'6'' - 5'9'' ft. 75 – 85 kg 165 – 187 lbs. 

XL 180 - 195 cm 5'9'' - 6'4'' ft. 85 – 95 kg 187 – 210 lbs. 

XXL 195 - 205 cm 6'4'' - 6'8'' ft. 95 – 105 kg 210 – 231 lbs. 

XXXXL 205 - 215 cm 6'8'' - 7'1'' ft. 105 – 115 kg 231 – 254 lbs. 

 

23.2 MVN kinematics and output 

23.2.1Quaternion orientation representation 

A unit quaternion vector can be interpreted to represent a rotation about a unit vector n 

through an angle . 

( ) ( )( )2 2
cos , sinGBq  = n

 
A unit quaternion itself has unit magnitude, and can be written in the following vector 

format: 

( )0 1 2 3, , , ,q q q q q=
 

1q =
 

Quaternions are an efficient, non-singular description of 3D orientation and a quaternion 

is unique up to sign: 

q q= −
 

An alternative representation of a quaternion is as a vector with a complex part, the real 

component is the first element . 

The inverse 
BGq  is defined by the complex conjugate * of : 

( )*

0 1 2 3, , ,GB BGq q q q q q= − − − =
 

As defined here, 
GBq  rotates a vector 

B
x  in the body co-ordinate system (B) to the 

global reference co-ordinate system (G). 
*G GB B GB GB B BGq q q q=   =  x x x

 

Where   represents a quaternion multiplication: 

( )01 2 1 2 1 2, 1 2 2 1 1 20 0 0q q = q q v v q v q v v v  −   +  + 
 

with: 

( )

( )

1 2 3

1 2 3

1 1 , 1 , 1

2 2 , 2 , 2

v q q q

v q q q

=

=
 



0q

GBq
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and both   and  represent the standard dot and cross product, respectively. Be aware 

that the order of multiplication is important. Quaternion multiplication is not 

commutative, meaning: 

1 2 2 1q q q q  
 

 

23.2.2Conversions 

Quaternion to rotation matrix: 
2 2 2 2

0 1 2 3 1 2 0 3 1 3 0 2

2 2 2 2

1 2 0 3 0 1 2 3 2 3 0 1

2 2 2 2

1 3 0 2 2 3 0 1 0 1 2 3

2 2

2 3 1 2 0 3 1 3 0 2

2 2

1 2 0 3 1 3 2 3 0 1

1 3 0

2 2 2 2

2 2 2 2

2 2 2 2

1 2 2 2 2 2 2

2 2 1 2 2 2 2

2 2

q q q q q q q q q q q q

q q q q q q q q q q q q

q q q q q q q q q q q q

q q q q q q q q q q

q q q q q q q q q q

q q q q

 + − − − +
 

+ − + − − 
 − + − − + 

− − − +

= + − − −

−

R =

2 2

2 2 3 0 1 1 22 2 1 2 2q q q q q q

 
 
 
 + − −   

 

For further information on quaternion operations and rotations, refer to the book: J.B. 

Kuipers. Quaternions and Rotation Sequences. Princeton University. 

23.3 Body planes 

 

Frontal / coronal plane 

Transverse plane 

Sagittal plane 
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Figure 90: Body planes 
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23.4 Coordinate systems 
The MVN Fusion Engine calculates the position and orientation, and other kinematic data 

of each body segment, B, with respect to an earth-fixed reference co-ordinate system, G. 

By default, the earth-fixed reference co-ordinate system used is defined as a right 

handed Cartesian co-ordinate system with: 

 

Global reference frame: 

• X positive when pointing to the local magnetic North (red). 

• Y according to right handed co-ordinates (West) (green). 

• Z positive when pointing up (blue). 

 

The body frames are aligned with the Global reference frame when the subject is 

standing in T-pose. For the calculation of joint angles, an extra frame of reference (based 

on anatomical pose) is used to define the body frames. This frame of reference defines 

the body frames by: 

• Origin: center of rotation (proximal) 

• X forward. 

• Y up, from joint to joint. 

• Z pointing right. 

 

This different coordinate system is only used as in intermediate frame to calculate joint 

angles. Joint origins are determined by the anatomical frame and are defined in the 

center of the functional axes with the directions of the X, Y and Z being related to 

functional movements. For example, flexion/extension of the knee is described by the 

rotation about the BZ-axis of the lower leg with respect to the upper leg; 

abduction/adduction is the rotation about the BX-axis; and endo/exo rotation is about the 
BY-axis. Note that in some studies, different anatomical and reference frames definitions 

are used; to compare results proper co-ordinate frame transformations must be 

performed. 

 

After the calibration procedure, the right heel of the character is set at the origin (0,0,0). 

This is the begin point of the red arrow in the 3D viewport (pointing in the positive X-

direction). 

 

Figure 91: Global and local coordinate frames in MVN Analyze/Animate for the calculation of joint 
angles 
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23.5 Anatomical model 

23.5.1 Definition of segment axes 

To describe motion capture data in clinically meaningful data, e.g. joint rotations, it is 

necessary to define a coordinate reference frame attached to the body segment. The ISB 

proposal for standardization for joint coordinate systems is currently based on positions 

(optical markers) of bony landmarks. For most segments on the body, the origin of the 

reference frame and direction of axes are described in Wu and Cavanagh (1995) [i] Wu et 

al. (2002) [ii] and Wu et al. (2005) [iii].The MVN Fusion Engine uses the calibration poses 

to determine the direction of the axes of each segment. Figure 92a shows the origins of 

the segment axes in the neutral anatomical pose. The origin of the segment is always in 

the proximal joint center which is the functional rotation point.  The origin is chosen such 

that by connecting all joint centers a character (skeleton) is formed, see Figure 92b. 

Their positions for the calibration poses in the global reference frame can be found in the 

<segments>section and <frame type=”tpose/tpose-isb”>when exporting as MVNX file. 

23.5.2 Bony/anatomical landmarks 

The positions of bony/anatomical landmarks with respect to the joint origin of the related 

segment are presented in the MVNX file, see the <points>tag in the <segment>section. 

Segments are assumed to be rigid bodies. 

 

Positions of anatomical landmarks in the global frame (G) can be found by rotating the 

vector of the landmark in the body frame (B) to the global frame and adding the global 

position of the origin. 
*G G GB B GB

landmark origin+ q q=  p p x
 

Or in rotation matrix formulation: 
G G GB B

landmark origin+= p p R x
 

 

The rotation from body to global (GBq) and global position of the origin (Gpos) are given in 

the MVNX file, see next section. 
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a 

b 

Figure 92: a) Segment coordinate system at each joint origin, as is used in MVN to determine joint 

angles. b) Joint centers connected, forming a skeleton Legend: x: red, y: green, z: blue 

Note that positions of anatomical landmarks are not measured directly as they are with 

optical measurement systems. They are computed using the measured accelerations, 

angular velocities and rotations in combination with the biomechanical model. Relevant 

points are used for the detection of contacts with the external world and as an indication 

for scaling of segment lengths. 

 

The MVN character mesh (only for visualization) is an abstract representation of the 

human skeleton; therefore not all anatomical landmarks are exactly on the mesh. The 

ribcage is connected to T8 and will move accordingly. 
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T8, ribcage, 

neck and 

shoulders 

Right arm and shoulder 

Upper body 

Pelvis, L5 and 

right upper leg 

Left leg and 

foot 
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Figure 93: Selection of anatomical landmarks. Above, anterior view. Below, posterior view. 

 

23.6 Segment axes definitions and Origin Definitions 

Note: To ease comparison between the MVN segment co-ordinate systems with the 

International Society of Biomechanics recommendation, currently based on optical 

pPIJ 

pPX 
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position tracking systems, the ISB recommendation is presented next to the MVN 

definition. 

 

The MVN segment axes definition and origins have been chosen as closely as possible to 

the ISB recommendation where whenever possible. 

  MVN ISB [ii] 

 

O Midpoint between right and left hip 
center of rotation 

Coincident with hip center of 
rotation 

X Perpendicular to Y and Z 

Pointing forward 

Line parallel to a line lying in the 

plane defined by two ASISs and 
midpoint of two PSIS, orthogonal to 
Z-axis. 

Pointing anteriorly. 

Y hipOrigin to jL5S1 

Pointing up 

Line perp. to X and Z. 

Pointing cranially. (Della Croce et 

al.[iv]) 

Z to jLeftHip to jRightHip 

Pointing right 

Line parallel to a line connecting 
right and left ASISs. 

Pointing right. 

NB: Della Croce et al. [iv] define O as the midpoint between RASIS and LASIS 

23.6.1 Spinal segments: L5, L3, T12, T8: Segments 2-5 

 MVN  ISB [ii] 

 O jL5S1, jL4L3, jL1T12, jT9T8  

X Pointing forward Line per. Y and Z 

Y Joint to Joint  

Pointing up 

Line passing thru centers of 
vertebra’s upper and lower 
endplates 

Z Perp. to X and Y 

Pointing right 

Line parallel to a line joining 
similar landmarks on the 
bases and right and left 
pedicles 

Note: Spine segments not measured directly in MVN, they are interpolated 

between the MT’s of the Pelvis, Sternum and Head using a model of the spine. 

Joint origins are the rotation points in the vertebrae. 
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23.6.2 Neck: Segment 6 

  MVN  ISB 

 

O jT1C7 Not described in ISB 

X Perp. to Y and Z 

Pointing forward 

 

Y jT1C7 to jC1Head  

Z Pointing right  

Note: The neck segment is not measured directly in MVN; it is calculated using a 

model of the neck. 

23.6.3 Head: Segment 7 

  MVN  ISB 

 

O jC1Head Not described in ISB 

X Perp. to Y and Z  

Y jC1Head to TopOfHead  

Z  Left Ear to Right Ear   

Note: Position of Ears are not measured but assumed to be on the same height. 

23.6.4 Shoulder: Segment 8 Right and Segment 12 Left 

  MVN  ISB 

 

O jRightC7Shoulder 

jLeftC7Shoulder 

See Wu et al. [iii] 

and Šenk et al.v for 
range of definitions. 

X Pointing forward 

Y Perp. to X and Z 

Z Right: jRightC7Shoulder  to 
jRightShoulder to  

Left: jLeftC7Shoulder to jLeftC7  

In ISB the shoulder complex is described with the Thorax, Clavicle, Scapula and 

Humerus. MVN does not define the thorax segment. The thorax region is split into spine 

segments. The mesh of the thorax will move with segment T8 which is measured with 

the MT of the sternum. MVN does not measure the clavicle and is undefined in MVN. 
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23.6.5 Upper Arm (Humerus): Segment 9 Right and Segment 13 Left 

There are two segment coordinate systems described in ISB. The system described below 

is option 1. 
  MVN  ISB [iii] 

 

O jRightUpperArm GH 

jLeftUpperArm GH 

GH 

X Sagittal plane 

Pointing forward 

Line perp. Plane EL-EM-GH 

Pointing forward 

Y Right: jRightElbow to jRightShoulder 

Left: jLeftElbow to jLeftShoulder 

Line connecting GH to mid point EL-
EM 

Pointing to GH 

Z Perp. to X and Y 

Pointing to the right 

Line perp. Y and Z 

Pointing to the right 

23.6.6 Forearm (Radius/Ulna): Segment 10 Right and Segment 14 Left 

There are two segment coordinate system described in ISB. Option 1 is described here. 
  MVN  ISB [iii] 

 O jRightElbow 

jLeftElbow 

US 

X Pointing forward Line Perp. plane thru US-RS and 
midpoint EL-EM 

Pointing forward 

Y Right: jRightWrist to jRightElbow 

Left: jLeftWrist to jLeftElbow 

Line connecting GH to mid point 
EL-EM 

Z Perp. to X and Y 

Pointing right 

Line perp. X and Y 

Note: The joint origin is the midpoint between the epicondyles in MVN. 

In the anatomical pose, the hand and forearm are orientated forward 

23.6.7 Hand: Segment 11 Right and Segment 15 Left 

  MVN  ISB [iii] 

 

O jRightWrist  
jLeftWrist 

ISB defines origins and axes for 
each: 

Of the 5 Metacarpals 

14 phalanges 

X Pointing forward  

Y Top of Hand to 
jRightWrist/jLeftWrist 

Pointing Vertical 

 

Z Perp. to X and Y 

Pointing right 
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Note: In MVN, the joint center is the midpoint between the styloids. No 

metacarpals are measured in MVN. 

 

This description is for the anatomical pose. When the subject stands in the N-pose, X will 

no longer point anteriorly, but medially. 

23.6.8 Upper Leg (Femur): Segment 16 Right and Segment 20 Left 

   MVN  ISB [ii] 

 

 O jRightHip/jLeftHip (Only defined for use of 
calculating the hip joint angle): 

Coincident with right (or left) hip 
center of rotation, coincident with 
pelvic center O in neutral 

configuration 

 X Perpendicular to Y and Z  
Pointing forward in sagittal plane 

Line perp. to Y- and x- 

Pointing anteriorly. (Della Croce 
et al. [iv]) 

 Y Right: jRightKnee to jRightHip 

Left: jLeftKnee to jLeftHip 

Line joining midpoint between 

medial and lateral Fes and the 
origin. 

Pointing cranially 

 Z Right: Medial to Lateral 

Left: Lateral to Medial 

Pointing right 

Line perp. to Y-axis lying in plane 
defined by origin and two Fes. 

Pointing Right. 

Note: In ISB and MVN, the origin is in center of hip rotation, which is the head 

of the femur. Della Croce [iv]: midpoint LE and ME. In the MVN model, the lateral 

and medial epicondyles are on the same height. 

23.6.9 Lower Leg (Tibia/Fibula): Segment 17 Right and Segment 21 Left 

  MVN  ISB [ii] 

 

O jRightKnee 

jLeftKnee 

IM 

IM 

X Perp. Y and Z 

Pointing forwards 

Line perp. to torsional plane of 
tibia/fibula. 

Pointing anteriorly 

Y Right: jRightAnkle to jRightKnee 

Left: jLeftAnkle to jLeftKnee 

Line perp. to X and Z 

Z Right:  Medial to Lateral 

Left: Lateral to Medial 

Pointing right 

Line between MM and LM. 

Pointing to the right 

Note: In MVN, the joint center is approx. between LC and MC which corresponds 

with the center of rotation of the lower leg. Same coordinate system as Della 

Croce [iv], except that the origin is not in IM. In ISB, the Y axis is not along the 
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Tibia. In the MVN model the lateral and medial epicondyles and lateral and 

medial malleoli are the same height. 

23.6.10  Foot (Calcaneus): Segment 18 Right and Segment 22 Left 

  MVN  ISB [ii] 

 

 

O jRightAnkle 

jLeftAnkle 

IM 

IM 

X Sagittal plane forward 

 

Line perp. to frontal plane of tib/fib 
in neutral configuration. 

Pointing anteriorly. 

Y Vertical (aligned with gravity, 

pointing up) 

Line coincident with long axis of 

tibia/fibula, in neutral 
configuration. 

Pointing cranially 

Z Perp. to X and Y 

Pointing right 

Line perp. to x- and Y- 

Note: In the MVN model lateral and medial malleoli are on the same height. 

23.6.11  Toe: Segment 19 Right and Segment 23 Left 

The toes are not defined in ISB. 
  MVN  ISB  

 

 

O jRightToe 

jLeftToe 

The toes are not defined in ISB. 

 

X Sagittal plane forward  

Y Vertical (aligned with gravity)  

Z Perp. to X and Y  

Note: In MVN toes are not measured directly but are based on the foot 

kinematics and contact detection. The origin is between the metatarsals of the 

foot. Toes can only flex and extend, other kinematics are due to interpolation. 

23.7 Joint angles 

Typically, a joint rotation is defined as the orientation of a distal segment BGB
q with 

respect to a proximal segment : 

A B A BB B GB GB*q= q q  

where   denotes a quaternion multiplication and 
*
the complex conjugate of the 

quaternion (see Section 23.2.1). There are a few commonly used parameterizations of 

the joint rotation A BB B
q  that describe joint angles: 

• the Cardan/Euler representation [Cole 1993, Woltring 1994] 

• joint coordinate system [Grood & Suntay 1983]vi 

• helical angle [Kinzel 1972] 

Note that all representations of the joint angles are based on the same quaternion or 

rotation matrix. The differences lie only in how the angles are extracted (represented) 

from this rotation. The International Society of Biomechanics (ISB) has proposed 

AGB
q
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standards for rotation sequences for the lower [Wu et al, 2002ii] and upper body [Wu et 

al 2005iii]. 

23.7.1 Euler Extractions for the joint angles 

In order to produce validated joint angle output, Xsens MVN works closely to the ISB and 

Grood and Suntay recommendations [i,ii,iii,vi]. Almost all angles follow the ISB Euler angle 

extractions of Z (flexion/extension), X (abduction/adduction) Y (internal/external 

rotation). The definitions of the origins of the segments are somewhat different, since 

MVN uses MT’s placed on the segment, rather than markers placed on bony landmarks. 

The origins and coordination axes are defined above. 

23.7.2 Shoulder angle definitions 

For joint angle calculations, the only difference for Euler extractions between MVN and 

ISB is for the shoulder joint. MVN provides three different shoulder angle calculations, as 

can be seen in the data tree, after a session has been recorded. 

The shoulder joint angles provided are: 

• Angles between C7 and the shoulder segment 

• Euler rotation sequence ZXY 

• Euler rotation sequence XZY 

23.7.3 Joint angle outputs 

Below is an overview of all joints available in MVN and a short description. 
 Joint Angle  Description (& Euler Sequence) 

1 L5S1 Joint between the lumbar spine segment 5 and sacral spine 1 (ZXY) 

2 L4L3 Joint between the lumbar spine segment 4 and lumbar spine segment 
3 (ZXY) 

3 L1T12 Joint between the lumbar spine segment 1 and thoracic spine segment 

12 (ZXY) 

4 C1Head Joint between the cervical spine segment 1 and the head segment 
(ZXY) 

Left and Right 

5 C7Shoulder Joint between cervical spine 7 and the MVN shoulder segment 

6 Shoulder ZXY Shoulder joint angle between the MVN shoulder segment and the 
upper arm; calculated using the Euler sequence ZXY 

7 Shoulder XZY Shoulder joint angle between the MVN shoulder segment and the 

upper arm; calculated using the Euler sequence XZY 

8 Elbow Joint between the upper arm and the forearm. (ZXY) 

9 Wrist Joint between the forearm and the hand. (ZXY) 

10 Hip Joint between the pelvis and upper leg. (ZXY) 

11 Knee Joint between the upper leg and lower leg. (ZXY) 

12 Ankle Joint between the lower leg and foot. (ZXY) 

13 BallFoot Joint between the foot and the calculated toe. (ZXY) 

23.8 Xsens motion capture engine 
Traditional motion capture systems based on inertial and magnetic sensing typically 

estimate the position and orientation of each segment by applying the result of a sensor-
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to-segment calibration procedure to an estimate of sensor orientation, and applying a 

(scaled) biomechanical model of the human body. Each of these components will 

introduce errors, but the most dominant error source are generally the magnetic 

distortions which are present anywhere (e.g. common materials in buildings, furniture, 

and surrounding electronic equipment). The typical sensor fusion of inertial and magnetic 

sensor signals is done by combining the tracking of short-term changes in orientation by 

the gyroscopes with the accelerometer and magnetometer readings to provide stability 

for the long-term for inclination and heading respectively. The above mentioned 

magnetic distortions will affect the heading estimates yielding inconsistent tracking of the 

motion. Despite the huge improvements in accuracy of orientation tracking over the last 

years, there are fundamental limits to the accuracy that can be obtained using 

gyroscopes, accelerometers and magnetometers alone. 

 

In the past years, Xsens has spent tremendous effort towards a new motion capture 

engine that aims to overcome the major sources of error present in current solutions and 

to provide an accurate and consistent solution. Contrary to the current MVN system, 

Xsens MVN Analyze/Animate uses a sophisticated motion capture engine that combines 

the data of all motion trackers with an advanced biomechanical model to get rid of the 

effects of magnetic distortions. The engine works well in any environment and a variety 

of dynamics. This means that measurements can include motions ranging from semi-

static to high dynamics.  

 

An important aspect of using any measurement apparatus is the scale of the sensor. 

Often, for example with a temperature sensor (thermometer!) when the range is 

exceeded, the sensor either breaks or simply can no longer measure outside of the 

defined range. With the Xsens sensors and the new engine, this is completely prevented. 

Clipping (exceeding the dynamic range) is of course possible, but the effect is negligible.  

23.8.1 Height tracking 

Due to the many improvements, from signal processing to how data is handled in MVN 

Analyze/Animate including foot contact detection, it is now possible to track height 

changes of a subject e.g. walking upstairs or up a steep slope while wearing the system. 

Please note that height changes due to e.g. changing floor level in an elevator will not be 

detected, since there is no relative change in motion of the body segments, in this case, 

it will appear that the subject stands still and continues on a level plane. 

23.8.2 Engine settling time 

Settling time is the time needed for the engine to “warm up”. After applying the 

calibration, or when manually reinitializing the motion capture engine (both when 

standing still), it is recommended to move slowly (e.g. walk round) for about 30 seconds.  

23.9 Update Rate versus Sample Frequency 

Since MVN Studio 4.0, Xsens refers to the term “update rate” rather than sample 

frequency. This is an intentional change in terminology since the data is sampled in a 

different way than in the past. 

 

Normal, digital systems using some form of recording relies on sampling of this data. 

Since data is sampled, this implies some degree of data loss at those time instances that 

no sampling took place. Sampling must take place a measureable time, some amount of 

times over a given time frame. This is known as the sampling frequency. Most systems 

operate at a given sample frequency. 
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The intentional difference in terminology is needed to highlight that data from new Xsens 

motion trackers (MTx and MTw) undergoes a mathematical method called Strap Down 

Integration. This ensures that no loss of accuracy is experienced, even though the data is 

transmitted to the PC at lower update rates. Update rates as low as 20 or 30Hz still 

provides very accurate data. 

23.10 Strap Down Integration 

Strap down integration (SDI) is a method used to compute an orientation/position 

change given an angular velocity and linear acceleration of a rigid body. Angular velocity 

and acceleration data in the MTx and MTw is sampled at a very high frequency (1000Hz) 

to maintain accuracy under very dynamic conditions such as vibrations and impacts. The 

sampling frequency is too high to be transmitted wirelessly, and would typically present a 

computational load that is too high on the receiving host device (e.g. PC). Based on this 

data, the MTx and MTw calculates velocity increments and orientation increments using 

the SDI algorithm. The main advantage of using the SDI algorithm is that full 3D tracking 

accuracy can be maintained even if the output update rate from the MTx and MTw is 

lower (<100 Hz). An additional advantage is that the MTx and MTw can continue to track 

the 3D motion internally when facing transient data loss in the RF transmission and 

immediately report the full 3D velocity and orientation increment as soon as the RF link is 

restored, without the need to re-transmit all the data that was lost which would a) cause 

a large delay during real-time tracking b) use a lot of precious RF bandwidth and 

consume unnecessary power. The specific use of SDI data in combination with such a 

specialized RF protocol, Xsens has named the Awinda protocol7. 

23.11 The Awinda Protocol 

The Awinda protocol is the wireless protocol that controls the data stream from the MTws 

to the Awinda Station or Awinda Dongle. This wireless protocol provides accurate time 

synchronization of up to 32 MTw's across the wireless network to within 10 

microseconds, achieving 'wired like' system performance. The Awinda protocol is 

developed such that no data is ever lost. If individual packets are missed, there is some 

room to contain data temporarily. This buffered data is then retransmitted. If these 

packets become lost (for example if the subject wearing the hardware is outside of the 

radio transmission range and for a prolonged period – meaning the buffer becomes full) 

then it is still possible to retrace the missing data due to the use of SDI. Retransmitted 

data is used during reprocessing, for this reason Awinda data can appear better – 

smoother and more accurate after reprocessing. 

23.11.1 Choosing a Radio Channel for MVN Awinda 

Figure 94 provides an overview of the allowed channels for operating MVN Awinda. The 

Awinda protocol is based on the IEEE 802.15.4, around 2.4 GHz. The bottom row of the 

figure shows the channels on the 2.4GHz, the top row shows how WiFi channels use the 

spectrum. This should indicate to the user that the best channels to use when you know 

which channel WiFi is on. When in an environment where WiFi is also expected to be in 

prevalent use, but you are not sure which channels, try Channels 11, 15, 20 or 25. 

Bluetooth uses the entire spectrum around 2.4 GHz, but will (try to) avoid channels in 

use by other systems including Awinda channels. 

 
7 Patents pending. 
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Figure 94: Overview of channels operating around 2.4GHz; for ease of channel selection 
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23.12 System Specifications 
Recommended computer system 

Operating system Windows 10 (64 bit) 

Processor Quad core or higher (2.7 GHz or faster) 

Hard drive SSD 256 GB or more 

Memory 8 GB RAM (64-bit) 

Graphics card Hardware acceleration for DirectX 11 
Dedicated memory 512 MB or more 

Network card Gigabit Ethernet, support for jumbo frames (9014 Bytes) 

USB ports USB 2.0 (1 per MVN Awinda system, 1 per license dongle) 

 

MVN System  

Number of trackers per suit configuration: 

Full body 17 inertial motion trackers 

Extra prop /backup   1 inertial motion tracker 

Optional extra trackers:   3 inertial motion trackers 

Total usable prop trackers   4  inertial motion trackers 

MVN Camera Prosilica GS650 

MVN Mounting Straps  Fabrifoam with Velcro closure 

Full body Lycra suit: Light weight revolutionary stretch fabric with exterior 
zippered channels for trackers and wires 

Sizes: Straps one size fits all, with 3 sizes of vests (s-m, m-l, l-xl). 

Suit: S, M, L (standard), XL, XXL 

Accessories:  2 gloves with tracker pocket 

1 head band with tracker pocket 

2 foot pads with Velcro patch 

Pair of shorts (MVN Link) 

MVN Link on body cabling: 1 cable connects Body Pack to Battery Back, all remaining 
strings of trackers connect to Body Pack. 

Data control units: 1 Body Pack 

Power (BP)  

 Battery Part number: NC2040xx31 (3.1Ah) 

rechargeable smart Lithium Ion battery pack 

 Battery charger (included) Part number: CH5000 

battery charger with ability to recalibrate  

fuel gauge on battery packs 

 Battery charger power      
adapter (incl.) 

Part number: ATS065TP240 

110-240VAC / 24VDC 2.71A (65W) 

Operating time (typical) 9.5 hours 

Power Awinda Station/Charger  

Power adapter (incl.) 

Power adapter Mean Well GE18I12-P1J  

90-264VAC /12VDC 1.5A (18W) 
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Communication  

Interface Wireless (WiFi or Awinda Protocol)  

Wireless range radius (max) MVN Awinda Station Awinda dongle 

 Outdoor 150 meter (492 ft.) ~50m (164 ft.) ~20m 

 Indoor open space 150 meter (492 ft.) ~20m () ~10m 

 Indoor office 50 meter (164 ft.) ~20m () ~10m 

 

Wireless receiver units: MVN Link MVN Awinda 

Number of Wireless Receivers 1 Access Point 1 Awinda Station or Awinda 
Dongle 

RF technology WiFi 2.4GHz, 5.0 GHz IEEE 802.15.4 PHY 
2.4GHz  

Interface Ethernet USB 1.1 or 2.0 

Power Battery USB (station additionally 
mains power supply) 

 

Physical  

Dimensions MTx 36 x 24.5 x 10mm       

Dimensions BP 160 x 72.5 x 25 mm      

Dimensions MTw 47 x 30 x 13 mm 

Dimensions Awinda Station 148x104x61.9 mm 

Dimensions Awinda Dongle 45x20.4x10 mm 

Dimensions Awinda Dongle ANT 148 x 104 x 62 mm (excluding antenna) 

Dimensions MVN suitcase 559 x 351 x 229 mm    (22 x 13 x 9 inches) 
Flight case with wheels & extendable handle. 
Durable & watertight 

Weight MTx 10 g 

Weight BP 150 g 

Weight MTw 16g 

Weight Awinda Station 233g 

Weight Awinda dongle 8g 

Weight MVN Suit(no trackers) 485 g 

Weight MVN Straps(no trackers) 153 g 

Weight total on-body system 
(with batteries and cables) 

1130 g MVN Awinda: 525 g 

Shipping weight 10 kg 5.5 kg 

Housing material products PC ABS – UL 94V-0 
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Environmental  

Operation environment  0 – +50 deg Celsius, non-wet 

Humidity 20-80%RH NC 

 

 

Tracker Performance  

Static accuracy (Roll/Pitch) 0.2 deg 

Static Accuracy (Heading) 0.5 deg 

Dynamic Accuracy 1 deg RMS 

Accelerometer range MTx: ± 160 m/s2 (16 g) MTw: ±160m/s2 (16g) 

Gyroscope range ± 2000 deg/s 

 

MVN Performance  

MVN human model MVN uses a 23 segment biomechanical model with 22 joints. 
Each joint is specified by statistical parameters for 6DOF joint 
laxity. An advanced spine and shoulder model is used that 
computes the kinematics of the spine and shoulder blades. 

 

System Calibration  

General 

 

Flexible calibration scheme with instant feedback regarding 
the expected accuracy. Calibration can be done without 
assistance from a second person. 

Minimum calibration time 

 

10 seconds. 
Basic calibration needs only subject length, foot length. 

Advanced calibration 

 

10 – 30 seconds per additional step. 

Advanced subject specific calibration determines tracker 
alignment and/or subject specific dimensions. 

Calibration procedures for subjects with limited range of 
motion are possible. 

 

MVN Fusion Engine  

Output Full kinematics of each segment (position, velocity, 
acceleration, orientation, angular velocity and angular 

acceleration). 

MVN Animate Pro additionally provides joint angle and CoM. 
All at preset sample frequency (max 240Hz). 

Double integration of body segment accelerations allows for 
jumping/running (permanent floor contact is not needed). 
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MVN Fusion Engine  

3D translation capture ~1% error in traveled distance (without external aiding). 
Advanced external contact model detects body-world 
contacts, to enable crawling, sitting, cartwheel etc. Various 
friction models (slippage etc.) are possible.8 

Seamless fusion with aiding technologies possible, e.g. 3D 
position from optical/GPS, or 2D image correspondences.8 

Magnetic environment 

Local, permanent disturbances 

Full immunity to any magnetic distortion.  

Soft tissue artifacts Minimized to ~2 degrees RMS using redundancy in 
measurement and biomechanical constraints. 

Multiple person capture Up to four person capturing on one pc 

 

MVN Analyze/Animate 
Software 

 

Functionality Easy and quick calibration 
Real time preview of motion capture 

Simultaneous recording and viewing of motion capture data 
Replaying and editing of previously recorded motion data 

Supported export formats .BVH  -Biovision Hierarchical Data 

.C3D -Coordinate 3D data 

.FBX – FiLMBOX 

.MVNX – MVN Open XML format 

Excel – to open with MS office Excel 

Sample Frequency 60 – 240 Hz (default 240 Hz) 

Wireless Update Rate 20-60Hz Depending on suit configuration 

Data rate 37 MB/min @ 60 Hz 

74 MB/min @ 120 Hz 

158 MB/min @ 240 Hz 

 

Legal Notice  

Warranty 2 Years 

MVN and Xsens are trademarks of Xsens Technologies B.V. 

Patents Pending  

www.xsens.com  

 

 

  

 
8 Some features are only available in SDK, ask for possibilities. 

http://www.xsens.com/
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Package Label 
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23.13 System block diagrams 

23.13.1 MTw 

The purpose of the MTw wireless motion tracker is to give accurate orientation data. This 

is done by sampling digital sensors and processing this data at an MCU (Microcontroller 

unit) to angular velocity, acceleration, magnetic field and barometric pressure 

information.  

 

The MTw functions as a slave in a wireless network. It transmits the data by the RF front 

end (CC2541 +CC2590) wireless via AWINDA™ protocol to the AWINDA master. 

 

The MTw power supply is a 150mAh LiPo battery, and is rechargeable on the AWINDA 

master. The charging circuit is integrated in the MTw. It is also possible to power and 

communicate with the MTw via a micro USB connector. 

 

 
Figure 95: MTw block diagram 

23.13.2 Awinda Dongle 

The AWINDA dongle works as a master and together with the MTw it forms a wireless 

motion tracker system. The AWINDA  dongle communication is based on CC2541 

hardware, using a proprietary TDMA (Time Division Multiple Access) AWINDA™ protocol.  

 

 
Figure 96: Awinda Dongle block diagram 

 



   

 

 

 

 

  

 

144 www.xsens.com 

23.13.3 Awinda Dongle ANT 

The AWINDA dongle works as a master and together with the MTw it forms a wireless 

motion tracker system. The AWINDA  dongle communication is based on CC2541 

hardware, using a proprietary TDMA (Time Division Multiple Access) AWINDA™ protocol.  

 
Figure 97: Awinda Dongle ANT block diagram 

23.13.4 Awinda Station 

The AWINDA station works as a master in a Local wireless sensor network. Together with 

the MTw it forms a wireless motion tracker system. The AWINDA  station communication 

is based on a fixed channel proprietary radio 1Mbps GFSK radio (CC2541 & CC2591), 

using a proprietary TDMA (Time Division Multiple Access) AWINDA™ protocol.  

Synchronization with external devices is possible via galvanic isolated BNC ports. 

The AWINDA station can be powered via USB. In addition, a 12V net adapter can be 

connected to charge six MTw’s. 

 

 
Figure 98: Awinda Station block diagram 
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24 Contact point editing 
For examples of contact point editing please check this link: https://base.xsens.com/hc/en-

us/articles/360013009559-Contact-Point-editing 

https://base.xsens.com/hc/en-us/articles/360013009559-Contact-Point-editing
https://base.xsens.com/hc/en-us/articles/360013009559-Contact-Point-editing
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25  Synchronization with External Devices 

25.1 The Hardware 

MVN Awinda uses the Awinda Station for synchronization. 

Details on initializing the synchronization of MVN are provided in Section 7.2.9. The 

purpose of this section is to provide some in-depth information about the synchronization 

possibilities. 

 

The Awinda Station was originally created as a wireless master to control the Xsens MTw 

kit. The Awinda Station and Sync Station were created specifically for the biomechanics 

market, where synchronization with external devices is an essential aspect of 

biomechanics research. For this reason, these Stations are equipped with 4 BNC 

connectors, two for receiving TTL pulses (Sync IN) and two for sending TTL pulses (Sync 

OUT). 

 

The hardware clock of the Awinda Station is very accurate. As an indication of the clock 

accuracy, the error in the Awinda Station’s clock has a maximum of 1 µs every second (1 

ppm). Therefore, in general, the recommended scenario is that users relying on very 

tightly coupled synchronization use MVN Awinda, and use it with the Sync Out settings.  

 

With MVN Link, there is additional hardware making synchronization possible, this is 

software synchronization. It is essential that the user understands that software 

controlled synchronization can lead to undefinable latencies between button click in the 

software and reception of this signal. 

 

Note that to synchronize with external devices, BNC connectors are required at the 

Awinda Station or Sync Station side. Since there are a multitude of system-specific 

connectors for third party systems, Xsens does not provide the cables or connectors. 

Please contact the respective third party providers or user manuals for details their 

hardware requirements. 

 

25.1.1 Important note when receiving 5V synchronization pulses 

On the back of the Awinda and Sync Stations are four BNC ports, two Sync In ports and 

two Sync Out. The ports have been configured to send (Sync Out) or receive (Sync In) 

TTL pulses 0-3.3V. 

 

This 3.3V is lower than the voltage sent by some devices, which will be synchronized with 

the MVN System. These other devices are based on 5V TTL levels. For this reason, it is 

advised to separately purchase (from eg Farnell) a 3.3 - 5V / 5V - 3.3V SMD level 

translator. This will prevent damage to the SyncIn ports of the Awinda or Sync Station 

when receiving 5V pulses from external systems. In general, sending a 3.3V pulse from 

an Awinda or Sync Station SyncOut port is fine. Therefore, unless a threshold of 5V of 

the third party system is required, in which case the 3.3V-5V SMD level translator will be 

required. 
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25.2 Sync In 
Sync In means that an external device sends a control signal to the Awinda Station. The 

Awinda Station can detect polarity changes on the input lines. This trigger may be a 

rising or falling edge as illustrated in the following figures: 

  
When a trigger is detected on one of the input lines, the Awinda Station can be 

configured to perform a certain action. Combinations of any of the following are possible 

on each Sync In port: 
Sync Type Description 

Start Recording External system sends a start recording trigger. Upon receiving this 
trigger, the Awinda Station will begin recording at the start of the first 

frame following the trigger. 

Stop Recording External system sends a stop recording trigger. The Awinda station will 
stop recording at the end of the current frame. 

 

A number of parameters can be set for each action: 
Parameter Description 

Sync Line The sync line to activate. 

Pulse Polarity Rising or falling edge, or rising and falling. 

Trigger Once Only the first trigger event will be used. It is not recommended to select 
Trigger once, if more than one recording using synchronization of multiple 
systems will be made. This is a failsafe option in the case external systems 

send pulses throughout recordings. 

Skip First The number of initial occurrences of the sync trigger to skip. This is useful 
if a well-defined delay is expected, or if the external signal uses the same 
sync line to generate for example start and stop recording. If both start 
and stop are on the same sync line, skip first should be 1 for stop 
recording, ensuring that the second trigger, instead of the first, causes the 

recording to stop. 

Skip Factor The number of occurrences of the sync trigger to skip in between trigger 
signals. In the same way that was described in Skip First (above), skip 
factor, for start and stop recording on one sync line should be set to 1, to 
ensure that the first trigger starts the recording and the second stops etc. 

 

Note: If the user selects Sync In but selects a function from the drop-down 

menu that is only available as Sync out (namely, settings other than start or 

stop recording), the software will automatically change the sync channel to 

Out 1.  

 

Therefore, care is required when matching sync in or out with the functions available. 
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25.3 Sync Out 
Sync Out is the command that enables the Xsens system to send a trigger pulse for 

synchronization purposes. A control signal is sent via the Awinda/Sync Station, from MVN 

Analyze/Animate to the third party hardware. 

 
Sync Type Description 

Start Recording Upon clicking the record button in MVN Analyze/Animate, the Awinda 
Station starts the recording and consequently sends a start recording 
trigger to the external system. 

Stop Recording Upon clicking the record button in MVN Analyze/Animate, the Awinda 

Station stops recording and sends a stop recording trigger to the external 
system. 

Go to Operational A Sync Out trigger on “Go to Operational” is meant to be used for setting 
the initial signal level on a sync out line. 

Note: in general, this functionality is not needed since the level is 
automatically adapted based on the input settings.   

Interval Transition 
Measurement 

A frame / or interval transition at the Station can be used to give a signal 
to the external system, indicating the end of the strap-down integration 
interval over which data is calculated. Selecting this option, the frame 
transition is sent from the moment that “Start Measuring” is selected. 

Interval Transition 
Recording 

See Frame transition Measurement 
Selecting this option, the frame transition is sent from the moment that a 
recording is started, which can be used by the external device to capture 
the timing of the recording in its local time. 

 

A number of parameters can be set for each action: 
Parameter Description 

Sync Line The sync line to activate. 

Pulse Polarity Positive (where the polarity is initially low [0V] and goes high [3.3V]). 
Negative (where polarity is initially high [3.3V] and goes low [0V]). 

Trigger Once Only the first trigger event will be sent. It is not recommended to select 
Trigger once, if more than one recording using synchronization of multiple 
systems will be made. 

Skip First Number of initial sync pulses to skip. This command is useful if a well-
defined delay is expected between the Xsens and the third party system. 
It may also be needed if the third party, like the Xsens system uses the 
same pulse properties to trigger different actions. See description provided 
above for Sync In. 

Skip Factor Number of sync pulses, between the sync pulses delivered, to skip. See 
Sync In Table description. 

Pulse Width The duration of the pulse in ms. Some systems wait for a signal of a 
minimum pulse width before generating the desired synchronization 
action. The Awinda / Sync Station can send a pulse with a duration of up 

to 99ms to a third party system. It is not recommended to send a signal 
longer than a frame width. Specify 0 ms to generate an infinite pulse 
width. 
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25.3.1 Settings in MVN Analyze/Animate 

By opening the motion capture configuration window and select sync station 

configuration (Figure 99) 

 

 

Figure 99: Sync settings window in MVN Analyze/Animate 

 

To add a synchronization type, click “Add”, all settings become available, to be set 

manually or using the drop down menus. 

 

An example and the how to set up a 3rd party sync is explained in the tutorial video  and 

base article below. 

https://tutorial.xsens.com/video/setting-up-a-sync-station/ 

https://base.xsens.com/hc/en-us/articles/115003818654-MVN-Analyze-Synchronization-

Options-TTL 

25.4 Important Notices for Sync In 

When the Awinda Station is configured to start recording upon receipt of a trigger, it 

initializes recording at the start of the following frame. The Awinda Station cannot trigger 

a start recording command between frames since data received in a given frame is 

measured in the previous one. Therefore, delaying the recording in this way ensures that 

data is not recorded prior to the external trigger indication. 

 

In the same way, recording should not be stopped between frames, since data received 

in a given frame was measured during the previous frame. Therefore, the Awinda Station 

stops recording immediately after the current frame. 

https://tutorial.xsens.com/video/setting-up-a-sync-station/
https://base.xsens.com/hc/en-us/articles/115003818654-MVN-Analyze-Synchronization-Options-TTL
https://base.xsens.com/hc/en-us/articles/115003818654-MVN-Analyze-Synchronization-Options-TTL
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25.4.1 Sync In Recommended Settings 

Note that the preferences menu includes “Skip first” and “Skip Factor”. The definitions of 

these have been provided above; however for practical use consider the following: 

When the Awinda Station is triggered to start and stop a recording, on one line, it will 

blindly receive 3.3 V pulses on that line. Since all pulses are the same, the Station 

requires further instructions about what to do with each pulse. In the software, a 

translation has been put in place to carry out a certain action with each pulse. 

 

Therefore, to start a recording, one must give an initial pulse. The second pulse, should 

indicate a stop recording, therefore the skip factor in “Start Recording” should be set to 

1. In Stop Recording, the first pulse should not trigger a stop (it was just used to Start 

Recording); so a Skip First of 1 must be input, and to ensure that every other pulse 

thereafter stops the recording, a Skip Factor of 1 must be input. 

 

This means that Start Recording is commanded on pulse 1, 3, 5 etc and stop recording 

on 2, 4, 6 etc. 

25.5 Sync In with MVN Analyze/Animate 

When Sync In is in use, after configuration, and when ready to record, users should click 

Record, to prepare the system for the external trigger. The record icon changes from the 

normal red dot to one with the pause symbol overlaid. When recording has been 

triggered by the external system, the record button will indicate as such (most right icon 

shown below): 

 

Record button prior to 
depression 

 

Record button when 
depressed and waiting for 

Sync In signal 

 

Record button during 
recording (and temporarily 

during flushing) 

25.6 Sync Out with MVN Analyze/Animate 

When the parameters have been set for MVN Analyze/Animate to control the start and 

stop of recordings, each time the record button in MVN Analyze/Animate is depressed, a 

TTL pulse will be sent to the specified Sync Line. The receiving system must be 

configured to take the specified action. 

 

Of course, ensure that the BNC connector is connected to the correct Sync Out line(s). 

25.7 3rd party Synchronization Examples 

Xsens tried and tested with a number of third party hardware systems, an overview can 

be found here. 
EMG Pressure Mats Optical Systems EEG Data Loggers 

Noraxon 
Delsys 
Cometa Wave 
TMSi 

BTS 

GAITRite Vicon 
Qualisys 

TMSi 
ANT Neuro 
 

DataLOG 

25.8 Network sync 

https://base.xsens.com/hc/en-us/articles/360012651559-Network-Sync-in-MVN-2020-0 

 

https://base.xsens.com/hc/en-us/articles/203836822-Synchronization-with-3rd-party-devices
https://base.xsens.com/hc/en-us/articles/360012651559-Network-Sync-in-MVN-2020-0
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25.9 Gloves 
Manus: https://base.xsens.com/hc/en-us/articles/360017254919-Setting-up-Manus-

Prime-2-Gloves-with-MVN 

 

StretchSense: https://base.xsens.com/hc/en-us/articles/360017745539-Streaming-

StretchSense-Glove-Data-into-MVN 

 

https://base.xsens.com/hc/en-us/articles/360017254919-Setting-up-Manus-Prime-2-Gloves-with-MVN
https://base.xsens.com/hc/en-us/articles/360017254919-Setting-up-Manus-Prime-2-Gloves-with-MVN
https://base.xsens.com/hc/en-us/articles/360017745539-Streaming-StretchSense-Glove-Data-into-MVN
https://base.xsens.com/hc/en-us/articles/360017745539-Streaming-StretchSense-Glove-Data-into-MVN
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